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C H A P T E R 1

Introducing VMware VirtualCenter
This chapter introduces VMware VirtualCenter components and operations. Also this 
chapter describes the contents of this manual and provides additional references for 
support. This chapter contains the following topics:

• VirtualCenter Overview on page 14

• About This Manual on page 15

• Understanding the Components on page 17

• Operations Overview on page 25
13
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VirtualCenter Overview
The VirtualCenter server collects and stores persistent data in a dedicated database 
that contains per-system and environmental information. The VirtualCenter server 
automatically executes user-specified scheduled tasks, such as powering on, or 
moving powered-off virtual machines. VirtualCenter with VMotion moves a virtual 
machine from one host to another, while the virtual machine continues operation. 
This form of migration with VMotion, occurs without service interruption on the 
virtual machine. 

VirtualCenter is virtual infrastructure management software that centrally manages an 
enterprise's virtual machines as a single, logical pool of resources. VirtualCenter 
provides the central point of control for workload management, provisioning and 
availability. It simplifies IT so companies leverage their storage, network, and 
computing resources to control costs and respond faster to changing business 
demands.

VMware VirtualCenter exploits the benefits of a virtual infrastructure. With 
VirtualCenter, an administrator can manage thousands of Windows NT, Windows 
2000, Windows Server 2003, Linux and Netware servers from a single point of control. 
The VirtualCenter interface provides a powerful overview of all the virtual resources in 
a data center. From the VirtualCenter interface, administrators can perform: 

• Continuous Workload Consolidation — Monitor and optimize the utilization 
of data center resources to minimize unused capacity while maintaining 
application service levels, by adjusting the resources dedicated to each software 
service. 

• Instant Provisioning — Reduce server-provisioning time from weeks to tens of 
seconds, allowing administrators to respond immediately to requests for IT 
services. Using server templates, administrators can ensure that new servers are 
fully consistent with current build and security policies. 

• Zero-Downtime Maintenance — Safeguard business continuity 24/7, with no 
service interruptions for hardware maintenance, deployment, or migration. Use 
VMotion to move running operating systems and their applications off a system 
that needs maintenance, and then transfer them back when maintenance 
completes.
www.vmware.com14
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About This Manual
This manual, the VMware VirtualCenter User’s Manual, describes how to install, 
configure, and use VMware VirtualCenter to provision, migrate, monitor and manage 
the virtual machines through the single VMware VirtualCenter interface using virtual 
farms and groups for organizational ease of operation.

Intended Audience
The information presented in this manual is written for system administrators who are 
experienced Windows or Linux system administrators and who are also familiar with 
virtual machine technology.

Document History
VirtualCenter User’s Manual, Revision 20040827, Item No. VC-ENG-Q204-005

This manual is revised with each release of the product or when deemed necessary. A 
revised version can contain minor or major changes. 

To view the most current version of the manual, refer to the VMware Web site: 
www.vmware.com/support/vc11

Release Date Description

Added: Connecting to VirtualCenter 
Through a Firewall, Changing the 
Default Virtual Machine Directory

September 29, 2004 PDf, HTML on web

Patch release 1.1.1 August 27, 2004 PDF Printed

Patch release 1.1.1 August 3, 2004 PDF, HTML on web, PDF on CD, Help

Release 1.1 June 24, 2004 PDF, HTML on web, PDF on CD, Help, 
Printed

Release K2, beta 1 April 20, 2004 PDF, HTML on web

Release 1.0.1 March 29, 2004 PDF, HTML on web, Help

Release 1.0, editorial updates January 6, 2004 PDF, HTML on web

First Release 1.0 December 5, 2003 PDF, HTML on web, PDF on CD, Help, 
Printed
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Conventions
The following conventions are used in this manual. 

Abbreviations
The following abbreviations are used in the graphics in this manual.

Style Purpose

blue (online only) Cross references, links

Courier Commands, filenames, directories, paths, user input

Semi-Bold Interactive interface objects, keys, buttons

Bold Items of highlighted interest, terms

Italic Variables, parameters

italic Web addresses

Abbreviation  Description

VC VirtualCenter

UI VirtualCenter client

server VirtualCenter server

database VirtualCenter database

farmn VirtualCenter farms

hostn VirtualCenter managed hosts

VM# virtual machines on a managed host

user# users with access permissions

dsk# storage disk for the managed host

datastore storage for the managed host

SAN SAN type datastore shared between managed hosts

tmplt template
www.vmware.com16
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Understanding the Components
VirtualCenter components are discussed in the following sections:

• Managed Components

• Software Components

• Organizational Components

• Functional Components

• Access Privileges Components

Managed Components
VirtualCenter monitors and manages the listed components:

• Virtual machines — A virtualized x86 personal computer environment in which 
a guest operating system and associated application software can run. Multiple 
virtual machines can operate on the same host machine concurrently. 

Virtualization platforms are VMware products, such as ESX Server, GSX Server, 
or Workstation. These are used to create the virtual machines in the form of a set 
of configuration and disk files that together perform all the functions of a 
physical machine. Through the virtualization platform, you run the virtual 
machines, install operating systems and run applications, and configure the 
virtual machines, which includes identifying the virtual machine’s resources, 
such as storage devices.

• Hosts — The physical computers on which the virtualization platform software, 
such as ESX Server or GSX Server, is installed. It hosts the VirtualCenter virtual 
machines. 

Note: When VirtualCenter refers to a host, this means the physical machine on 
which the virtual machines are running. All virtual machines within the 
VirtualCenter environment are physically on ESX Server or GSX Server hosts. The 
term host used in this manual, means the ESX Server or GSX Server host that has 
virtual machines on it.

• Datastores — The storage locations for the virtual machine files. Datastores 
hide the idiosyncrasies of various storage options, such as VMFS, SAN, GSX Server 
and ESX Server, etc., thereby proving a uniform model for managing GSX Server 
and ESX Server hosts and various storage products in the context of virtual 
machine management. 
17
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Software Components
VMware VirtualCenter monitors and manages all the virtual machines and hosts 
registered with VirtualCenter. To perform these functions, VirtualCenter provides:

• VirtualCenter client — A user interface that runs locally on a Windows 
machine. 

The VirtualCenter client runs on a machine with network access. This can be on 
the same machine as the VirtualCenter server or on another machine with 
network access. The VirtualCenter client requires a computer monitor for access 
to the graphical user interface.

• VirtualCenter server — A service that acts as a central administrator for 
VMware servers connected on a network, to direct actions upon the virtual 
machines and the virtual machine hosts. VirtualCenter server provides the 
central working core of VirtualCenter. 

VirtualCenter server runs on a machine as a service. It can also, and typically is, 
another server machine in the network. It receives direction through the 
VirtualCenter client and executes actions upon the identified hosts and virtual 
machines. 

VirtualCenter Web service — A service that can optionally be installed with 
the VirtualCenter server. It is a required component for third party applications 
that use the VMware SDK application programmer interface (API).

• VirtualCenter agent — Installed on each virtual machine host, it collects, 
communicates, and executes the actions received from the VirtualCenter server.

VMotion — A feature that is activated by the VirtualCenter agent. It enables 
moving running virtual machines from one ESX Server to another without 
service interruption. It requires licensing on both the source and target host. The 
VirtualCenter server centrally coordinates all VMotion activities.

• VirtualCenter database — A persistent storage area, for maintaining status of 
each virtual machine, host and user managed in the VirtualCenter environment. 
This can be local or remote to the VirtualCenter server machine. 
www.vmware.com18
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The figure below illustrates the relationships of the VirtualCenter installed 
components. Refer to Abbreviations on page 16 for a description of abbreviations.

VMware VirtualCenter Installed Components

VMware SDK Components
The VMware SDK works with VirtualCenter but is not required for VirtualCenter 
operations. The VMware VirtualCenter SDK contains the following two components: 

• SDK package — VMware SDK product documentation and examples files. This 
is installed through an external link and does not require VirtualCenter to be 
installed with it. This is typically for developers only. To install the SDK package, 
refer to: //www.vmware.com/support/developer/vc-sdk

• Web Service — A required component for third party applications that use the 
VMware SDK application programmer interface (API). This is installed through 
the VirtualCenter installer and requires that the VirtualCenter server is also 
installed. 
19
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Organizational Components
Organizational components assist in the handling of the potentially hundreds of 
virtual machines. They can be renamed to represent their organization purposes, for 
example, they can be named after company departments or locations or functions. 
The organizational components are:

• Server Farms — The top level structure for the VirtualCenter server. Only one 
Server Farms object exists for each VirtualCenter server. Server Farms can contain 
multiple farm groups and farms. The term Server Farms is the default value, the 
actual name used can be changed.

• Farm Groups — An optional grouping structure, it’s hierarchically contained 
within the Server Farms structure. The VirtualCenter server supports multiple 
farm groups. Farm groups can contain other farm groups and farms.

• Farm — The main structure under which hosts and their associated virtual 
machines are added to the VirtualCenter server. VirtualCenter server supports 
multiple farms. 

Note: A host can be managed by only one farm at a time.

Note: All operations between hosts and virtual machines occur within a single 
farm. For example, hosts and virtual machines are not migrated between farms. 

• Virtual Machine Groups — An optional grouping structure, it contained within 
a farm. VirtualCenter server supports multiple virtual machine groups. Virtual 
machine groups contain virtual machines and other virtual machine groups.

All the VirtualCenter components, the hosts, the virtual machines, and the 
organizational groupings of server farms, farms, and farm groups are contained within 
the VirtualCenter environment.
www.vmware.com20
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The figure below illustrates the hierarchy of the VirtualCenter organizational 
components. Refer to Abbreviations on page 16 for a description of abbreviations.

VirtualCenter Organizational Components

Functional Components
The functional components group the monitoring and managing tasks. The 
functional components are:

Inventory — Provides a view of all the monitored objects in VirtualCenter. Monitored 
objects include: Server Farms, farms, farm groups, hosts, virtual machines, and virtual 
machine groups.

Scheduled Tasks — Provides a list of activities and a means to schedule those 
activities.

Templates — Provides a means to import virtual machines and store them as 
templates for deploying at a later time to create new virtual machines. 

Alarms — Provides a means to create and modify a set of alarms that you define. 
Alarms are applied to an object and contain a triggering event and a notification 
21
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method. Alarms do not have a navigation toolbar option. Alarms are viewed through 
the Alarms tab for each object. 

Events — Provides a list of all the events that occur in the VirtualCenter environment. 
Use the Navigation option to display all the events. Use an object specific panel to 
display, only events relative to that object.

The figure below illustrates the relationship of the VirtualCenter functional 
components. Refer to Abbreviations on page 16 for a description of abbreviations.

VirtualCenter Functional Components 

Access Privileges Components
Each VirtualCenter user logs on to the VirtualCenter service through the VirtualCenter 
client. Each VirtualCenter user is identified to the VirtualCenter as someone who has 
assigned rights and privileges to selected objects, such as farms and virtual machines, 
within the VirtualCenter environment. VirtualCenter itself has full rights and privileges 
on all hosts and virtual machines within the VirtualCenter environment. VirtualCenter 
passes on only those actions and requests from a VirtualCenter user that the 
VirtualCenter user has permissions to perform. 
www.vmware.com22
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VirtualCenter grants access to each VirtualCenter object, farm, farm group, virtual 
machine, and virtual machine group. To do this, VirtualCenter assigns a role and a user 
(or group) to each object. 

Individual permissions are assigned through VirtualCenter by pairing a user and a role 
and assigning this pair to a VirtualCenter object.

• Users and Groups — Created through the Windows domain or Active Directory 
database. VirtualCenter registers users and groups as part of the assigning 
privileges process. 

• Roles — A VirtualCenter pre-defined set of access rights and privileges. There 
are four roles. Each subsequent role includes the privileges of the previous role.

The types of roles that can be paired with a user and assigned to an object are:

• Read Only User — Users assigned this role for an object are allowed to view the 
state of virtual machines, hosts, farms, and groups.

With this role, view virtual machines, hosts, farms farm groups, and virtual 
machine group attributes, that is, all the tab panels in VirtualCenter — except 
the Console tab. You cannot view the remote console for a host. All actions 
through the menus and toolbars are disallowed. A Read Only User role can view 
the templates and scheduled tasks but not perform any actions with them.

• Virtual Machine User — Users assigned this role for an object are allowed to 
perform power operations on virtual machines. 

With this role, connect with a remote console and view the states of virtual 
machines. You cannot modify the configuration of hosts or virtual machines.

• Virtual Machine Administrator — Users assigned this role for an object are 
allowed to add, remove, or modify objects. With this role you:

• Connect/disconnect host devices, migrate and migrate with VMotion, clone, 
remove and configure virtual machines.

• Create, import, and deploy templates.

• Add and remove hosts from farms.

• Create, remove, or modify farms, farm groups, and virtual machine groups and 
their content.

• VirtualCenter Administrator — Users in this role are allowed to change 
privileges for an object. 

With this role, add, remove, and set access rights and privileges for all the 
VirtualCenter users and all the virtual objects in the VirtualCenter environment.
23
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The figure below illustrates the three users and their respective access to VirtualCenter 
objects. Refer to Abbreviations on page 16 for a description of abbreviations.

VirtualCenter Access Control
www.vmware.com24
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Operations Overview
Typical VirtualCenter operations are focused around managing virtual machines on 
multiple hosts. 

The figure below illustrates a VirtualCenter operation overview. Refer to Abbreviations 
on page 16 for a description of abbreviations.

Working VirtualCenter Environment 

Note: For the remainder of this manual, the term VirtualCenter refers to the 
VirtualCenter client, unless explicitly specified otherwise. 

There are several options for adding virtual machines to VirtualCenter:

• Register a host with virtual machines.

• Create virtual machines. 

The list below describes some of the key process options.

• A Virtual machine can be created from scratch using the New Virtual Machine 
wizard. After creating a virtual machine, a guest operating system must be 
installed.

• An existing virtual machines can be used as source for new templates using the 
New Template wizard.
25
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• An existing virtual machines can be cloned to create new virtual machines using 
the Clone wizard.

• Templates can be deployed as new virtual machines using the Template 
Deployment wizard.

• When creating a new machine from either a template or as a clone, the new 
virtual machine can be customized using the Guest Customization wizard. This 
wizard customizes a virtual machine that already has a guest operating system 
installed.

• After creating a new virtual machine, irrespective of the method used to create 
it, it can be edited using the Virtual Machine Properties dialog box. 

The following sections introduce the essential VirtualCenter tasks:

• Understanding Virtual Machines and Hosts

• Understanding Templates

• Cloning Virtual Machines

• Understanding Customization

• Understanding Migration

• Creating and Configuring New Virtual Machines

• Understanding Scheduled Tasks

• Understanding Events

• Understanding Alarms

• Understanding the User Interface

• Performing Actions

Action Requires

New Virtual Machine No previous condition

Create Template Existing virtual machine registered with VirtualCenter or local to VirtualCenter server

Deploy Template Existing template in template upload repository or on datastore of registered host.

Clone Existing Virtual Machine Existing registered virtual machine

Guest Customization Triggered from deploy template or clone wizards. Requires existing guest operating system in original source 
virtual machine.

Edit Existing Virtual Machine Completed virtual machine. Virtual machine can be result of either New Virtual Machine wizard or Deploy or 
Clone wizards. 
www.vmware.com26
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Understanding Virtual Machines and Hosts
Hosts are added to the VirtualCenter environment through an Add Host wizard. When 
VirtualCenter adds a host, it automatically discovers and registers all the virtual 
machines on that host. Each host is associated with a specific farm. Select a farm 
object to enable the Add Host wizard menu option. 

The figure below illustrates the process of adding virtual machines to VirtualCenter 
control. Refer to Abbreviations on page 16 for a description of abbreviations.

Adding a Host to a Farm and Performing Automatic Discovery of Virtual Machines

Understanding Templates
A template is a golden image of a virtual machine. The template typically includes a 
specific operating system and configured components which provide virtual 
counterparts to hardware components. VirtualCenter uses templates to create new 
virtual machines. 

Creating a Template
You create templates from existing virtual machines. These virtual machines can be 
either:

• Virtual machines located on any VirtualCenter registered host.

• Virtual machines stored on a disk local to the VirtualCenter server. Virtual 
machines local to the VirtualCenter server can be virtual machines created by 
supported versions of ESX Server, GSX Server, or Workstation. Refer to 
VirtualCenter Template Requirements on page 49 for additional information.

�
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Note: Optionally, create templates from GSX Server and Workstation virtual 
machines. Only virtual machines created by ESX Server version 2.0 or greater or 
GSX Server version 2.5 or greater can be managed by VirtualCenter.

In addition, create templates by making a copy (cloning) of an existing template. 

When you create a template, VirtualCenter provides an option to store the template at 
one of three locations:

• Datastore — The original datastore location of the source virtual machine. The 
original virtual machine is the template. This option works best with a shared 
datastore between hosts on a farm. This option is typically used for creating 
templates from virtual machines on registered hosts.

• Template upload directory — Located on the VirtualCenter server machine. It 
contains copies of the original virtual machine virtual disks. Specify a directory 
local to the VirtualCenter server as the template upload directory. Typically used 
when a template may need to be deployed to any host.

• Locally — Locally to the VirtualCenter server. This option is available if source 
virtual machine and a VirtualCenter client are local to the VirtualCenter server. 
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The figure below illustrates the two methods for storing templates in VirtualCenter. 
Refer to Abbreviations on page 16 for a description of abbreviations.

Creating a Template
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Deploying a Template
When you deploy a template, you create a new virtual machine from the template. If 
the template is in the template upload directory, place the new virtual machine on 
any VirtualCenter managed host. 

If the template is stored on the datastore of a host, place the new virtual machine only 
on another host that has access to the datastore. Only those hosts that share the 
datastore are listed as Deploy a Template wizard target host choices.
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The figure below illustrates the process for deploying a template to create a new 
virtual machine. Refer to Abbreviations on page 16 for a description of abbreviations.
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Cloning Virtual Machines
A clone is a copy plus customization of a virtual machine. When you create a clone, 
VirtualCenter provides an option to customize the guest operating system of that 
virtual machine. Store clones on any host within the same farm as the original virtual 
machine. 

The figure below illustrates the process for cloning an existing virtual machine to 
create a new virtual machine. Refer to Abbreviations on page 16 for a description of 
abbreviations.

Creating a Clone
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Understanding Customization
When creating a virtual machine by either deploying a template or cloning an existing 
virtual machine, an option is provided to customized the guest operating system 
installed on that template or existing virtual machine.

Customizing Windows guest operating system options include:

• Join workgroups and domains

• Network interface configuration

• Domain suffix, security ID (SID) change

Customizing Linux guest operating system options include:

• Host name

• Domain suffix

• Network interface configuration
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Understanding Migration
Migration is the act of moving a virtual machine from one host to another. There are 
two types of migration.

• Migration with VMotion — Moving a powered on virtual machine between 
hosts on a farm. Moving a powered on virtual machine, allows to virtual machine 
to continue performing transactions without interruption. This functionality 
requires activation of VMotion on both the source and target host. The figure 
below illustrates migrating a powered on virtual machine from one host to 
another using VMotion. Refer to Abbreviations on page 16 for a description of 
abbreviations.

Performing a Migration with VMotion
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• Migration — Moving a powered off virtual machine between hosts on a farm. 
The figure below illustrates the process for migrating a powered off virtual 
machine from one host to another. Refer to Abbreviations on page 16 for a 
description of abbreviations.

Performing Migration of a Powered Off Virtual Machine
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Creating and Configuring New Virtual Machines
In addition to providing multiple methods for moving, migrating, deploying, and 
cloning virtual machines, VirtualCenter also incorporates the creation capabilities of 
the virtualization platforms. Through the New Virtual Machine wizard and the Virtual 
Machine Properties dialog box create new virtual machines from scratch and make 
configuration modifications to them once they are created. 

Understanding Scheduled Tasks
Create scheduled tasks to automatically perform operations at specified times. 
Configure the tasks to occur once or routinely. Apply tasks to groups, farms, or 
individual virtual machines. The Scheduled Tasks panel lists all planned for and user 
defined actions within the VirtualCenter environment. Create, modify, or remove tasks, 
as needed. The New Task wizard provides the following task options: 

• Deploy a virtual machine from a template

• Clone an existing virtual machine

• Change the power state of a virtual machine

• Migrate a virtual machine

• Migrate a virtual machine with VMotion

• Change resource settings of a virtual machine

Understanding Events
VirtualCenter events are logged in the VirtualCenter database. Each event panel 
displays the events relevant to the selected VirtualCenter object. With the Events 
option in the navigation bar selected, the Events panel displays all the events for the 
current session. With a farm or host selected, only the events that occurred on that 
farm or host appear in the Events panel.

Understanding Alarms
Alarms are preconfigured actions that can be triggered when selected events occur. 
Apply alarms to any VirtualCenter object. View, modify, and remove an existing alarm 
through the Alarms tab of the object where the alarm was defined.
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Understanding the User Interface
The VirtualCenter client display is typical to Windows screens. It has a menu bar, a 
shortcut navigation bar, a navigation specific toolbar, and a display area. For the 
Inventory navigation item, the display area is divided into:

• Inventory panel — Displays an inventory list of all the managed VirtualCenter 
server objects.

• Information panel — Displays the tab specific content for the selected object 
in the inventory panel. For the Tasks, Templates, and Events Navigation items, the 
display area shows a list of scheduled tasks, templates, and events, respectively. 

VirtualCenter User Interface

menu bar navigation bar information panel tabs

inventory panel

farm

information panel

host

virtual machine
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Performing Actions
Performing an action through VirtualCenter involves:

• Starting and logging on to the VirtualCenter client. 

• Adding or selecting a virtual machine, host, farm, or group.

• Selecting the desired action from the corresponding menu for the virtual 
machine, host, farm, or group, and answering the prompts from the task wizard 
screens.

The figure below illustrates the process flow for typical VirtualCenter activities.

VMware VirtualCenter Process Flow
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C H A P T E R 2

VMware VirtualCenter 
Requirements and Resources
This chapter describes VMware VirtualCenter requirements and provides additional 
references for support. This chapter contains the following topics:

• What’s New In Version 1.1? on page 40

• VMware VirtualCenter Requirements on page 41

• Technical Support Resources on page 53

• Viewing System Logs on page 55
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What’s New In Version 1.1?
The VirtualCenter 1.1 release has been enhanced with the following major features: 

• Support for GSX Server, including centralized management, secure access 
control, rapid provisioning, and virtual machine interoperability between 
managed GSX Server and ESX Server hosts.

• A programmatic Web service interface to allow users and third party software 
products to leverage the capabilities provided by VirtualCenter.

• Scalability and performance enhancements to the VirtualCenter server.

• Enhanced remote browsing capabilities for connecting an ISO file to a virtual 
CD-ROM.

• Single-port management operations for better integration with firewalls.

• Usability improvements such as restructuring the Tasks and Events interfaces 
and removing the long UUID tags from filenames.

• Additional database support for Oracle 9i.
www.vmware.com40
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VMware VirtualCenter Requirements
The VirtualCenter client and VirtualCenter server are both Windows executables that 
can optionally run in a virtual machine. The following sections describe additional, 
component-specific requirements.

• VirtualCenter Server Requirements

• VirtualCenter Client Requirements

• VirtualCenter Database Requirements

• VMware SDK Requirements

• VirtualCenter Managed Host Requirements

• GSX Server as Managed Host Requirements

• VirtualCenter Managed Virtual Machine Requirements

• VirtualCenter Networking Requirements

• VirtualCenter Licensing Requirements

• VirtualCenter VMotion Requirements

• VirtualCenter Template Requirements

• VirtualCenter Guest Operating System Customization Requirements

VirtualCenter Server Requirements
The VirtualCenter server must have:

• Administrator privileges on the installing system to install the VirtualCenter 
server. The VirtualCenter server installation adds VirtualCenter as a Windows 
service.

• Windows 2000 Server, Windows 2000 Advanced Server, Windows XP 
Professional, or Windows Server 2003 (Web, Standard, and Enterprise). 

• Minimum 2GB RAM for VirtualCenter configurations managing 50 hosts or less. 
Greater than 50 hosts configurations, use 3GB RAM. Configurations with 100 
hosts running 2000 virtual machines, use 4GB RAM.

• Minimum Pentium IV 2.0Ghz processor. Dual processors recommended for 
deployments with greater than 25 hosts.

• Minimum 1 10/100Mbps NIC (1Gbps NIC recommended).

• Windows Script version 5.6 or later. If you do not have this version, VirtualCenter 
installer automatically updates to Windows Script version 5.6. 
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• Disk space sufficient on the machine to support the VirtualCenter database and 
the template upload directory. 

The VirtualCenter server may run on the same machine as the VirtualCenter client, or 
may be installed separately on another Windows system. The VirtualCenter server can 
also be installed in a virtual machine.

VirtualCenter Client Requirements
The VirtualCenter client must have:

• .NET Framework version 1.1. If you do not have this version, VirtualCenter 
automatically updates to .NET Framework version 1.1.4322.573.

• Windows 2000 (all versions), Windows XP Professional, Windows XP Home 
Edition, Windows Server 2003 (all versions), Windows 98, Windows 98 SE, 
Windows ME, or Windows NT4 (SP6a required).

• Minimum 256MB RAM (512 MB recommended).

The VirtualCenter client can be installed on multiple Windows systems and access the 
VirtualCenter server through the network. These Windows systems can be on your 
desktop, laptop, or another virtual machine.

Note: If you install your VirtualCenter server in a virtual machine, do not install the 
VirtualCenter client in that same virtual machine. Viewing a Console recursively from 
that virtual machine might cause the host to fail. 

VirtualCenter Database Requirements
The VirtualCenter database must have one of the following compatible database 
formats:

• Microsoft Access (default)

You do not need to have a Microsoft Access database installed to use this option. 
VirtualCenter stores the database in Microsoft Access format.

• Microsoft SQL Server 2000

• Microsoft SQL Server 7

• Oracle 8i, version 8.1.5 and Oracle 9i, version 9.0.1

Note: VMware recommends using the Microsoft Access Database only for 
demonstration environments and proof of concepts. This database is not 
recommended for production deployments. Rather, for production environments, use 
either the SQL Server or Oracle database.
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VMware SDK Requirements
There are two components for the VMware SDK. They are:

• VMware Web Service

• VMware SDK Package

Note: VMware SDK functions only apply to ESX Server hosts at this time.

VMware Web Service Package
Your machine must meet the minimum hardware requirements listed for VMware 
VirtualCenter 1.1. Refer to the product documentation for the requirements.

• VMware VirtualCenter — www.vmware.com/support/vc11 

To run the Virtual Machine Agent server, you must also have installed, and have 
running, the following:

• Microsoft Windows operating system — supported version for the VirtualCenter 
server

• VMware VirtualCenter 1.1

VMware SDK Package
Your machine must meet the minimum hardware requirements listed for the IBM 
WebSphere Software Developer Kit for Web Services V5.1. Refer to the product 
documentation for the requirements.

• WSDK V5.1 — www-106.ibm.com/developerworks/webservices/wsdk/
install_guide.html

In general, your machine should support a standard development environment:

• 1 GHz processor

• 256MB memory

• 50MB free disk space

To install the VMware SDK package, go to: www.vmware.com/support/developer/vc-sdk

To use the client package, you must also have installed the following:

• IBM WebSphere Software Developer Kit for Web Services V5.1 (WSDK V5.1) at: 
www-106.ibm.com/developerworks/webservices/wsdk/

• The WSDK download package also includes IBM SDK for Java 2 Standard Edition 
(J2SE) Technology, version 1.3.1.

• The VMware SDK package requires approximately 8.2MB, and the VMware Web 
Service package requires approximately 21.3MB.
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VirtualCenter Managed Host Requirements
The VirtualCenter registered and managed hosts must be running the following 
virtualization platform:

• VMware ESX Server, version 2.0.1 or 2.1

• VMware GSX Server, version 3.1

The IP address that VirtualCenter server uses to connect to a host at must be 
accessible from all other hosts. For example:

If a host H1 has multiple NICs with IP addresses, for example, x.x.x.x1 and 
x.x.x.x2, but DNS resolves H1 to x.x.x.x1 and the VirtualCenter server 
connects to the host at that IP address, then x.x.x.x1 must be reachable from all other 
hosts.

To ensure that the VirtualCenter server host is accessible to the other hosts: 

1. Log on to the server running VirtualCenterserver and perform a DNS lookup of 
H1, type at a command prompt:

nslookup H1

The example prints the IP address x.x.x.x1

2. Log on to another host and type at a command prompt:

ping x.x.x.x1

The ping should return the IP address.

GSX Server as Managed Host Requirements
Using a GSX Server host with VirtualCenter has the following restrictions:

• GSX Server virtual machine configuration and .vmdk disk files must be stored 
locally to the GSX Server. 

• Cannot create templates from GSX Server virtual machines with IDE disks. This 
applies to external virtual machines being imported as templates and well as 
virtual machines on managed GSX Server hosts or ESX Server systems. 

• GSX Server feature that automatically starts virtual machines when the GSX 
Server starts is not supported in VirtualCenter. 

• The template repository must be local or on a Network Attached Storage (NAS). 

• GSX Server must be upgraded to the GSX Server 3.1. 

• Migration with VMotion using GSX Server hosts is not supported at this time. 
www.vmware.com44



C H A P T E R  2  VMware VirtualCenter Requirements and Resources
• GSX Server virtual machines must be configured with network labels. Please 
refer to your GSX Server documentation for information on how to configure 
network labels. 

• All virtual machines on a GSX Server host need to be configured with a RunAs 
user mode. Refer to your GSX Server documentation for information on 
changing virtual machine user modes.

VirtualCenter Managed Virtual Machine Requirements
VirtualCenter managed virtual machines must have the following:

Disks — must use SCSI hard disks (though CD-ROM drives can be configured as IDE).

Guest operating system — must be one of the supported versions listed for the 
virtual machine host, ESX Server or GSX Server. Refer to the following for a complete 
list of compatible guest operating systems: //www.vmware.com/support/guestnotes/
doc/

VirtualCenter Networking Requirements
A VirtualCenter host and virtual machine networking requirements are as follows:

• Up to four virtual Ethernet NICs. Each virtual NIC may be high-performance 
VMware virtual NIC or AMD PCnet-PCI II compatible virtual NIC 

• Supports any protocol that the guest operating system supports over Ethernet. 
Multiple high-performance Ethernet-compatible virtual networks 

• Configure a TCP/IP address on an extra network adapter card (NIC) sufficient to 
support migration

The minimum number of NICs is two — how the NICs are assigned differs 
depending upon the version of the VMware virtualization platform being used. 

For ESX Server 2.1, create a bond including both NICs and give the bond to all 
three entities (service console, VMkernel, and virtual machines). Use VLANs to 
create separate logical networks. 

For ESX Server 2.0.1 dedicated one NIC to the service console and VMotion, and 
dedicate the other NIC for the virtual machines.

The preferred minimum number is three — one is dedicated to the host, one (or 
more) are dedicated to the virtual machines, and one is dedicated to VMotion 
activity. 

The figure below illustrates the possible NIC configurations that support VirtualCenter. 
Refer to Abbreviations on page 16 for a description of abbreviations.
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VMotion Network Card Configuration Options
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Depending upon the version of ESX Server you are using, configure your networking 
as follows:

If you are using ESX Server 2.1: 

1. Create a bond including both NICs.

2. Give the bond to all three entities (service console, VMkernel, and virtual 
machines). 

3. Use VLANs to create separate logical networks.

If you are using ESX Server 2.0.1:

1. Configure one NIC for the virtual machines.

2. Configure one NIC to be shared between the Service Console and the VMotion 
networks. 

Refer to your ESX Server System Administration Guide for additional information 
on sharing nics between vmkernel and the service console.

VirtualCenter Licensing Requirements
There are three elements to VirtualCenter licensing, each of which has a separate set 
of license keys with a different set of policies. 

VirtualCenter server — Requires one license for each VirtualCenter Server. 
VirtualCenter Server licenses are perpetual. A license key is requested the first time 
VirtualCenter client connects to the VirtualCenter server, not during installation. 

VirtualCenter agent licenses — Requires one license that comes in assorted 
configurations for each registered host. Managed CPU licenses are perpetual. The 
license configurations are typically in combinations of pairs, for example 2, 4, 8, and 16 
CPU licenses. Hosts cannot be partially licensed. For example, you cannot use 4 CPUs 
worth of licenses on an 8-way system; this configuration requires 8 CPU licenses. 
Additional licenses can be added through the VirtualCenter client. 

Licenses are applied to either ESX Server and GSX Server hosts as specified by the 
license keys submitted.

Any time you add a host to VirtualCenter, VirtualCenter automatically applies an 
appropriate number of managed CPU licenses towards that host. The number of 
licenses applied depends on the number of CPUs on the host.

VMotion CPU licenses — Requires one license for each CPU for each registered host 
to be VMotion-enabled. VMotion CPU licenses are perpetual. As with the managed 
CPU licenses, hosts cannot be partially VMotion licensed. For example, an eight CPU 
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server requires eight licenses. Additional licenses can be added through the 
VirtualCenter client. 

Whenever you add a host to VirtualCenter, and there are sufficient VMotion CPU 
licenses available, VirtualCenter prompts you to VMotion-enable the new host. If you 
select Yes, VirtualCenter checks that no virtual machines are running on the host. The 
host is then VMotion-enabled, and the appropriate number of licenses are applied by 
VirtualCenter.

Whenever you remove a host from VirtualCenter, the VMotion licenses are released. 
The VMotion licenses must be reapplied when the host is re-registered with 
VirtualCenter.

VMotion licenses are not intended to be mobile. The only legitimate circumstance 
under which you should move a license are when you are:

• Deprecating and replacing a VMotion-enabled host.

• Repurposing a VMotion-enabled host to run services in a new farm.

• Exercising a one-time transfer of VMotion licenses.

VirtualCenter VMotion Requirements
If you wish to have VirtualCenter perform a migration with VMotion of your virtual 
machines, you must also have and activate the VirtualCenter VMotion Module. You 
must activate each host. Activation requires a specific VMotion license for each host. 
The only hosts supported at this time are ESX Server hosts.

In addition, the hosts you are planning to migrate between must meet the following 
requirements. Complete these requirements before you attempt to perform a 
migration with VMotion.

• The hosts must share a storage area network (SAN) infrastructure. 

• Configure all of your hosts to use a single Virtual Machine File System (VMFS) 
volume. 

• The virtual machine’s disks have to be on a VMFS that is accessible by both 
source and target hosts. 

• The shared VMFS access mode VMFS setting should be public.

• Set the size of the VMFS volume sufficiently large, and spanning enough LUNs, 
to store all of the virtual disks for your virtual machines.

• Ensure that all VMFS volumes on your hosts use volume names, and that the 
virtual machines use the volume names for specifying the virtual disks.
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• Ensure that the CPUs in the VMotion hosts (CPU0 and CPU1) match, for example 
are both P4. The vendors for CPU0 and CPU1 must match each other. 

• The virtual machine configuration file should not reside on a VMFS located on 
the shared datastore. 

• VMotion does not currently support the migration of clustered applications, raw 
or undoable virtual disks. If you have clustered applications, or raw or undoable 
disks, store the disks on separate VMFS volumes from the virtual machines you 
plan to migrate using VMotion.

• VMotion requires a Gigabit Ethernet network between virtual machines.

VMotion requires the setup of a private, Gigabit Ethernet migration network 
between all of the VMotion-enabled hosts. When VMotion is enabled on a host, 
configure a unique network identity object for the host and connect it to the 
private migration network.

• Deploying a template or cloning a virtual machine may fail due to SCSI 
reservation conflicts on the LUN. To prevent this add the following line to the 
host configuration file to tell VirtualCenter to retry several more times. 

$ echo n > /proc/vmware/config/Scsi/ConflictRetries

Where n is the number of times to retry. The recommended number is 10.

VirtualCenter Template Requirements
Virtual machines to be used as source for VirtualCenter templates must have been 
created by one of the following virtualization platforms:

• Workstation version 4.x

• GSX Server version 2.5.x

• ESX Server version 2.x

If you have older virtual machines that you plan to include in the VirtualCenter 
environment, you must upgrade your Workstation, GSX Server, or ESX Server to the 
supported version level and upgrade the virtual machines to the supported version 
level. Refer to your Workstation, GSX Server, or ESX Server documentation for 
additional information.

Note: To be registered with VirtualCenter, ESX Server hosts must be running ESX 
Server version 2.0.1, though virtual machines can have been created with ESX Server 
version 2.0, then imported into a host running ESX Server version 2.0.1. Similarly GSX 
Server hosts must be running GSX Server version 3.1, though virtual machines can 
have been created with GSX Server 2.5.x.
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The virtual disks of virtual machines to be used as source for VirtualCenter templates 
have the following requirements:

• Workstation or GSX Server virtual machine’s directory path and configuration file 
must be local to VirtualCenter server. 

The path must refer to a drive letter corresponding to a local file system. 
Specifically, it cannot be a network share that is mapped as a local drive. 

• ESX Server virtual machines must be registered with VirtualCenter. 

Remove the ESX Server host from VirtualCenter after you have created the 
template, if needed. 

• ESX Server golden images can have their configuration file refer to virtual disks 
with relative paths. Then have the virtual disks reside under the same directory as 
the configuration file.

• Only SCSI virtual disks are allowed. IDE virtual disks cannot be imported as a 
template. 

Note: Windows XP and Windows Server 2003 virtual machines created through 
Workstation or pre-version 3.0 GSX Server default to IDE disks. Refer to your 
Workstation or GSX Server documentation for information on creating virtual 
machines with SCSI disks.

VirtualCenter Guest Operating System Customization 
Requirements
To use the guest customization wizard, the virtual machine and the guest operating 
system, Windows or Linux, must meet the requirements listed in the following 
sections:

• Virtual Hardware Requirements for Guest Customization

• Windows Requirements for Guest Customization

• Linux Requirements for Guest Customization

Virtual Hardware Requirements for Guest Customization
Guest customization requires that the source virtual machine used to create the clone 
or templates has the following:

• VMware Tools installed.

• At least one Network Interface Card (NIC) configured.

When a virtual machine is cloned or used for a template, the new virtual 
machine has the exact same number and type of NICs. For example, AMD 
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VLance/PcNet versus high-performance VMware vmxnet. This cannot be 
changed during the deployment and/or guest customization process.

• SCSI disks.

The default configuration for VMware Workstation and GSX Server creating a 
Windows XP or Windows Server 2003 virtual machine is IDE disks. If the source 
virtual machine was created using VMware Workstation or GSX Server, with 
Windows XP or Windows Server 2003 guest operating systems, be sure the non-
default SCSI disks were specified.

VirtualCenter customization operates on the disk attached to the virtual SCSI 
node with the lowest address on the SCSI controller with the lowest index. As a 
result, it is a requirement to make sure that the guest operating system that is 
being customized resides on a disk attached as SCSI 0:0 node in the virtual 
machine configuration. 

For Windows guest operating systems: Both the active partition (the partition 
containing boot.ini) and the system partition (the partition containing the 
system directory, for example \WINNT or \WINDOWS) are on the same virtual 
disk and attached the SCSI 0:0 virtual SCSI node. 

Note: It is not a requirement that active and system partitions be the same 
partition.

For Linux guests: The virtual disk containing the system partition (the partition 
containing the /etc. directory) must reside on the SCSI 0:0 node.

Windows Requirements for Guest Customization
Guest customization of a Windows guest operating system can occur if:

• The guest operating system is not a primary or backup domain controller.

• The clone or template has one of the following Windows versions installed:

• Windows 2000 Server or Advanced Server

• Windows XP Professional

• Windows Server 2003, Web, Standard, or Enterprise Editions

Note: Windows XP Home or Windows NT4 operating system guest 
customization is not supported.

• The Microsoft Sysprep tools are installed on the VirtualCenter server. 

Refer to Installing the Microsoft Sysprep Tools on page 297 for information on 
installing the Microsoft Sysprep tools. 
51



VMware VirtualCenter User’s Manual
Microsoft Sysprep tools have certain requirements and impose certain 
restrictions on the source machine, please refer to the Microsoft Sysprep 
documentation for additional information.

Linux Requirements for Guest Customization 
Guest customization of a Linux guest operating system can occur if:

• The clone or template has one of the following Linux versions installed:

• Red Hat Enterprise Linux AS 3.0

• Red Hat Advanced Server 2.1

• SUSE LINUX Enterprise Server 8

• The clone or template has a root volume formatted with ext2 or ext3 file system.

Note: A default installation of SUSE LINUX Enterprise Server 8.0 formats the disk 
using the ReiserFS file system, which is not supported. If you would like to 
customize your SUSE virtual machines, be sure to format the disk using an ext2 
or ext3 file system during the installation of the guest operating system.

• The VMware Open Source Components installed on the VirtualCenter server. 

Refer to Installing the VMware Open Source Components on page 298 for 
additional information.
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Technical Support Resources
There are several resources available for researching and finding solutions for issues 
and concerns. The following sections describe the options. 

Documentation on the Web
Full documentation for VMware VirtualCenter, including the latest updates to the 
manual, can be found on the VMware Web site at: www.vmware.com/support

VMware Knowledge Base
You can find troubleshooting notes and tips for advanced users in the knowledge 
base on the VMware Web site at: www.vmware.com/support/kb/enduser/std_alp.php.

VMware Newsgroups
The VMware newsgroups are primarily forums for users to help each other. You are 
encouraged to read and post issues, work-arounds and fixes. While VMware personnel 
may read and post to the newsgroups, they are not a channel for official support.

The VMware NNTP news server is at: news.vmware.com.

For a listing of all current newsgroups and the topic areas they cover, refer to: 
www.vmware.com/support/newsgroups.html

VMware Community
The VMware community is a set of moderated discussion forums hosted on the 
VMware Web site and is open to users of all VMware products. VMware technical staff 
regularly monitor the forums to learn about your issues and feedback, and help 
facilitate discussions when appropriate.

To participate in the community:

1. Go to: www.vmware.com/community

2. Create a user account.

Reporting Problems
If you have problems while running VirtualCenter, please report them to VMware 
technical support. 

The following guidelines describe the information we need from you to diagnose 
problems. This information largely comes from various log files. Which log file we 
need depends upon the problem you encounter. 
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1. Register your serial number. 

2. Describe the steps you took in the period before the failure occurred.

• Save any other information that might help reproduce the problem. 

• Record a description of your physical hardware and of the software (operating 
system and applications) that was running in the virtual machine, if 
applicable. 

3. Collect the logs and files requested by VMware technical support. 

Refer to Viewing System Logs below for a description of possible logs and files. 

4. Contact your VMware Technical Support representative. 

If you are requesting support directly from VMware, then report your problems 
using the support request form on the VMware Web site at: www.vmware.com/
requestsupport

Refer to your service contract for additional information.
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Viewing System Logs
There are several files available that might be requested by the VMware technical 
support to help resolve your problem. The following describes the files, when you 
might need them. 

Component Operating 
System

Name Location

VirtualCenter 
service log

Windows vmware-vpxd-[user]-

[pid].log

Temp directory, Example:

C:\Documents and Settings\Administrator\ Local 

Settings\Temp\ vmware-vpxd-Administrator-1024.log 

C:\WINDOWS\Temp\vmware-VirtualCenter-SYSTEM-

1024.log 

C:\WINNT\Temp\vmware-VirtualCenter-SYSTEM-

1024.log 

GSX Server 
registration 
service log 

Windows vmware-serverd.log C:\Windows\Temp

Linux vmware-serverd.log /var/log/vmware

ESX Server 
service log

ESX Server vmware-serverd-

[user]-[pid].log

Temp directory, Example:

/tmp/vmware-serverd-root-1024.log

 VMware 
Management 
Interface log

Windows mui.log C:\Program Files\VMware\VMware Management 

Interface

Linux error_log /var/log/vmware-mui

 VMware Virtual 
Machine Console

Windows vmware-<username>-

<PID>.log

Temp directory, Example:

C:\Documents and Settings\<username>\Local 

Settings\Temp

The path to this file appears in the About dialog box. In a console, choose 
Help > About VMware VirtualCenter, and look under Additional 
information.

Linux ui-<PID>.log Temp directory, Example:

/tmp/vmware-<username>

The path to this file appears in the terminal when you start the console.

If you encounter problems with the VMware Virtual Machine Console on a remote client, please submit a support request 
and this log file.
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ESX Server log ESX Server vmware-ccagent-n.log /var/log/vmware/

C:\WINNT\TEMP

C:\WINDOWS\TEMP on Windows XP or Windows 2003 systems

Where n increments after the first log from 0 to 9. The most recent log is 
the one without a dash number.

VirtualCenter 
installation log

Windows VirtualCenter server host.

VMware Virtual 
Machine Console 
installation log

WIndows VMInst.log Temp directory, Example:

C:\Documents and Settings\<username>\Local 

Settings\Temp. 

The Local Settings folder is hidden by default. To see its contents, 
open My Computer, choose Tools > Folder Options, click the View tab 
and select Show Hidden Files and Folders. 

Linux VMInst.log /etc/vmware

Virtual Machine 
Log

Windows vmware.log In the same directory as the configuration file (.vmx) of the virtual 
machine that had problems. 

The path to the log file of the active virtual machine appears in the About 
dialog box. In a console, choose Help > About VMware VirtualCenter, and 
look under Additional information.

Linux <vmname>.log In the same directory as the configuration file (.vmx) of the virtual 
machine that had problems.

 Run the support script or save the log file before you launch the failed virtual machine again

virtual machine’s 
event log

Windows event-

<path_to_configuratio

n_file>.vmx.log

On the virtual machine host.

C:\Program Files\VMware\VMware 

VirtualCenter\vmserverdRoot\eventlog

Linux /var/log/vmware

Some of the log information is displayed in the VMware Management Interface.

Virtual machine 
core file

Windows 
and Linux

vmkernel-core.<date> 

and vmkernel-

log.<date>

/root directory after you reboot your machine.

Virtual machine 
configuration file

Windows 
and Linux

.vmx On the virtual machine host.

Migration history 
log

Windows /proc/vmware/migration/history

On the VirtualCenter server.

Component Operating 
System

Name Location
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Collecting Log Files

There are several files available that might be requested by the VMware technical 
support to help resolve your problem. The following describes script processes for 
generating and collecting some of these files. 

Collecting VMkernel Files
If the VMkernel fails, normally an error screen is displayed for a period of time and then 
the virtual machine reboots. 

If you specified a VMware core dump partition when you configured your virtual 
machine, the VMkernel also generates a core dump and error log. 

More serious problems in the VMkernel can freeze the machine without an error 
screen or core dump.

Collecting VirtualCenter Service Console Files
This script collects and packages all relevant VirtualCenter system and configuration 
information and VirtualCenter log files. This information can be used to analyze the 
problem you are encountering. 

Service Console 
log

ESX Server /var/log/messages

To view service console messages: from the management interface, click 
the Service Console Log tab.

Service Console 
availability report

ESX Server To view the server availability report: from the management interface, click 
the Availability Report tab. 

The availability report contains useful information about server uptime and downtime. This includes detailed statistics 
regarding uptime history and an analysis of downtime.

VMkernel 
messages

ESX Server /var/log/vmkernel in the service console

To view the VMkernel message log:, from the management interface, click 
the VMkernel Log tab. 

VMkernel alerts 
and availability 
report

ESX Server /var/log/vmkernel in the service console

To view VMkernel log and the availability report: as the root user, from the 
management interface click Options >System Logs > the appropriate tab 
for the log file you want to view.

VMkernel 
warning

ESX Server /var/log/vmkwarning in the service console

To view VMkernel warnings and serious system alerts, from the 
management interface, click the VMkernel Warnings tab. 

Component Operating 
System

Name Location
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1. Run the following script on the service console:

/usr/bin/vm-support

2. Save the resulting file:

vpx-<date>-<unique-xnumber>.tgz

Collecting Service Log Files
You can enable logging for the VMware Authorization Service (known as vmware-
authd on Linux hosts) manually.

1. In a text editor, open the following file:

• On a Windows host, edit config.ini, located in C:\Documents and 
Settings\All Users\Application Data\VMware\VMware 

VirtualCenter.

• On a Linux host, edit /etc/vmware/config.

2. Add the following lines to the file: 

vmauthd.logEnabled = TRUE
log.vmauthdFileName = "vmauthd.log"

This creates a file called vmauthd.log. On a Windows host, this file appears by 
default in C:\Windows\system32 or C:\WINNT\system32; on a Linux 
host, this file appears by default in /var/log/vmware.

3. Save and close the configuration file. The log is enabled on a Linux host.

4. On a Windows host, restart the VMware Authorization Service. Choose Start > 
Administrative Tools > Services. Right-click VMware Authorization Service and 
choose Restart. This enables logging.

Collecting VirtualCenter Configuration Information
Enable logging:

1. Open or create the configuration file:

C:\Documents and Settings\All Users\Application 
Data\VMware\VMware VirtualCenter\config.ini

or

C:\Documents and Settings\All Users.WINNT\Application 
Data\VMware\VMware VirtualCenter\config.ini

2. Add the following line:

vpxd.logVerbose = "TRUE"
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Collecting VirtualCenter Settings Information
1. From the VirtualCenter client, open the VMware VirtualCenter Settings, 

Advanced tab.

Select File > VMware VirtualCenter Settings. When the 
dialog box appears, select the Advanced tab.

2. Record the information in the server.options field. Click OK.

Collecting VirtualCenter Log Files
These files are useful when you submit requests to technical support.

1. Open a command prompt window in the machine running VirtualCenter server.

2. Change to the directory where VirtualCenter is installed. 

For example, the if the default installation directory was used:

cd c:\Program Files\VMware\VMware VirtualCenter\

3. Run the following command to collect the logs:

cscript vclogs.wsf 

For example:

cscript vclogs.wsf /n:all /o:vclog.txt

To view help for the command, type at the script directory:

cscript vclogs.wsf /?

Help content is:

Microsoft (R) Windows Script Host Version 5.6
Copyright (C) Microsoft Corporation 1996-2001. All rights 
reserved.

This script collects VMware VirtualCenter server log files 
to help VMware customer support diagnose your problem.

Usage: vclogs.wsf [/?] [/n:value] [/o:value]

Options:
? : Displays this help
n : Number of logfiles to collect, default is 10. 
Specify 'all' to get all the logs.
o : Output filename, default is VirtualCenterLogs-
username-date.txt.

4. Locate and provide the VirtualCenter log.

The location of the VirtualCenter log is dependent on the platform it is running 
on as well as the user it is running as.
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Generally, the log is in TEMP directory. The TEMP directory for the system user is 
different on different platforms, but typically it is one of the following: 

C:\WINDOWS\Temp (on Windows XP)

C:\WINNT\Temp (on Windows 2000, Windows 2003). 

In either of these directory there are files named as follows:

vmware-vpxd-SYSTEM-<process_id>.log

5. Locate and provide the following log files, vmmsi.log and vminst.log. 
They are typically located in:

c:\documents and settings\administrator\local 
settings\temp\

6. Locate and provide the Event Viewer Log files from the VirtualCenter server. 

a. Log on as a user with VirtualCenter Administrator privileges.

b. Export the files in the defaul event viewer format with .evt extension.

7. Place all the required files into a zip file. 

Incorporate a timestamp into the zip file name.

Collecting GSX Server Files and Logs Using Scripts
The GSX Server log files are generated by GSX Server and are collected by the support 
script as needed. Since there is no support script on a remote GSX Server client, you 
need to submit a support request at www.vmware.com/requestsupport for any issues 
you encounter on a client and include the console’s log file or its installation log file.

With GSX Server hosts, you can simplify the process of collecting the needed 
information by running the support script to collect the appropriate log files and 
system information. Follow the steps below that apply to your host computer.

Note: The support script runs only on the GSX Server host. If you encounter 
problems on a remote client, you must supply the log files manually. The two log files 
you should supply, depending upon the problem you encounter on the client, 
include the VMware Virtual Machine Console log file and the installation log file. See 
below for more information about these logs.

Running GSX Server Scripts for Windows Hosts
1. Open a command prompt.

2. Change to the GSX Server program directory.

C: cd \Program Files\VMware\VMware GSX Server
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If you did not install the program in the default directory, use the appropriate 
drive letter and substitute the appropriate path in the cd command above.

3. Run the support script.

cscript vm-support.vbs

4. After the script runs, it displays the name of the directory where it has stored its 
output. Use a file compression utility such as WinZip or PKZIP to zip that 
directory, then include the zip file with your support request. 

Running GSX Server Scripts for Linux Hosts
1. Open a terminal.

2. Run the support script as the user who is running the virtual machine or as root.
vm-support

If you are not running the script as root, the script displays messages indicating 
that it cannot collect some information. This is normal. If the VMware support 
team needs that information, a support representative may ask you to run the 
script again as root.

3. The script creates a compressed .tgz file in the current directory. Include that 
output file with your support request. 
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Installing VMware VirtualCenter
This chapter describes how to install VMware VirtualCenter on your system. Included 
are the installation requirements and information about the installation process. This 
chapter contains the following topics:

• Preparing for the VirtualCenter Database on page 65

• Installing and Upgrading the VirtualCenter Product on page 70

• Finishing VirtualCenter Web Service Installation on page 83

• Connecting to VirtualCenter Through a Firewall on page 92

• Uninstalling VirtualCenter on page 95

• Uninstalling a VirtualCenter Component on page 98

• Adding a VirtualCenter Component on page 101

To install VirtualCenter, run a single installer package that contains the VirtualCenter 
client, VirtualCenter server, and the VMware SDK Web service. You can install only the 
VirtualCenter client, only the VirtualCenter server, or both on a single Windows 
system.The VirtualCenter agent installation is handled automatically by the 
VirtualCenter server. The VirtualCenter client package includes online help and 
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documentation for administrators and users. The VMware SDK Web service is installed 
with the VirtualCenter server.
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Preparing for the VirtualCenter 

Database
VirtualCenter supports three types of database formats:

• Microsoft Access (default) 

• Microsoft SQL Server 2000, Microsoft SQL Server 7 

• Oracle 8i

Each database requires some configuration adjustments in addition to the basic 
installation. The following sections describe these configuration adjustments.

The installation preparation topics are covered in the following sections:

• Configuring Oracle 8i and 9i Connection to Work Locally

• Configuring Oracle 8i or 9i Connection to Work Remotely

• Configuring a SQL Server ODBC Connection

• Configuring the Microsoft Access Database

Configuring Oracle 8i and 9i Connection to Work Locally
If you are planning to use an Oracle database as your VirtualCenter database, and you 
are going to have VirtualCenter access the database locally.

To prepare an Oracle database to work locally with VirtualCenter:

1. From the Oracle database machine install and prepare Oracle:

a. Install Oracle8i or Oracle 9i and create a database (VirtualCenter).

b. If you are installing Oracle 8i, then:

Download Oracle ODBC 8.1.5.7 from the Oracle Web site.

Install Oracle ODBC driver 8.1.5.7 through the Oracle Universal Installer 
(directions are provided with the driver).

c. If you are installing Oracle 9i, then:

Download Oracle ODBC 9.0.1.8 from the Oracle Web site.

Install Oracle ODBC driver 9.0.1.8 through the Oracle Universal Installer 
(directions are provided with the driver).

d. Increase the number of open cursors for the database. Add the entry 
open_cursors = 300 to the 
C:\Oracle\ADMIN\VPX\pfile\init.ora file.
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2. Connect Oracle locally:

a. Create a new tablespace specifically for VirtualCenter using the following SQL 
statement:

CREATE TABLESPACE vpx DATAFILE 
'C:\Oracle\ORADATA\VPX\vpx.dat' SIZE 500M;

b. Create a user for accessing this tablespace through ODBC:

CREATE USER vpxAdmin IDENTIFIED BY vpxadmin DEFAULT 
TABLESPACE vpx;

c. Allow that user CONNECT and DBA privileges:

GRANT CONNECT, DBA to vpxAdmin;

d. Create an ODBC connection to the database using the following settings:

Data Source Name: VMware VirtualCenter
TNS Service Name: VPX 
User Id: vpxAdmin

Configuring Oracle 8i or 9i Connection to Work Remotely
If you are planning to use an Oracle database as your VirtualCenter database, and you 
are going to have VirtualCenter access the database remotely.

To prepare an Oracle database to work remotely with VirtualCenter:

1. Install the Oracle client on the VirtualCenter server machine.

2. Connect Oracle remotely:

a. Download and install the ODBC driver 8.1.5.7 or 9.0.1.8, as appropriate.

b. Edit the tnsnames.ora file located at Ora81 or Ora91, as appropriate.

C:\Oracle\Oraxx\NETWORK\ADMIN

Where xx is either 81 or 91.

c. Use the Net8 Configuration Assistant to add the following entry:

VPX =
(DESCRIPTION =
 (ADDRESS_LIST =
   (ADDRESS=(PROTOCOL=TCP)(HOST=vpxd-Oracle)(PORT=1521))
   )
   (CONNECT_DATA =
    (SERVICE_NAME = VPX)
   )
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  )
HOST = 

Where HOST is the host to which the client needs to connect.

Configuring a SQL Server ODBC Connection
When you install VirtualCenter server, you have the option to establish a connection 
with a SQL Server database. The following procedure describes the procedure to 
configure a SQL Server ODBC connection. If you use the SQL Server authentication 
method, supply the same username, password, and ODBC system DSN in the wizard 
that you used to configure the ODBC. 

Refer to your Microsoft SQL ODBC documentation for specific instructions regarding 
configuring the SQL Server ODBC connection.

To prepare a SQL Server database to work with VirtualCenter:

1. On your Microsoft SQL server perform the following:

a. Create a SQL Server database using Enterprise Manager on the SQL Server.

b. Create a SQL Server database user with database operator (DBO) rights. 

The default database for the DBO user is what you defined in step 1.

2. Perform the following steps on your VirtualCenter server.

3. Open the Windows ODBC Data Source Administrator.

Select Settings > Control Panel > Administrative Tools > Data Sources (ODBC).

4. Select the System DSN tab.

5. Modify an existing SQL Server ODBC connection: 

a. Select the SQL Server ODBC DSN you want to modify.

b. Select the appropriate ODBC connection from the System Data Source list. 
Click Configure. 

c. Proceed with step 7 for creating a new SQL Server ODBC DSN connection.

6. Create a new SQL Server ODBC connection: 

a. Select Create New Data Source. Click Add.

b. Select a New Data Source to SQL Server. Click Finish.

7. Specify an ODBC DSN name.

Type the name in the Name field. For example, VMware VirtualCenter.

8. Optionally, specify an ODBC DSN description.
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Type the description in the Description field.

9. Select the DSN server name from the Server drop-down menu. 

Where local means local host. 

Type the SQL Server machine name in the field if you cannot find it in drop-
down menu.

10. Configure the SQL Server authentication screen. Click Next.

11. Select an authentication option.

Use either of the authentication methods: 

• If you are using local SQL Server, select Windows NT authentication.

• If you are using remote SQL Server, select SQL Server authentication. You can 
also choose Windows NT authentication. 

Note: The authentication option you choose for a remote SQL Server must 
match the local SQL Server.

To identify the authentication type:

a. Open SQL Server Enterprise Manager.

b. View Properties

c. Check the Mode. 

The mode indicates either Windows NT or SQL Server authentication type.
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12. Enter your SQL Server login and password.

Refer to your database administrator for this information.

13. Configure the default database. Click Next.

14. Select the database.

Select from the Change the default database to menu. Click Next.

15. Complete the process. Click Finish.

16. Verify the database source.

From the ODBC Microsoft SQL Server Setup menu. Select Test Data Source. 

If the test data source is acceptable, click OK. If it is not acceptable, return and 
reconfigure any incorrect items.

17. Close the ODBC Data Source Administrator. Click Close.

Configuring the Microsoft Access Database
If you find that the database performance is slow, increase the buffer size. 

To adjust the performance of the Microsoft Access database:

1. Open the Windows ODBC Data Source Administrator.

Select Settings > Control Panel > Administrative Tools > Data Sources (ODBC)

2. Select the System DSN tab.

3. Select ODBC Mircosoft Access Setup. Click Options.

4. Increase the buffer size. Then click OK.

The default value is 2048. Change it to 8192.
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5. Restart the VirtualCenter server, if it is running.

Refer to Starting or Stopping VMware VirtualCenter on page 108 for information 
on starting and restarting the VirtualCenter server.

Installing and Upgrading the 

VirtualCenter Product
This section describes how to upgrade or install your VirtualCenter product. This 
includes performing a fresh installation, adding a component to an existing 
installation, and upgrading existing components to the latest VirtualCenter version. 
The topics are described in the following sections:

• Starting the VirtualCenter Installer for an Upgrade Installation

• Starting the VirtualCenter Installer for a First Time Installation on page 72

• Selecting the Components to Install on page 74

• Installing the VirtualCenter Server on page 77

• Installing the VMware Web Service on page 80

• Completing the Installation on page 82

VMware VirtualCenter installs the following components:

• VirtualCenter client — A user interface that runs locally on a Windows host 
with network access to the VirtualCenter server.

• VirtualCenter server — A service that acts as a central administrator for 
VMware servers connected on a network, to direct actions upon the virtual 
machines and the virtual machine hosts. VirtualCenter server is the central 
working core of VirtualCenter.

Note: A host can only be registered with one VirtualCenter server. If you try to 
register an host that it is already registered with a different VirtualCenter server, 
an error message appears and you are prevented from adding the host to the 
additional VirtualCenter server.

• VirtualCenter database — A database dedicated to the VirtualCenter 
processes. It is installed when the VirtualCenter server is installed.

• VirtualCenter agent — An agent installed on each host to be under 
VirtualCenter control. It coordinates the actions received from the VirtualCenter 
server.
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• VMware Web Service — A component of the VMware SDK. It is installed by 
default with the VirtualCenter server. It cannot be installed without the 
VirtualCenter server.

Note: Install and use only one VirtualCenter server to control all, or specific groups of, 
hosts. Do not have multiple VirtualCenter servers controlling the same host. Instead, 
install multiple copies of the VirtualCenter client. From each VirtualCenter client, you 
can access any networked VirtualCenter server. 

Note: The VirtualCenter client does not store any persistent information on your 
local machine.

Starting the VirtualCenter Installer for an Upgrade Installation
When you upgrade your VirtualCenter version, you must upgrade all the components, 
this includes your VirtualCenter server and VirtualCenter client. 

To upgrade your VirtualCenter components on each machine that has a client 
or server:

1. Backup your VirtualCenter database.

It is recommended that your database administrator (DBA) perform this task.

2. If you are using an Oracle database: prior to upgrading, make sure that 
shared_pool_size parameter is set to no less than 100MB.

This ensures that the upgrade to performs reasonably. 

The shared_pool_size parameter is in the init.ora file. Have your 
Oracle database administrator check and set this.

3. Download the VirtualCenter installer file from the VMware secure Web site to a 
local drive.

www.vmware.com

Contact your VMware representative for information on the location of the 
secure Web site.

4. Run the installer.

Double-click the VMware installation icon or select Start > Run and enter the 
location of the installer in the Run window.

The VirtualCenter installer prepares to install the components. 

5. Verify you are upgrading the VirtualCenter product. Click Next.

6. Accept the upgrade wizard. Click Next.
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The VirtualCenter installer checks the local machine to identify what 
VirtualCenter components are installed. 

7. If the VirtualCenter server is installed: declare whether to install the VMware 
Web Service. 

Note: The VMware Web Service must be installed on the same machine as the 
VirtualCenter server. 

To install the Web service, click the Install VirtualCenter Web service checkbox. 
Then click Next.

If VirtualCenter server is not already installed or an older version is installed, the 
current version of VirtualCenter server is installed or upgraded, as needed.

8. Proceed to the section appropriate to the component(s) you selected.

If you are installing the Web service, proceed to the section, Installing the 
VirtualCenter Server on page 77.

If you are upgrading the VirtualCenter server or VirtualCenter client, proceed to 
the section, Completing the Installation on page 82.

Starting the VirtualCenter Installer for a First Time Installation
To install a VirtualCenter component on your client, server, or host:

1. Download the VirtualCenter installer file from the VMware secure Web site to a 
local drive.

Contact your VMware representative for information on the location of the 
secure Web site.

2. Run the installer.
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Double-click the VMware installation icon or select Start > Run and enter the 
location of the installer in the Run window.

The VirtualCenter installer prepares to install the components. 

3. If you do not have Microsoft .NET Framework version 1.1 on your machine, then 
a prompt is displayed to ask if you wish to install it.

If you click Yes, then the installer automatically installs this package. If you have 
installed an older version, then the installer automatically upgrades your version 
to version 1.1.

For more information on .NET Framework 1.1, see msdn.microsoft.com/
netframework/technologyinfo/.

4. Verify you are installing the VirtualCenter product. Click Next.

5. Accept the VMware license terms. 

Click the Accept button, then click Next.

6. Enter your customer identification information. 

Enter your user name, company name, and select the appropriate user 
application status radio button. Then click Next to continue the installation. 

7. Proceed to the next section.
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Selecting the Components to Install
1. Select the type of installation setup. 

The choices are:

• Client — Installs the VirtualCenter client and VirtualCenter database 
components on the local machine. 

• Server — Installs the VirtualCenter server and the Web service component on 
the local machine.

Web service — Installed by default with the VirtualCenter server. It is a 
programmatic interface that allows customer-written or third-party 
applications to access services provided by VirtualCenter. This is not a user 
interface for configuring VirtualCenter.

You must install the VirtualCenter server to install the Web service. For 
information about writing programs that use the VirtualCenter Web service, 
refer to the VMware SDK documentation available at:

www.vmware.com/support/developer/vc-sdk

• Custom — Allows you to select which items to install and where, within the 
network, they are to be installed.

Click the appropriate radio button. Then click Next to continue the installation. 

• If you selected Client only, skip to Completing the Installation on page 82. 

• If you selected Server only, skip to Installing the VirtualCenter Server on 
page 77. The default is to install the Web service with the Server option.

• If you selected Custom, proceed with the next step.
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2. Select the VirtualCenter component(s) to install.

Click the down arrow next to the appropriate component and select from the 
drop-down menu.

If you unselect an item, its icon changes to an X. The Space and Change buttons 
are grayed, if a component is not selected.
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3. Make adjustments for available disk space.

Click the Space button from the Custom Setup screen. In the Disk Space 
Requirements screen, click and drag column headers to view all columns as 
needed. 

If a volume line is highlighted, click OK, return to the previous screen, and select 
to install either the client or the server, as both do not fit in the available disk 
space. 

Click OK to return to the Custom Setup screen.

4. Change location, as needed.

Click the Custom button from the Custom Setup screen. In the Change Current 
Destination Folders screen. 

Browse to find the appropriate location. Click OK to return to the Custom Setup 
screen.
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After your selections are made, click OK to return to the Custom Setup screen.

5. Complete the Custom Setup screen. Click Next. 

6. Proceed to the section appropriate to the component(s) you selected.

If you selected Client only, skip to Completing the Installation on page 82. 

If you selected Server, proceed to the next section, Installing the VirtualCenter 
Server on page 77. 

Installing the VirtualCenter Server
1. Set up or confirm the type of VirtualCenter database you wish to use.

Select whether to have the VirtualCenter create a database, or to create either a 
custom SQL Server or Oracle database, or if you are upgrading, need to specify 
the previous database used. The options are:

• Use Access database — VirtualCenter automatically creates a Microsoft 
Access database. 

This is a file in Microsoft Access format.

• Use a custom SQL Server database connection — VirtualCenter prompts for 
DSN information then configures the database.

Supported versions are: SQL Server 7, or SQL Server 2000

• Use a custom Oracle database connection — VirtualCenter prompts for DSN 
information, a username, and a password, then configures the database.

Supported versions are: Oracle 8i and Oracle 9i

The VirtualCenter database can be remote to the VirtualCenter server. The 
VirtualCenter database user is configured as the initial Administrative user.
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You must already have installed and configured the database application. Refer 
to Preparing for the VirtualCenter Database on page 65 for additional 
information. 

2. If you have an existing database: Click Yes at the prompt. 

If you are performing an upgrade to the VirtualCenter server or adding the 
VirtualCenter Web service, you might see this prompt.

3. To create a Microsoft Access database: click the Use Access database button, 
then click Next.

4. To create an Oracle or SQL Server database connection: perform the 
following:

a. Click Use custom SQL or Oracle database connection, then click Next. 

b. Manually create a new System DSN. Click Add. Set the name to VMware 
VirtualCenter. 
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c. Provide a username and a password. 

d. If an existing custom connection is already present, click Cancel to quit the 
ODBC Data Source Administrator. 

VirtualCenter checks that the connection is valid before it allows the 
installation to continue. 

For an Oracle database, connect through an Oracle driver. You must upgrade 
the Oracle driver to version 8.1.7 for the Oracle 8.1.5 database. If you have not 
already done so, refer to Preparing for the VirtualCenter Database on page 65 
and perform the preparation steps before proceeding.

VirtualCenter then stores the VirtualCenter database information in the 
registry.

For additional information on creating an ODBC data source, refer to your 
Windows documentation.

5. Proceed to the appropriate section.

• If you are not installing the Web service, skip to Completing the Installation on 
page 82. 

• If you are installing the Web service, proceed to the next section, Installing the 
VMware Web Service on page 80.
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Installing the VMware Web Service
You can install the Web service on any machine that also has the VirtualCenter 
server.The VMware SDK package is not installed through the VirtualCenter installer. For 
information about writing programs that use the VirtualCenter Web service, refer to 
the VMware SDK documentation available at:

www.vmware.com/support/developer/vc-sdk

To install the Web service, continue with the VirtualCenter installer. 

1. Enter the information to enable the Web service to connect to the VirtualCenter 
server.

• VMware VirtualCenter server hostname — Typically, this is the same 
machine on which you are installing the VirtualCenter, or localhost.

• VMware VirtualCenter server port number — Port number for the 
VirtualCenter server. The default port number is 905.

• VMware Web Service port — Specifies the Virtual Machine Agent server port 
number. Use the default port number of 8443, unless this port is already in 
use.

• VMware VirtualCenter user name — This user must have VirtualCenter 
Administrator privileges.

• VMware VirtualCenter password — The password for the user name you 
previously entered.

The Web service uses this username and password to connect to the 
VirtualCenter server, and has the privileges assigned to this administrator user. 
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Refer to the VirtualCenter documentation for information on the various users 
and groups.

2. Select whether to accept the default VMware certificates or use your own 
certificates. 

a. To accept the VMware certificates: leave all the fields unchanged and click 
Next. 

b. To specify your own certificates: enter the path to your own certificates, 
then click Next.

You can always update or modify the digital certificates at a later time. Refer to 
Updating VMware SDK Digital Certificates on page 90.

The following files are required for digital certification. 

server Certificate: stored in vmaConfig.xml as <sslCert>
server CA Chain: stored in vmaConfig.xml as <sslCAChain>
server private Key: Stored in the registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Vmware, Inc.\VMWare 
SDK\CertInfo

3. Proceed to the next section.
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Completing the Installation
1. Verify that you are ready to proceed with installation. Click Install to continue the 

installation. 

Progress messages appear while the installation proceeds. The VirtualCenter 
installer, as specified, installs the VirtualCenter server, starts the VirtualCenter 
database, performs a default access setup of the open database connectivity 
(ODBC), registers and activates the VirtualCenter server, and installs the 
VirtualCenter client. 

Note: If you are upgrading your VirtualCenter server, the VirtualCenter database 
is also upgraded. This can take a long time, from several minutes to hours, 
depending up on the size of your database. Do not click Cancel. Be patient. 

2. Close the installation wizard and, if prompted, restart your computer. Click Finish.

The selected VirtualCenter components are installed on your Windows machine.

Appropriate services are started, including the VirtualCenter server and the 
ProtectedStorage service, as appropriate to the VirtualCenter components 
installed on the machine.
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Finishing VirtualCenter Web Service 

Installation
After installing the SDK component, it is recommended that you perform and/or 
verify the steps in the following sections:

• Verifying VirtualCenter Web Service Installation

• Changing VMware Web Service Options After Installation

• Updating VMware SDK Digital Certificates

Verifying VirtualCenter Web Service Installation
After installing the VirtualCenter Web service, you can verify that it is installed and 
working correctly using the following steps. 

1. Validate that VirtualCenter is installed and running correctly by opening a 
VirtualCenter client and connecting to the VirtualCenter server. If VirtualCenter is 
not running, the Web service will not function. Log in with the same username 
and password that you entered during installation to make sure that those are 
valid. 

2. Open Internet Explorer on the Windows machine on which the two services are 
running and open the following URL.

C:\Documents and Settings\All Users\Application 
Data\VMware\VMware VirtualCenter\VMA\login\login.html

3. Optionally, enable access from remote locations.

a. Using a text editor, open the vmaConfig.xml file to include the URL path. 

The file is located at: C:\Documents and Settings\All 
Users\Application Data\VMware\VMware VirtualCenter\VMA

This file is designated as hidden. Make sure your Windows Explorer is set to 
view hidden files if you cannot see it.

b. Add the following:

<vma>
<service>
...
<docRoot>C:\Documents and Settings\All Users\Application 
Data\VMware\VMware VirtualCenter\VMA\login</docRoot>
</service>
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...
</vma>

c. Save the file.

d. Restart the Web service.

e. Type the Web service URL directly into your browser specifying the Web 
service host machine. For example:

https://<webservicemachine>:8443/login.html

Note: Use caution when putting the docRoot element into 
vmaConfig.xml. Since this allows access to all files below the specified 
directory, a mistake in the docRoot directory path or placing documents in the 
directory that should not be present in it, can result in documents not intended 
for public access becoming inadvertently accessible.

4. Enter the login information

a. Type your user name and password.

b. Type the Web service URL, for example:

https://localhost:8443

Note: 8443 is the default port number. If you entered a different port number 
during installation, use that instead. 

If the Web service is installed correctly, an XML message or file is displayed in the 
browse. This indicates that the Web service is operating and responding to 
queries. 

If VirtualCenter does not accept the username and password you entered, the 
XML message indicates permission denied. 
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If VirtualCenter does accept the username and password you entered, an XML 
file similar to the one below, showing the top-level information paths available 
through the Web service. 

If you see a page not-found message ensure that you have the correct port 
number by reviewing the vmaConfig.xml file. 

If you get different behavior, ensure that the username and password you 
entered during installation are valid within VirtualCenter. Even if you enter an 
acceptable username and password through the browser, if the Web service 
itself is not configured with valid credentials, it will not operate correctly. If 
necessary, modify the Web service configuration as described in Changing 
VMware Web Service Options After Installation on page 88, or uninstall and re-
install the Web service.

<?xml version="1.0" encoding="UTF-8" ?> 
- <env:Envelope xmlns:xsd="http://www.w3.org/2001/
   XMLSchema" xmlns:env="http://schemas.xmlsoap.org/soap/
   envelope/" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
   instance">
- <env:Body>
   - <GetContentsResponse env:encodingStyle="http://
      schemas.xmlsoap.org/soap/encoding/"
       xmlns="urn:vma1">
   - <returnval>
     <handle>vma-0000-0000-0000</handle>
     <vHandle>vma-0000-0000-0000@fd0b16f9a6000002</
       vHandle> 
   - <body xsi:type="Container">
     - <item>
       <key>vma-0000-0000-0001</key> 
       <name>vcenter</name> 
       <type>Container</type> 
       - <perm>
         <key>Administrators</key> 
         <rights>Admin</rights> 
       </perm>
     </item>
   - <item>
        <key>vma-0000-0000-0002</key> 
        <name>webservice</name> 
        <type>Container</type> 
    </item>
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    - <item>
        <key>vma-0000-0000-0008</key> 
        <name>host</name> 
        <type>Container</type> 
    </item>
    - <item>
        <key>vma-0000-0000-0009</key> 
        <name>vm</name> 
        <type>Container</type> 
    </item>
    - <item>
        <key>vma-0000-0000-000a</key> 
        <name>unknownVM</name> 
        <type>Container</type> 
    </item>
    - <item>
        <key>vma-stats-conf</key> 
        <name>perf</name> 
        <type>Container</type> 
    </item>
    - <item>
        <key>vma-datastore</key>
        <name>datastore</name> 
        <type>DatastoreInfoList</type> 
    </item>
    - <item>
        <key>vma-global-conf</key> 
        <name>customProperty</name> 
        <type>CustomPropertyList</type> 
    </item>
    - <item>
        <key>vma-0000-0000-0013</key> 
        <name>event</name> 
        <type>Container</type> 
    </item>
    - <item>
        <key>vma-0000-0000-0018</key> 
        <name>task</name> 
        <type>Container</type> 
    </item>
    - <item>
        <key>vma-0000-0000-0019</key> 
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        <name>schedule</name> 
        <type>Container</type> 
    </item>
    - <item>
        <key>vma-0000-0000-001a</key> 
        <name>template</name> 
        <type>Container</type> 
     </item>
    </body>
   </returnval>
  </GetContentsResponse>
 </env:Body>
</env:Envelope>

5. Once you have been properly authenticated through the browser interface, 
review the information available through the Web service and confirm that it 
matches the VirtualCenter client. 

To do this: append paths to the URL. For example:

https://localhost:8443/vcenter

This address returns an XML representation of the VirtualCenter hierarchy.   Drill 
down further by, for example, appending the name of a farm: /vcenter/
test-farm. Browsing top-level paths /host or /vm displays lists of the 
hosts or UUIDs of virtual machines being managed by VirtualCenter. Drilling 
down displays XML documents with host and virtual machine details. 
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Changing VMware Web Service Options After Installation
The Web service provides an command line command, vma, for making selected 
configuration modifications.

To use the vma command:

1. Stop the Web service.

a. Select Start > Programs > Administrative Tools > Services. 

b. Right click the Web service and select Stop

.

2. Start the command line window.

Select Start > Run. Type cmd. Click OK. 

3. Change to the Web service application data directory:

cd c:\Documents And Settings\All Users\Applicaton 
Data\VMware\VMware VirtualCenter\VMA

4. Execute the vma.exe command at the prompt:

c:\Program Files\VMware\VMware VirtualCenter\ 

vma.exe can be invoked in to ways: with and without the -update option. To 
view help information on the vma command, type: vma -help.

• Executing the vma command without the -update option: runs the Web 
service. 

The only option permitted in this mode is -config <config-
filename>. This option specifies a configuration file for the Web service to 
use. If -config is not specified, the service looks for the default 
configuration file, vmaConfig.xml, in the current directory.
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• Executing the vma command with the -update option: updates the 
specified configuration information and exits. The configuration information 
that can be updated is listed in the table below.

For example, to connect to the VirtualCenter server as a user other than the 
one you specified in the installation, type in the terminal window:

vma -update -username <username> -password <password>

where <username> is the new user name and <password> is the new 
password. The changes are written to the vmaConfig.xml file.

The following table lists the vma -update command options. 

5. Restart the Web service for changes to take effect. 

a. Select Start > Programs > Administrative Tools > Services. 

b. Right click the Web service and select Start.

vma Option Description

-help Lists the options for this command.

-config <config-file> Update the Web service to use the specified alternate VMA 
configuration file. The default file is vmaConfig.xml.

-VMAport <port> Update the Web service to use the specified the port number for 
the VMA server; the default is 8443.

-username <username> Update the Web service to use the specified the user name to 
connect to the VirtualCenter server. 

-password <password> Update the Web service to use the specified the password for the 
user that connects to the VirtualCenter server.

-hostname <hostname> Update the Web service to use the specified the name of the 
VirtualCenter server. Typically, it is the same machine on which the 
Web service is installed, or localhost.

-port <port> Update the Web service to use the specified the port number of the 
VirtualCenterserver. The default port number is 905.

-subject For internal use.

-sslCert <sslcert> Update the Web service to use the specified the SSL certificate file.

-sslCAChain <sslcachain> Update the Web service to use the specified the SSL certificate CA 
chain file.

-sslPrivateKey <sslprivatekey> Update the Web service to use the specified the SSL private key file.

-sslPassphrase <sslpassphrase> Update the Web service to use the specified the SSL passphrase for 
private key.
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6. Edit the vmaConfig.xml as needed.

Although most Web service configuration options should be set through the 
vma.exe -update command, certain options can only be set by editing 
vmaConfig.xml directly. 

• Non-SSL port

By default, the Web service is bound to an SSL port. To configure the Web 
service to listen on a non-SSL port, for example 8443, add the following to 
vmaConfig.xml.

<vma>
<service>
...
<port>8443</port>
...
</service>
...
</vma>

• Log Level

There are three levels of logging available for the Web service: error, info, 
and verbose. Info is the default level. This is reflected by the following link 
in vmaConifg.xml.

<eventlog level="info" /> 

Updating VMware SDK Digital Certificates
Periodically, for security reasons, you may choose to update your Web service digital 
certificates. You can modify or create your own. Only PEM format certificates are 
supported. The required certificates are:

• server Certificate— stored in vmaConfig.xml as <sslCert>

• server CA Chain — stored in vmaConfig.xml as <sslCAChain>

• server private Key — stored in the registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Vmware, Inc.\VMWare 

SDK\CertInfo

Note: When you create the certificate files, place the privateKey in a separate file and 
store it separately from the other Web service digital certificates.
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To change the digital certificates, from the Windows machine on which the Web 
service is installed:

1. Start the command line window.

Select Start > Run. Type cmd. Click OK. 

2. Change to the Web service application data directory:

cd c:\Documents And Settings\All Users\Applicaton 
Data\VMware\VMware VirtualCenter\VMA

3. Execute the vma.exe command at the prompt:

c:\Program Files\VMware\VMware VirtualCenter\ 
vma.exe -update -sslCert <sslCert file>
vma.exe -update -sslCert <sslCert file> 
vma.exe -update -sslCAChain <sslCAChain file>
vma.exe -update -sslPrivateKey <private key file> 
vma.exe -update -sslPassphrase <pass phrase if one exists>

For example:

vma.exe -update -sslCert certificate.pem
vma.exe -update -sslCAChain root.pem
vma.exe -update -sslPrivateKey key.pem
vma.exe -update -sslPassphrase authentication
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Connecting to VirtualCenter Through a 

Firewall
If you have a firewall or if you need to connect to VirtualCenter through a Web 
browser, refer to the following sections:

• Connecting Your VirtualCenter Hosts Through a Firewall on page 92

Use this option if you are connecting a host to the VirtualCenter server when the 
elements are separated by  a firewall.

• Connecting Your VirtualCenter Clients Through a Firewall on page 93

Use this option if you are connecting a VirtualCenter client to a VirtualCenter 
server when the elements are separated by  a firewall.

Connecting Your VirtualCenter Hosts Through a Firewall
If any component of your VirtualCenter environment is on the other side of a firewall 
from the VirtualCenter server, you need to open a pass through port to enable 
communication. All entities must be able to communicate. This includes the host on 
which the VirtualCenter server is installed, the ESX Server or GSX Server host, and the 
VirtualCenter server. 

Selected ports allow designated traffic. 

• port 905 — the default port for VirtualCenter client to VirtualCenter server 
communications.

• port 902 — the defined port for encrypted secure socket layer (ssl) 
VirtualCenter server to ESX Server or GSX Server communications. This port, 
when defined, is host specific. 

• port 8443 — the VMware SDK port.

To open a port for firewall pass through communication:

Open the appropriate port to receive incoming traffic, for the relevant VirtualCenter 
entity.

VirtualCenter entity Open ports for traffic

Managed ESX Server host Port 902

Managed GSX Server host Port 902

VirtualCenter server host Port 905 and optionally 8443 (for SDK use)

VirtualCenter client host No extra settings required. 
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Refer to the firewall system administrator for additional information on configuring 
the ports.

Connecting Your VirtualCenter Clients Through  a Firewall
Connection between the VirtualCenter server and VirtualCenter client on opposite 
sides of a firewall is available through Web site port 80. Secure Web site data transfer is 
available through Port 443. 

Note: You have the option to specify any other port value that is appropriate to your 
situation.

To enable your VirtualCenter client to connect with the VirtualCenter server, change 
the Web site port address on your VirtualCenter server. 

To open a Web port between the VirtualCenter server and the VirtualCenter 
client, using IIS:

On the VirtualCenter server:

1. Install Internet Information Services (IIS) Manager. 

Typically, this is installed by default with the Microsoft Windows operating 
system. 

2. Enable IIS

Select Start > Control Panel > Administrative Tools > Internet Services 
Manager >  Internet Information Services

3. From the IIS manager, open the Windows dialog box.

Expand the  <server_name>

Right-click on the Default Web Site.

Select Properties >  Web Site tab.

4. Set the port value for the VirtualCenter service.

In the Web Site Description block, enter the value in the TCP Port or if allowed 
the SSL port. 

A value of 80 is the default non-secure TCP Web site port. A value of 443 is the 
default secure SSL Web site port. 

5. Set the dll directory. 

a. If needed, create the directory:

C:\inetpub\wwwroot\vpx\

b. Set the permissions for this directory to allow execute.
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c. Copy the file vmdbhttpproxy.dll to this directory.

The file is in \Program Files\VMware\VMware VirtualCenter

6. Verify that the change has been applied.

Stop then restart the default web site.

7. Each time you update the VirtualCenter version, repeat this process.

When you start the VirtualCenter client, enter the VirtualCenter server Web site 
address as in the Server field.

• If you are using the secure Web port or any other non-default port, use the full 
name: http:<server name>:<port>.

For example, http:vcserver:443

• If you are using the default non-secure Web site port, any of the following 
combinations work: http:<server name>, <server name>80, or 
http:<server name>:80. 
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Uninstalling VirtualCenter
If both your VirtualCenter client and VirtualCenter server are installed on the same 
system, then you may uninstall one or both in the same step. You must have 
Administrator privileges to uninstall the VirtualCenter server. If you try to uninstall the 
VirtualCenter server while it is running, you must confirm that you really want to take 
action, as it causes a disruption to any VirtualCenter clients connected to the service. 

Uninstalling the VirtualCenter components does not uninstall the .NET framework. Do 
not uninstall the .NET framework if you have other applications on your system that 
depend upon it.

To uninstall VirtualCenter, choose either the VirtualCenter installer or the Windows 
Add/Remove tool.

Uninstalling VirtualCenter Using the Windows Add/Remove 
Tool

1. As Administrator on the Windows system, click through the Windows system to 
the Add/Remove Programs.

Select Start > Control Panel > Add/Remove Programs. Scroll through the list of 
installed programs and select the appropriate VMware VirtualCenter 
component to remove, this includes the VirtualCenter server, VirtualCenter 
client, or the Web service. Click Remove.

2. Confirm that you want to remove the program. Click Yes. 
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3. Select to remove the VirtualCenter database and settings or not.

Click Yes to remove all traces of VirtualCenter. Click No to retain the VirtualCenter 
database and settings in preparation for a reinstallation.

4. Close the installation wizard. Click Finish.

All or any installed VirtualCenter components are removed. This includes 
VirtualCenter client, VirtualCenter server, and Web service. 

Uninstalling VirtualCenter Using the VirtualCenter Installer
1. As Administrator on the Windows system, run the installer.

Double-click the VMware installation icon or select Start > Run and enter the 
location of the installer in the Run window.

2. Accept the VirtualCenter Installer. Click Next.

3. Select the Remove option.

Click the appropriate radio button, then click Next.

4. Verify ready to proceed with uninstallation. Click Remove.

VirtualCenter displays a progress screen as it proceeds with the uninstallation. 
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5. If you are removing the VirtualCenter server: select to remove the 
VirtualCenter database settings or not. This does not remove the actual database 
from your system. It removes the ODBC references only.

6. Click Yes to remove all traces of VirtualCenter. Click No to retain the VirtualCenter 
database and settings in preparation for a reinstallation.

7. Close the installation wizard. Click Finish.

All or any installed VirtualCenter components are removed. This includes 
VirtualCenter client, VirtualCenter server, and Web service. 
97



VMware VirtualCenter User’s Manual
Uninstalling a VirtualCenter Component
If both your VirtualCenter client and VirtualCenter server are installed on the same 
system, then you may uninstall one or both in the same step. You must have 
Administrator privileges to uninstall the VirtualCenter server. If you try to uninstall the 
VirtualCenter server while it is running, you must confirm that you really want to take 
action, as it causes a disruption to any VirtualCenter clients connected to the service. 

Uninstalling the VirtualCenter components does not uninstall the .NET framework. Do 
not uninstall the .NET framework if you have other applications on your system that 
depend upon it.

To uninstall a VirtualCenter component, choose either the VirtualCenter installer or 
the Windows Add/Remove tool.

Uninstalling a VirtualCenter Component Using the Windows 
Add/Remove Tool

1. As Administrator on the Windows system, click through the Windows system to 
the Add/Remove Programs.

Select Start > Control Panel > Add/Remove Programs. Scroll through the list of 
installed programs and select the appropriate VMware VirtualCenter 
component to remove, this includes the VirtualCenter server, VirtualCenter 
client, or the Web service. Click Change.

The VirtualCenter installer starts.

2. Proceed to step 2 in the following section, Uninstalling a VirtualCenter 
Component Using the VirtualCenter Installer on page 99. 
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Uninstalling a VirtualCenter Component Using the 
VirtualCenter Installer

1. As Administrator on the Windows system, run the installer.

Double-click the VMware installation icon or select Start > Run and enter the 
location of the installer in the Run window.

2. Accept the VirtualCenter Installer. Click Next.

3. Select the Modify option.

Click the appropriate radio button, then click Next.

4. Deselect the components to uninstall, as needed.

Note: If you uninstall the VirtualCenter server, the Web service is also 
uninstalled. If you uninstall the Web service only, the VirtualCenter server 
remains.
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5. Verify ready to proceed with uninstallation. Click Next.

VirtualCenter displays a progress screen as it proceeds with the uninstallation. 

6. If you are removing the VirtualCenter server: select to remove the 
VirtualCenter database settings or not. This does not remove the actual database 
from your system. It removes the ODBC references only.

Click Yes to remove all traces of VirtualCenter. Click No to retain the VirtualCenter 
database and settings in preparation for a reinstallation.

7. Close the installation wizard. Click Finish.

All or any installed VirtualCenter components are removed. This includes 
VirtualCenter client, VirtualCenter server, and Web service. 
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Adding a VirtualCenter Component
Modifying your VirtualCenter installation includes adding or removing selected 
components. If you have installed a VirtualCenter component on a system, you can 
later install or remove individual components.

Note: To install the Web service on a machine, the VirtualCenter server must also be 
installed on that machine.

To modify the VirtualCenter installation:

1. Run the VirtualCenter installer.

Double-click the VMware installation icon or select Start > Run and enter the 
location of the installer in the Run window.

2. Specify the type of modification you are performing.

Click the appropriate radio button, then click Next to continue. 
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3. If you selected Modify, change the installation options for the VirtualCenter 
server and/or VirtualCenter client.

If you are adding a VirtualCenter client, skip to step 8.

If you are adding a VirtualCenter server, proceed with the next step. 

If you are adding a Web service and the VirtualCenter server is already installed, 
proceed to step 7.

4. If you are installing the VirtualCenter server: Set up the VirtualCenter 
database.

Select whether to have the VirtualCenter create a database, or to create either a 
custom SQL Server or Oracle database. The options are:

• Use Access database — VirtualCenter automatically creates a Microsoft 
Access database. 

This is a file in Microsoft Access format.
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• Use a custom SQL Server database connection — VirtualCenter prompts for 
DSN information then configures the database.

Supported versions are: SQL Server 7, SQL Server 2000, or SQL Server 2003

• Use a custom Oracle database connection — VirtualCenter prompts for DSN 
information, a username, and a password, then configures the database.

Supported versions are: Oracle 8i and Oracle 9i

The VirtualCenter database can be remote to the VirtualCenter server. The 
VirtualCenter database user is configured as the initial Administrative user.

You must already have installed and configured the database application. Refer 
to Preparing for the VirtualCenter Database on page 65 for additional 
information. 

5. To create a Microsoft Access database: click the Use Access database button, 
then click Next.

6. To create an Oracle or SQL Server database connection: perform the 
following:

a. Click Use custom SQL or Oracle database connection, then click Next. 

b. Manually create a new System DSN. Click Add. Set the name to VMware 
VirtualCenter. 
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c. Provide a username and a password. 

d. If an existing custom connection is already present, click Cancel to quit the 
ODBC Data Source Administrator. 

VirtualCenter checks that the connection is valid before it allows the 
installation to continue. 

For an Oracle database, connect through an Oracle driver. You must upgrade 
the Oracle driver to version 8.1.7 for the Oracle 8.1.5 database. If you have not 
already done so, refer to Preparing for the VirtualCenter Database on page 65 
and perform the preparation steps before proceeding.

VirtualCenter then stores the VirtualCenter database information in the 
registry.

For additional information on creating an ODBC data source, refer to your 
Windows documentation.
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7. To install the Web service: you must have the VirtualCenter server installed and 
selected the Web service option at the Custom step. Proceed with the 
VirtualCenter installer. 

a. Enter the information to enable the Web service to connect to the 
VirtualCenter server.

• VMware VirtualCenter server hostname — Typically, this is the same 
machine on which you are installing the VirtualCenter, or localhost.

• VMware VirtualCenter server port number — Port number for the 
VirtualCenter server. The default port number is 905.

• VMware Web Service port — Specifies the Virtual Machine Agent server port 
number. Use the default port number of 8443, unless this port is already in 
use.

• VMware VirtualCenter user name — This user must have VirtualCenter 
Administrator privileges.

• VMware VirtualCenter password — The password for the user name you 
previously entered.

The Web service uses this username and password to connect to the 
VirtualCenter server, and has the privileges assigned to this administrator user. 
Refer to the VirtualCenter documentation for information on the various users 
and groups.
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b. Select whether to accept the default VMware certificates or use your own 
certificates. 

• To accept the VMware certificates: leave all the fields unchanged and click 
Next. 

• To specify your own certificates: enter the path to your own certificates, 
then click Next.

You can always update or modify the digital certificates at a later time. Refer to 
Updating VMware SDK Digital Certificates on page 90.

The following files are required for digital certification. 

server Certificate: stored in vmaConfig.xml as <sslCert>
server CA Chain: stored in vmaConfig.xml as <sslCAChain>
server private Key: Stored in the registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Vmware, Inc.\VMWare 
SDK\CertInfo

8. Verify that you are ready to proceed with reinstallation. Click Install.

The screen title reflects the choice to repair or modify the installation of 
VirtualCenter on this machine. Click Install.

VirtualCenter displays a progress screen as the reinstallation proceeds. The 
VirtualCenter database retains any existing content. 

9. Close the installation wizard. Click Finish.

10. If you installed the Web service: verify the Web service installation, refer to 
Finishing VirtualCenter Web Service Installation on page 83
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Starting VMware VirtualCenter
This chapter describes how to start, stop and move around in VirtualCenter. In 
addition, as licensing is required to add a host, this chapter describes how to add 
licenses. This chapter contains the following topics:

• Starting or Stopping VMware VirtualCenter on page 108

• Starting and Stopping the VirtualCenter Client on page 112

• Adding Licenses on page 116

• Navigating in the VirtualCenter Client on page 118

You need only a Read Only User role assigned to the farm, host, or virtual machine to 
view objects in VirtualCenter. However, you need VirtualCenter Administrator role to 
add or change licenses. 
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Starting or Stopping VMware 

VirtualCenter
When you install VirtualCenter, it is registered as a single Windows service that 
appears in the Windows Services list. The VirtualCenter server is an automatically 
started Windows Service. 

The VirtualCenter server continues to function and perform its monitoring and 
managing activities in the background. This means that even when you are not 
logged on to the VirtualCenter client, the VirtualCenter server continues its 
monitoring and scheduled activities. 

The VirtualCenter database is configured during installation. Applying changes to the 
VirtualCenter database after the VirtualCenter server is started might cause a 
temporary disruption to other users accessing the same VirtualCenter server.

All the VirtualCenter activities are specified through the VirtualCenter client and 
performed by the VirtualCenter server. 

To monitor and manage the VirtualCenter activities:

1. Start the VirtualCenter client.

2. Log on to the VirtualCenter server.

The starting and stopping topics are covered in the following sections:

• Getting Started with VirtualCenter Users

• Verifying the VirtualCenter Server has Started

• Restarting the VirtualCenter Server

• Restarting the VirtualCenter Agent

• Stopping the VirtualCenter Server

Getting Started with VirtualCenter Users
When VirtualCenter is installed, the Administrator user installing VirtualCenter is 
assigned VirtualCenter Administrator privileges for the VirtualCenter environment. 
Permissions for all other VirtualCenter users need to be explicitly set by a VirtualCenter 
Administrator.

VirtualCenter supports user groups. Users may belong to one or more groups, to allow 
aggregate security assignments. Users assume the roles assigned to any group of 
which they are members. Refer to Assigning Access Permissions on page 445 for 
additional information on assigning access permission and roles to users and groups. 
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Verifying the VirtualCenter Server has Started
The VirtualCenter server starts automatically when you start the Windows machine on 
which it is installed. It also restarts each time the VirtualCenter host is rebooted. When 
the VirtualCenter client appears, the baseline bar of the VirtualCenter client window 
indicates the VirtualCenter server you are currently logged on to.

To verify the VirtualCenter server is running, check your Windows Services:

1. Select Start > Settings > Control Panel > Administrative Tools > Services > 
VMware VirtualCenter Server. 

The Status column indicates whether or not the service is started.

2. For additional information, display the Properties dialog box.

Right-click the VMware VirtualCenter Server, select Properties. In the VMware 
VirtualCenter Services Properties dialog box select the General tab and view the 
service status. 

Restarting the VirtualCenter Server
To restart the VirtualCenter server through your Windows Services:

1. Select Start > Settings > Control Panel > Administrative Tools > Services > 
VMware VirtualCenter Server. 

2. Right-click the VMware VirtualCenter Server, select Restart.

3. Close the Properties box, click the close symbol, X, at the top of the dialog box.

When Windows completes the powering on process, close the Properties dialog 
box.
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Restarting the VirtualCenter Agent
The VirtualCenter agent is installed on each host automatically. It is also started 
automatically. If for some reason it stops, it must be restarted. 

To restart the VirtualCenter agent:

1. From the VirtualCenter client, display the inventory panel to display the virtual 
machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the host properties dialog box. 

a. Select the host whose VirtualCenter agent you wish to restart.

b. Select menu Edit > Properties. Or right-click on the selected host, select 
Properties. Or from the select host Summary page, click Edit Properties.

3. Select the Advanced tab. Click Restart.

4. If this option is not available because the host has lost contact with 
VirtualCenter, then use the Windows Administrative Tools to manually restart the 
agent.

To restart the VirtualCenter agent on a GSX Server host through your 
Windows Services:

a. Go to the GSX Server host.

b. Select Start > Settings > Control Panel > Administrative Tools > Services > 
VMware VirtualCenter agent. 

c. Right-click the VMware VirtualCenter agent, select Start.
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d. Close the Properties box, click the close symbol, X, at the top of the dialog 
box.

When Windows completes the powering on process, close the Properties dialog 
box.

Stopping the VirtualCenter Server
The VirtualCenter server is a Windows service, so you should go through your 
Windows interface to select the service and stop it.

Note: You should never have to stop the VirtualCenter server. It is best for the 
VirtualCenter server to have continuous operation. Continuous operation ensures that 
all monitoring and task activities are performed as expected.

To stop the VirtualCenter server:

1. Select Start > Control Panel > Administrative Tools > Services > VMware 
VirtualCenter Service.

2. Right-click the VMware VirtualCenter Server, select Stop. 

3. Close the Properties box, click the close symbol, X, at the top of the dialog box.

When Windows completes powering off of the process, close the Properties 
dialog box.
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Starting and Stopping the VirtualCenter 

Client
This section describes starting and stopping the VirtualCenter client, and logging on 
to a VirtualCenter server.

Starting the VirtualCenter Client and Logging On
VirtualCenter server supports multiple VirtualCenter client logons. The VirtualCenter 
client may be installed on any machine that has network access to the VirtualCenter 
server. 

To start a VirtualCenter client session:

1. Log on to your Windows system.

The first time you start the VirtualCenter client, log on as the administrator.

By default, administrators are allowed to log on to VirtualCenter. Administrators 
here are defined to be either:

• Members of the local Administrators group, if the VirtualCenter server is not a 
domain controller.

• Members of the domain Administrators group, if the VirtualCenter Server is a 
domain controller.

If the host is not a domain controller, log on as either <local host name>\<user> 
or <user>, where <user> is a member of the local Administrators group. 

If the host is a domain controller, you must log on as <domain>\<user>, where 
<domain> is the domain name for which the host is a controller and <user> is a 
member of that domain's Administrator group.

2. Launch the VirtualCenter client.

Double-click a shortcut or select the application through Start > Programs > 
VMware > Vmware VirtualCenter.

3. When you start the VirtualCenter client, log on to the VirtualCenter server.
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Enter or select the VirtualCenter server name, your username and your password 
for that VirtualCenter server. Click Connect to continue. 

The default localhost location is the local Windows server or machine where you 
started the VirtualCenter client. Using the LocalHost in the logon screen, the 
VirtualCenter client assumes the VirtualCenter server is located on the same host 
as the VirtualCenter client. Alternatively, click the Server list arrow and select 
from the list of available VirtualCenter servers. Or type the name of the 
VirtualCenter server on your network. An IP address or a name are acceptable.

Note: Only previously typed VirtualCenter servers appear in the Server pull-
down list. 

The default for the username field is the user currently logged on. To change the 
username when you log on, highlight the name and type over it, as you do in 
any other Windows logon dialog box.

If you do not log on to a VirtualCenter server, the VirtualCenter client displays its 
interface. However, you cannot access any hosts or virtual machines without 
logging on to a VirtualCenter server.

4. Locate and apply the VirtualCenter licenses, if needed. 
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If your VirtualCenter server does not have its licenses installed yet, the licensing 
screen appears. 

To make licenses available to the VirtualCenter server:

a. Click the Add License button and browse to locate the license file. 

b. Click Open on the browse screen. 

c. Click OK on the browse screen. 

d. Click Close on the Licensing screen. 

Refer to Adding Licenses on page 116 for additional information.

The VirtualCenter client screen appears. The screen settings match those of your 
last session. 

Note: If this is the first time you have logged onto the VirtualCenter server, an empty 
Inventory screen appears. Proceed to adding a farm to begin monitoring and 
managing your virtual machines through VirtualCenter. Refer to Working with Farms 
on page 153 for additional information.
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Stopping the VirtualCenter Client and Logging Off
Closing a VirtualCenter client does not stop the VirtualCenter server. 

To stop a VirtualCenter client session:

1. Click the close box (X) in the upper right corner of the VirtualCenter client 
window or select File > Exit.

The VirtualCenter client shuts down. The VirtualCenter client is logged out from 
the VirtualCenter server. The VirtualCenter server continues to run all its normal 
activities in the background. Any scheduled tasks are saved and performed by 
the VirtualCenter server.
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Adding Licenses
Licenses are required for various activities within your VirtualCenter environment. 
These activities include:

Starting the VirtualCenter server — One license is required for each instance of the 
VirtualCenter server.

Adding a host connection — One license is required for each CPU on each host. If a 
host is removed from the VirtualCenter environment, the corresponding license is 
released, and is available for another host.

Migrating (VMotion) a virtual machine — One license is required for each CPU in 
the migration host. Performing migration with VMotion requires two hosts: the target 
and the source machine. Both host must have VMotion licenses.

The VirtualCenter client licensing provides:

• A license inventory window that reports on license usage.

• An uploading license keys window.

Note: The migration process has additional requirements. Refer to Enabling VMotion 
on page 208 for information.

To add your licenses to VirtualCenter:

1. Create your license file in a location accessible by VirtualCenter client. 

You received the license keys in a confirming email when you purchased 
VirtualCenter. 

Place all your VirtualCenter licenses into a plain text file. You have the option to 
place all your VirtualCenter licenses into one text file or keep the licenses in 
separate files. If you use separate files, you need to follow this procedure for each 
license file. 

Ensure that the license key string starts in column 1 of the license text file. That is 
flush left. Do not have any leading spaces at the beginning of the license file. In 
addition, be sure to keep the integrity of the licenses you are given, that is, keep 
the hyphenation format as it is provided. For example xxxxx-xxxxx-xxxxx-xxxx.

Optionally, include your serial numbers as keywords in your license file. 
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2. From the VirtualCenter client, open the License window.

Select Help > Edit Licensing Information.

3. Select the license key file.

Click Add Licences then browse to locate the license key file. Click Open on the 
browse window.

VirtualCenter adds the licenses to the VirtualCenter database. 

Note: Adding non-evaluation licenses removes all previously installed 
evaluation licenses.

4. Close the Licensing window. Click Done.

You are now ready to add hosts and perform migrations.
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Navigating in the VirtualCenter Client
This section describes common Windows practices that affect the VirtualCenter client. 
For detailed information on the windows and options in the VirtualCenter client, refer 
to Working with the VirtualCenter Client on page 125.

Briefly, the VirtualCenter client is divided into two areas. 

• A heading area with a main menu, navigation bar, and toolbar. 

• A data area which displays different information depending upon the option 
selected in the navigation bar.

The navigation bar options divide VirtualCenter’s primary tasks into:

Inventory — Divided into two subpanels, the inventory panel and the information 
panel. This navigation bar option displays all the objects contained within 
VirtualCenter. Through selecting objects in either of the two subpanels, you perform 
and specify actions.

Tasks — Displays an information panel that lists all the tasks scheduled to occur.

Template — Displays an information panel that lists all the templates available for 
deploying. This list includes templates that are stored in the template upload 
directory, stored on a local disk, or stored on the same datastore as their source virtual 
machine.

Events — Displays an information panel that lists all the events that have occurred in 
the VirtualCenter.

The navigation topics are covered in the following sections:

• Selecting Objects

• Monitoring Objects

• Performing Actions on Objects
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Selecting Objects
VirtualCenter objects are farms, groups, hosts, and virtual machines. Selecting an 
object does the following:

• Allows you to view the status of the object.

• Enables the menus so you can select actions to take upon the object.

To select an object: 

1. Select the appropriate navigation bar option. The options are Inventory, Tasks, 
Templates, and Events.

2. Browse through the hierarchy in the inventory panel until you see the icon for 
the object, then click it. 

When you select an object is selected, the object label in the inventory panel backfills 
and the information panel updates its display to reflect the data for the selected 
object. 

To view an object menu: Select the appropriate object and select the appropriate 
action from the Menu bar. Alternatively, right click on the object. A popup menu with 
the object’s available actions appears.

For each type of object, such as farm, host, or virtual machine, in the inventory panel, a 
corresponding default tab appears in the information panel. For example, if you select 
a host in the inventory panel, the information panel displays Summary, Virtual 
Machines, Performance, Events, and Alarms tabs. If you select a farm, the information 
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panel displays Summary, Virtual Machines, Hosts, Performance, Events, Alarms, and 
Permissions tabs.

Multiple selection has limited support in the Inventory panel. 

The inventory panel and information panel share a single selection list. Selecting an 
object in one panel deselects any other object in the other panel.

Menu actions, from either the menu bar or a popup menu, apply to the currently 
selected object. If no object is selected, the menu action is not available. A popup 
menu can appear only for a selected object. Refer to Popup Menus on page 128 for 
additional information on the popup menu options. 

To change the name of an object: Press F2 on a selected item, or click on the text of 
a selected item and type the new name.
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Monitoring Objects
Monitoring a host or a virtual machine requires that it has been added to the 
VirtualCenter environment. Refer to Adding a Host to a Farm on page 163 for 
information on adding objects to your VirtualCenter server.

To check the status of an object:

1. Start the VirtualCenter client. 

Refer to Starting or Stopping VMware VirtualCenter on page 108.

2. Select the Inventory option in the navigation bar. The options are Inventory, 
Tasks, Templates, and Events. 

• If you select the Tasks, Templates, or Events options, the information panel 
displays the scheduled tasks, available templates, and all events that have 
occurred on the VirtualCenter server.

• If you select the Inventory option, drill through the inventory panel lists to 
view individual objects such as hosts, farms, and virtual machines.

3. Click on the object to view it.

When you select an object, the object label in the inventory panel appears in 
blue and the information panel updates its display to reflect the object’s data. 

4. Click the appropriate tab in information panel.

The data corresponding to the object and tab selected appears. Click through 
the tabs to view the information about the object, as needed.
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Performing Actions on Objects
This section describes only the basic process for performing tasks in the VirtualCenter 
client. This section does not describe specific settings and conditions. Refer to the 
chapter specific to the task you wish to perform for additional information. 

To view an object, you must have a role of Read Only User or greater assigned to that 
object. To take action on an object, you must have Virtual Machine User, Virtual 
Machine Administrator, or VirtualCenter Administrator role assigned to you for that 
object. Refer to Setting Access and Permissions on page 435 for additional 
information on permissions with VirtualCenter objects. 

There are three methods for taking actions upon objects in VirtualCenter:

• Selecting the action from the menu bar at the top of the VirtualCenter window.

Refer to Menu Bar on page 127 for information on the menu bar options.

• Scheduling the action through the Scheduled Tasks panel.

Refer to Creating a Scheduled Task on page 367 to information on scheduling 
tasks.

• Selecting the action from the object popup menu or button.

The following procedure describes how to select the action from the object 
menu or button.

To perform an action on a VirtualCenter object:

1. Start the VirtualCenter client

2. Connect to the appropriate VirtualCenter server.

3. Select the object you want to view or upon which you want to perform an 
action. 

Browse through the hierarchy in the inventory panel until you see the icon for 
the object, then click on it. An object can be selected in the inventory panel or 
the information panel.

If the object is not in the view:

• Verify you are logged onto the correct VirtualCenter server.

• Add the host to VirtualCenter control. Refer to Working with Hosts on 
page 159 for information.

4. Select the appropriate menu option:

Once an object is selected:

• Select a menu option from the main menu.
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• Right-click on the object and select from the popup menu.

5. Follow the VirtualCenter prompts.

Depending upon the action you selected, either the view in the information 
panel changes or a wizard prompts for information to complete the transaction. 
The wizard includes the option to schedule the action for a later time. 
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Working with the VirtualCenter 
Client
The VirtualCenter client provides mechanisms for interacting with the VirtualCenter 
server. Conceptually, the VirtualCenter client display combines the simplicity of 
Windows Explorer (navigating groups and lists of objects) with the more sophisticated 
capabilities of Windows Task Manager and the Microsoft Management Console 
(selecting and charting performance information).

This chapter describes the specific layout of the VirtualCenter client. Refer to Working 
with the VirtualCenter Data on page 399 for descriptions on viewing and interpreting 
the data displayed in the VirtualCenter client. This chapter contains the following 
sections:

• Introducing the VirtualCenter Client Window on page 126

• Understanding the Information Elements on page 135

• Accessing Properties and Settings on page 141

You need only a Read Only User role assigned to the farm, host, or virtual machine to 
perform the activities described in this chapter. 
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Introducing the VirtualCenter Client 

Window
The default VirtualCenter client layout is a single window with a menu bar, a 
navigation bar, a toolbar, a status bar, a panel section, and popup menus.

VirtualCenter Client Layout

The VirtualCenter client areas are covered in the following sections:

• Menu Bar

• Popup Menus

• Console Menu

• Navigation Bar

• Toolbar

• Status Bar

• Panel Sections

farm

inventory panel

host

virtual machine status bar

information panel tabstool barmenu bar navigation bar

popup menu

group

information panel
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Menu Bar
The menu bar provides access to all commands and operates in a manner consistent 
with other Windows applications. The table below lists all the options available from 
these five menus. The menu bar options are:

File Menu — Similar to the File menu in most applications with two exceptions.

A Print option is not available on the File menu. To print use either the Print Screen 
mechanism in Windows to take a copy of the VirtualCenter window, or export the 
VirtualCenter data to another format and print from another application. 

A Save option is not available. The VirtualCenter client is similar to a browser. Most user 
manipulations are persistent in the display of the VirtualCenter data.

Edit Menu — Displays options relevant to the selected object.

VM (Virtual Machine) Menu — Enabled only when a virtual machine is selected in 
the inventory panel. 

View Menu — Controls which panels are visible. 

Help Menu — Displays the online help options and the licensing option.

File Menu Edit Menu VM Menu View 
Menu

Help Menu

New > Farm Group Remove Shut Down Guest Inventory Help Topics

New > Farm Rename Suspend after running script Scheduled 
Tasks

User Manual

New > Virtual Machine Group Delete From Disk Resume and run script Templates Guest Operating System Install 
Guide

New > Add Host Virtual Machine 
Resources

Power On and run script Events VMware on the Web > VMware, 
Inc. Home Page

New > Virtual Machine Host Configuration Restart Guest Toolbar VMware on the Web > Online 
Support

New > Deploy Virtual Machine 
from Template

Properties Power On Status Bar VMware on the Web > Register 
Now

New > Alarm Power Off Check for Updates on the Web

New > Template Suspend Edit Licensing Information

New > Scheduled Task Resume About VMware VirtualCenter

New > Add Permission Reset

Host Connect Send

Host Disconnect Install VMware Tools
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Popup Menus
Popup menus provide direct access to many of the menu bar options. Popup menus 
are available from most objects in both the inventory panel and the information 
panel.

To view a popup menu: Right-click the selected object or press Shift+F10 keys.

Console Menu
The console of a powered-on virtual machine is available through VirtualCenter. 

To view the virtual machine console: Select the Inventory Navigation button, 
select a powered on virtual machine in the inventory panel, then click the Console tab 
in the information panel. 

To pop out the virtual machine console: Click the pop out icon in the navigation 
bar. A copy of the Console window separates from the VirtualCenter client. Additional 
menus appears. 

Custom Attributes Migrate

VMware VirtualCenter Settings Clone

Export Events Open Console

Exit Answer Question

File Menu Edit Menu VM Menu View 
Menu

Help Menu

Console pop out icon
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Additional menu options are available from the pop out Console window. 

The popout virtual machine Console has the following menu items. The embedded 
Console has similar, but not all of the external Console menu items.

Navigation Bar 
The navigation bar provides shortcut buttons that load the matching toolbar and 
panel into the VirtualCenter client window. Similar to the Outlook shortcut bar, the 
navigation bar combines and displays associated tasks and information. When a 
button has been selected, it remains depressed to indicate the current view. The 
buttons represent the VirtualCenter functional areas:

File Edit VM

Exit Properties Power On

Preferences Power Off

Suspend

Resume

Reset

Send

Install VMware Tools

Additional Console menu
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Inventory — Displays tasks and data related to viewing the status of and managing 
virtual machines, hosts, farms, and groups.

Tasks — Provides tasks and data related to scheduling tasks.

Templates — Provides tasks and data related to using templates.

Events — Provides tasks and data related to viewing current events.

To change the look of the navigation bar: Right-click in the navigation bar and 
select the appropriate option.

Navigation Bar and Associated Menu

Toolbar
The toolbar provides buttons for the most commonly used actions.

To view/hide a toolbar: Select View > Toolbars. 

VirtualCenter Client Toolbar Icons and Associated Actions for the Inventory Option

The toolbar options that appear differ depending upon the navigation bar option 
selected. The toolbar options for each navigation bar option are listed in the table 
below, with the matching main menu option for each navigation bar option.

Navigation Bar File Edit VMs

Inventory Add > VM

Add > Farm

Add > Host

Add > Task

Add > Template

Add > Alarm

Add Permission

Power Off

Suspend

Power On

Restart

Migrate

Clone

Console

back/forward
 power state migrate add permission

pop out consoletask list clone
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The following table describes the toolbar actions.

Scheduled Tasks New Scheduled Task Properties

Templates New Template

Deploy Template

Clone Template

Events Export Events

Button Actions

Back/Forward Arrows Back — moves the current inventory selection up or left in the hierarchy. 

Forward — moves the current inventory selection right or down in the 
hierarchy.

Stop/Suspend/Start/
Reset Buttons 

Stop — Powers down the selected active virtual machine.

Suspend — Suspends the selected active virtual machine.

Start — Powers up the selected non-active virtual machine.

Reset — Reboots the selected active virtual machine.

Task List Menu Button Create a New Virtual Machine — Launches a wizard to configure a new 
virtual machine.

New Farm — Creates a new empty farm, used for arranging hosts or groups.

Add Virtual Machine Groups — Creates a new empty group for arranging 
hosts.

Add Host — Launches a wizard to attaches an existing host to this 
VirtualCenter inventory.

Create a Scheduled Task — Launches a wizard to perform an automated 
activity at a particular time.

Import a Template — Imports a virtual machine to use as a template for 
creating multiple identical new VMs.

Create an Alarm — Creates an email warning to be sent when an object 
meets specified criteria.

Migration Button This buttons launches the migration wizard. Migration is the act of moving a 
virtual machine from one host to another. There are two types of migration.

Migrate a Virtual Machine — Moving a powered off virtual machine 
between hosts on a farm.

Migrate a Virtual Machine with VMotion — Moving a powered on virtual 
machine between hosts on a farm. This functionality requires activation of 
VMotion on both the source and target host.

Clone Button This buttons launches the clone wizard. A clone is a copy plus customization 
of a virtual machine. 

Navigation Bar File Edit VMs
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Status Bar
The status bar appears at the bottom of the window. It displays the status of the 
connection between the VirtualCenter client and the VirtualCenter server.

To hide or view the Status bar: Select View > Status bar.

Panel Sections
The panel section is the primary information and action display area. 

The content of this display area varies, depending upon the navigation bar selected. 
The content of the panel section for Tasks, Templates, and Events is a simple list. The 
content of the panel section for Inventory [of virtual machines, hosts, farms, and 
groups] is divided into two panels: the inventory panel and the information panel.

• Inventory panel — Displays a hierarchical list of VirtualCenter objects when the 
Inventory option is selected from the navigation bar. The displayed list includes 
Server Farms, farm groups, farms, hosts, virtual machine groups, and virtual 
machines. 

• Information panels — Display lists and charts. There are various information 
panels. There is one panel each for the Tasks, Templates, and Events navigation 
bar options. There are multiple panels for the Inventory option, these are divided 
into tabbed elements that vary, depending upon the object selected in the 
inventory panel. 

Add Permission 
Button

This buttons opens a dialog in which you can add or change access 
permissions.

Pop Out Console 
Button 

This button opens a window displaying the console for the selected virtual 
machine. This console is also available in the VirtualCenter window from the 
Console tab. 

The console window allows you to access a running virtual machine directly. 
It provides live access to the virtual machine console from within the 
VirtualCenter client, and allows you to interact with the operations of the 
virtual machine. 

The VirtualCenter Client consoles are similar to the remote console provided 
with the VMware platform products, such as ESX Server and GSX Server. 
However, the VirtualCenter Client console does not allow you to access 
selected functions (such as power or configuration operations) of the virtual 
machine beyond the direct manipulation of the console. These tasks are 
handled through the VirtualCenter Client.

Button Actions
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The table below lists the tabbed panel options available for each inventory panel 
object.

• Active tasks — Displays any currently running active tasks. Included is a 
progress bar indicating the percentage complete of each task. The active tasks 
panel displays across all four navigation button layouts, Inventory, Scheduled 
Tasks, Templates and Events.

To select an object: Single-click the appropriate object in either the Inventory option 
or on the information panel.

Inventory Object Farms Summary Virtual Machines Hosts Perfor-mance Events Alarms Console Permis-sions

Server Farms X X X X

Farm Group X X X X

Farm X X X X X X X

Host X X X X X

VM Group X X X X X

Virtual Machine X X X X X X
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To view a popup menu: Right-click the appropriate object.

VirtualCenter Client Panel Adjustments

To close or open a panel: Click the arrow in the panel menu bar. When the panel is 
hidden, the panel menu bar is a strip along the side of the VirtualCenter client 
window.

While the inventory panel is hidden, you cannot change the selected object. 

To resize a panel: Click on a resizing panel side, and drag it to an appropriate size.

Your choices for the panels are persistent across VirtualCenter client sessions. If you 
run multiple VirtualCenter client sessions using different usernames, the settings from 
the last session to quit determine the values for the next VirtualCenter client session.

panel menu

resizing bar

open/close toggle guest operating system line

logon information
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Understanding the Information 

Elements
The information elements include the symbols, attributes, lists, and charts. The 
information elements are covered in the following sections:

• Symbol Information Elements

• Attribute Elements

• List Elements

• Chart Elements

Symbol Information Elements
Monitoring data appears in the form of tables and charts, and uses color, icons, and 
timelines for easy viewing and analysis.

Inventory Panel Handling of Color Coding and Filtering Lists

Color coding — Depending upon the location of the colored icon, the color 
indicates status or power state. The color options are red, yellow, and green. Color 
conditions are propagated up the hierarchy.

color codingascending sort filter selection menupropagated state
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Icons — Used in conjunction with color mapping to add a visual representation of 
the associated text. Icons for virtual machine power states are the same as those used 
with other VMware virtualization platform products, such as ESX Server or GSX Server.

Attribute Elements
Attributes are the resources that are being monitored and managed for all the hosts 
and virtual machines in your VirtualCenter environment. Attributes status and states 
appear on the various inventory panels. 

Custom attributes — These attributes can be used to associate user-specific meta-
information with virtual machines and hosts. Once you have created the attributes, set 
the value for the attribute on each virtual machine and/or host as appropriate. This 
value is stored with VirtualCenter and not with the virtual machine or host. Then use 
the new attribute to filter information about your virtual machines and hosts. If you no 
longer need the custom attribute, remove it. A custom attribute is always a string.

To add a custom attribute:

1. Select the Inventory option of the navigation toolbar.

2. Open the Custom Attributes dialog box.

Select File > Custom Attributes.

3. Add a custom attribute, click Add.

The attribute is added to the list of virtual machine characteristics. 

4. Change the attribute name as needed. 

Click in the Name field and type the name you want to assign to the attribute.
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5. Enter the values for the custom attribute.

a. Select the object one level up the hierarchy that contains the objects to which 
you wish to apply the attribute. For example, if you want to enter attribute 
values for hosts, select the farm and the Hosts tab for a list of hosts.

b. For each host or virtual machine, click in the new attribute’s column.

In the information panel, the new attribute is added to the header.

c. Type the attribute value that is appropriate for each host or virtual machine.

List Elements
Sort any list by clicking in the column label heading. A triangle in the column head 
shows the sort order as ascending or descending. 

The Virtual Machines tab for virtual machines provides a means to filter for selected 
virtual machines. A filter is sorted by a key word. Select which columns to search for 
the keyword.

To sort a list: Click on a column heading to sort the list by entries in that column. The 
current selection does not change. 

To change ascending or descending: Click the triangle in the column heading.

To select items in a list: Click on an individual item. Press Shift-click or Ctrl-click to 
select multiple items. All lists can be sorted. 

To view or remove columns in a list: Right-click the column header and select the 
column name from the list.

enter value for the new attributeselected object  New Attribute column
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To filter the view of virtual machines: Click the arrow to view a list of attributes from 
which to select. Type text directly into the filtering field to specify search criteria. The 
Filter field does not support boolean expressions or special characters. Click Ok to 
display only those virtual machine that match the criteria. Click Clear to change the 
filter.

To remove a filter: Click Clear, or delete the entry in of the filtering field and click OK. 
VirtualCenter displays the full list of available items.

To select columns to search for the filtering keyword: Right-click in the contains: 
field and select or deselect the appropriate column names. Filtering is inclusive, not 
exclusive. If the keyword is found in any of the selected columns, the line item is 
included in the list. 

Chart Elements
Each chart contains data relative to the selected object in the inventory panel. The 
charts display the data across time. 

Each resource has a summary graph and one graph per instance of that resource. For 
example, the CPU Usage resource has one graph per CPU and net usage has one 
graph per NIC. View only one set of resource graphs at a time. 

Note: The graphs for a virtual machine show the shares allocated to that virtual 
machine as a percentage of the host CPU.
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To view the large version of a chart: Click on the thumbnail and the larger version 
appears in the information panel.

Information Panel Chart View Elements

To configure the increments of time: Click on the pull-down menu and select the 
appropriate increment. The options are: 

Past Hour —Displays the status of the item in one minute intervals

Day — Displays the status of the item in five minute intervals

Week — Displays the status of the item in one hour intervals

Month — Displays the status of the item in one day intervals

Year — Displays the status of the item in one month intervals

ranges menu

selected resource detail graph

 thumbnail graphs for each attribute

customize graph view

legend toggle
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To customize the graph view: Click the Customize Chart button and select from the 
options. 

The graph options vary, depending upon the resource selected. In the example above 
the options divide into the representation of the data in the primary chart.
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Accessing Properties and Settings
There are five sets of properties and settings dialog boxes. Each set makes 
adjustments to the corresponding VirtualCenter environment. These are described in 
the following sections:

• VMware VirtualCenter Settings

• VMware Management Interface

• Host Properties

• Virtual Machine Resources

• Virtual Machine Properties

• Schedule Task Properties

• Template Properties

• Alarm Properties
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VMware VirtualCenter Settings
To access the VMware VirtualCenter settings, select File > VMware VirtualCenter 
Settings. 

Note: Changes to this setting apply to the current VirtualCenter server only. If you 
log out and log on to another VirtualCenter server, the settings are specific to that 
VirtualCenter server only.

This dialog box has three tabs:

• Performance — Lists the interval settings used to collect performance data that 
appears on the Performance tab in the information panel.
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• Templates — Displays the field for specifying the template upload directory. 
This directory stores templates that are not stored on a shared datastore.
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• Advanced — Lists a variety of fields. 

The Advanced tab fields are:

• instance.id — Generates unique MAC addresses and UUIDs for virtual 
machines. 

In some cases, it is possible to have more than one VirtualCenter running in the 
same company. Each of these VirtualCenters must have its own unique 
instance.id. By default, an ID value is generated randomly. However, this 
value is editable. The only requirement is that it be a unique number from 0 to 
63.

• snmp.receiver.n.name/snmp.receiver.n.port/snmp.receiver.n.community 
— Used for alarm notification. Refer to Preparing for SNMP Alarm Notification on 
page 385 for information on setting these values.

• mail.sender/mail.smtp.sender/mail.smtp.port — Used for alarm notification. 
Refer to Preparing for Email Message SMTP Alarm Notification on page 384 for 
information on setting these values.

• host.reconnectThreshold — Specifies how long, in minutes, VirtualCenter 
should continue to try to connect automatically to a host. The default value is 30 
minutes.

• client.timeout.normal — Specifies how long, in seconds, the VirtualCenter 
client waits for a response from the VirtualCenter server before timing out. The 
default is 30 seconds.
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• client.timeout.long — Specifies how long, in seconds, the VirtualCenter client 
waits for a response from the VirtualCenter server for long operations. The 
default is 120 seconds.

• perf.numThreads — Specifies the number of threads used for collecting 
performance statistics from managed hosts. 

• task.interval — Specifies how often, in seconds, VirtualCenter checks if any 
scheduled tasks are ready to be executed or alarms should be triggered. The 
default is 5 seconds.

• server.options — Used for advanced debugging and troubleshooting. Use this 
field only when directed by VMware technical support.

To view a tool tip on each field: Drag your mouse over a data field.
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VMware Management Interface
Selecting a host > Host Configuration activates a link in VirtualCenter, starts a 
browser, and requests permission to access the VMware Management Interface for 
the selected host. Configuration and management of ESX Server or GSX Server hosts 
is done through the VMware Management Interface. 
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Host Properties
Selecting a host > Properties displays the <host_machine> Properties dialog box. 
The host Properties dialog box has two tabs:

VMotion — This option is available for ESX Server hosts. Use this dialog to configure 
VMotion settings for the selected host. Refer to Enabling VMotion on page 208 for 
information on setting up a host for VMotion.

Datastore — This option is available for GSX Server.Use this dialog to configure 
datastore settings for the selected host. Refer to Configuring Datastores on GSX Server 
Hosts on page 253 for information on setting up a host datastore.
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Advanced — Provides an option to restart the host’s VirtualCenter agent.

Virtual Machine Resources
Selecting a host > Virtual Machine Resources displays the Virtual Machine Resource 
dialog box. This is a list of all the virtual machines running on the selected host and 
the percentage of resources allocated to the virtual machine. Refer to Allocating Host 
Resources on page 177 for information on allocating host resources to virtual 
machines.
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Virtual Machine Properties
Selecting a virtual machine > Properties displays the Virtual Machine Properties 
dialog box. This dialog box has three tabs:

• Hardware — Use this tab to add hardware elements to your virtual machine.

• Options — This tab lists some general virtual machine settings, actions to take 
during a power state change, and actions taken for debugging during a process

• Resources — Use this tab to modify the resource shares on the host of a virtual 
machine. The modifiable resources are CPU, memory, disk, and network.

Refer to Editing an Existing Virtual Machine Configuration on page 317 for more 
information about editing the configuration of a virtual machine. 
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Schedule Task Properties
Selecting Tasks Navigation > task > Edit > Properties displays the Scheduled Task 
Properties dialog box. From this box modify the time, date, and frequency of a 
scheduled activity.

Template Properties
Selecting Templates Navigation > template > Edit > Properties displays the 
Template Properties dialog box. From this box change the name and description of 
the template.
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Alarm Properties
Selecting File > New > Alarm displays the Alarm Properties dialog box for creating 
and modifying alarms.
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Working with Farms
This chapter describes how to perform VirtualCenter farm-related tasks. This chapter 
contains the following sections:

• Working with VirtualCenter Farms on page 154

• Working with Farm Groups on page 156

You need to use a Virtual Machine Administrator role assigned to the Server Farm to 
perform the activities described in this chapter.
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Working with VirtualCenter Farms
A farm is the primary organizational structure used in VirtualCenter. A farm contains 
hosts and virtual machines. All actions taken upon hosts are virtual machines are 
applied within their farm. Within a farm, you can monitor and manage virtual 
machines separately from their hosts and use VMotion; you cannot perform migration 
between farms. The VirtualCenter farm topics are covered in the following sections:

• Adding a Farm

• Removing a Farm

Adding a Farm
To add a farm:

1. From the VirtualCenter client, display the inventory panel and select the 
appropriate farm group or Server Farms.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed,.

2. Add a new farm.

Select the Server Farms icon in the inventory panel. From the main or right-click 
popup menu, select New Farm.
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A new farm is added to the hierarchy. Type in a useful name.

Removing a Farm
To remove a farm:

1. From the VirtualCenter client, display the inventory panel and select the 
appropriate farm.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate farm.

2. Remove the farm.

Select the appropriate farm. From the main or right-click popup menu select 
Remove.

3. Confirm that you want to remove the farm. Click Yes.

VirtualCenter removes all virtual machine groups, hosts, and virtual machines, 
within the farm from the managed inventory. In addition all the associated tasks, 
alarms, and events are also removed. Assigned CPU and migration licenses are 
returned to available status. Virtual machines that were on the host remain on 
the host. 
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Working with Farm Groups
A farm group is an organizational feature. Farm groups can be added only to the 
Server Farms top level and to other farm groups. Hierarchically, farm groups contain 
farms or other farm groups. Use farm groups to organize farms into logical entities. For 
example, group all the systems that support a functional group, such as Sales or 
Finance; or that support a location, such as the Building 12 site or the San Francisco 
site. The farm group topics are covered in the following sections:

• Adding a Farm Group

• Moving a Farm to a Farm Group

• Removing a Farm Group

Adding a Farm Group
To add a farm group:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Select the appropriate icon 
either Server Farms or another farm group. 

2. Select New Farm Group.

With the object highlighted select New Farm Group from the main menu or 
right-click popup menu. VirtualCenter adds a New Group to the Inventory 
hierarchy.
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Moving a Farm to a Farm Group
To move a farm to a farm group:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Select the appropriate icon 
either Server Farms or another farm group. 

2. Click and drag the farm to the farm group.

Removing a Farm Group
Removing a farm group removes all its contents from the VirtualCenter environment. 
The contents include any other farms, hosts, and virtual machines.

To remove a farm group:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. 

2. Remove the farm group.

Select the appropriate farm group and select Remove from the main or right-
click popup menu.

3. Confirm that you want to remove the farm group. Click Yes.
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VirtualCenter removes the selected farm group and all items contained within it 
from the hierarchy and the VirtualCenter environment. Any assigned CPU and 
migration licenses return to available status. All virtual machines remain on the 
host.
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Working with Hosts
This chapter describes how to perform host-related tasks. This chapter contains the 
following sections:

• Hosts Overview on page 160

• Understanding Host States on page 161

• Preparing to Add a GSX Server Host on page 162

• Adding a Host to a Farm on page 163

• Configuring Network Labels for GSX Server Hosts on page 168

• Connecting or Disconnecting a Host on page 171

• Using Host Power Options on page 173

• Moving Hosts Between Farms on page 174

• Automatically Reconnecting a Host on page 174

• Removing a Host on page 175

• Allocating Host Resources on page 177

• Configuring a Host on page 180
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You need to use a Virtual Machine Administrator role assigned to the farm containing 
the host to perform the tasks described in this chapter. 

Hosts Overview
ESX Server and GSX Server hosts can be registered with VirtualCenter. All hosts are 
added to VirtualCenter farms. 

All virtual machines on hosts are automatically discovered and imported into 
VirtualCenter.

A virtual machine is removed from VirtualCenter server only when either the virtual 
machine, the host with the virtual machine, or the farm with the virtual machine is 
explicitly removed through the VirtualCenter client.

When you add multiple hosts, VirtualCenter identifies any naming conflicts that exist 
between virtual machines and alerts the system administrator, who can then rename 
virtual machines as necessary. Configure the virtual machine display names. The name 
can be up to 80 characters long, and can contain alphanumeric characters and the 
underscore (_) and hyphen (-) characters. The name must also be unique across all 
virtual machines within a virtual machine group. 

When VirtualCenter connects to a host, it does so as a privileged user. The individual 
VirtualCenter user does not necessarily need to be an administrative user on the host. 
Refer to Setting Access and Permissions on page 435 for information on setting up 
VirtualCenter users.

A host can be managed by only one instance of the VirtualCenter server. 
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Understanding Host States
Actions taken upon a host require that the host be in specific power states. Whenever 
a power operation is performed on a host, the host power state changes. While the 
state is in transition, the state field displays a term that describes the transition.

Note: Disconnecting a host is different than removing the host from VirtualCenter. 
Disconnecting a host does not remove it from VirtualCenter, it only temporarily 
suspends all VirtualCenter monitoring activities. The host and its associated virtual 
machines remain in the VirtualCenter inventory. Removing a host removes the host 
and all its associated virtual machines from the VirtualCenter inventory.

The figure below illustrates states, transitions and state changing commands for a 
host.

Host Power State Changes
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Preparing to Add a GSX Server Host
To accommodate the GSX Server security option for Interactive and RunAs virtual 
machines running Windows operating systems, a VirtualCenter user must be 
configured on the GSX Server. 

Note: This section does not apply to virtual machines running a Linux operating 
system.

1. Create or select the VirtualCenter user on the to-be-managed GSX Server host. 
This user:

• performs operations on behalf of VirtualCenter on the GSX Server host. 

• may be configured on a Domain controller.

• may be the same user used by VirtualCenter across multiple hosts. 

• must have access to all the files for all the virtual machines on the GSX Server 
host.

• must have access to GSX Server network shares so VirtualCenter can create 
and store virtual machines on the network share. 

2. Convert all existing virtual machines on the GSX Server to use a RunAs user: 
VirtualCenter user. 

If there are any existing virtual machines on the GSX Server, ensure that they are 
configured as RunAs user virtual machines with the VirtualCenter user as the 
designated RunAs user. This ensures that the user authorization to perform a 
function with a GSX Server virtual machine is set within the confines of 
VirtualCenter and that the user of the virtual machine has appropriate 
VirtualCenter access to storage, disk shares, and the GSX Server datastore.

All virtual machines created on a GSX Server host through VirtualCenter are 
automatically assigned RunAs user mode.

Refer to your GSX Server documentation for information on changing the RunAs 
and/or Interactive users on your virtual machines.

3. Provide VirtualCenter user identification when you add the GSX Server as a 
managed host in VirtualCenter. Refer to Adding a Host to a Farm on page 163.

Note: Though the VirtualCenter user can view all virtual machines on the GSX 
Server host, VirtualCenter cannot take actions upon any run as virtual machines 
for which it is not the run as user.
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Adding a Host to a Farm
Virtual machines exist on hosts within the network. Hosts are added to the 
VirtualCenter environment. The VirtualCenter server automatically discovers and adds 
all the virtual machines contained within that host to the VirtualCenter environment. 

The figure below illustrates the process for adding a host to VirtualCenter. Refer to 
Abbreviations on page 16 for a description of abbreviations.

Adding Host to VirtualCenter Environment with Automatic Discovery of Virtual Machines

A host can be added to only one VirtualCenter server. 

To add a host:

1. Ensure a communciation channel through a firewall, if needed.

If any host in the VirtualCenter environment is on the other side of a firewall, all 
hosts must open port 902 to enable incomming and outgoing traffic. Refer to 
Connecting to VirtualCenter Through a Firewall on page 92 for additional 
information.

2. From the VirtualCenter client, display the inventory panel and select the 
appropriate farm.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate farm.

�
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3. Start the Add Host wizard.

Select the appropriate farm, and select New Host from the main or right-click 
popup menu.

4. Confirm proceeding with the Add Host Wizard. Click Next.

5. Enter the host connection settings.
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Type the name of the host in the Hostname field. Enter the username and 
password for a user account that has administrative privileges on the selected 
host. Click Next to continue.

Refer to your ESX Server or GSX Server documentation for information on 
changing the port number if needed. 

VirtualCenter does the following:

• Connects to the host. 

• Verifies that the host is not already being managed. If it is already being 
managed on another farm, VirtualCenter displays an information message.

• Reads the number of CPUs on the host and allocates the appropriate number 
of licenses. The number of CPUs is stored in the VirtualCenter database and is 
verified upon each host reconnect and VirtualCenter start-up. 

• Verifies that the host version is supported. If it is not, VirtualCenter checks if 
the current version can be upgraded. If the host version can be upgraded, 
VirtualCenter prompts you to perform an upgrade.

• Imports existing virtual machines.

6. If you are adding an ESX Server: enable VMotion for the host, as needed. 

To enable VMotion:

Click Yes. Enter the network adapter, IP address, and gateway for the host. 
This is the information for the migration network, including which NIC it uses, 
and its IP address and gateway. The migration network should be a separate 
network. 
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If VMotion is enabled, VirtualCenter checks for a migration license and adds it 
to the host information.

To leave VMotion disabled: Click No. 

Click Next to continue.

Refer to Enabling VMotion on page 208 for additional information.

7. If you are adding a GSX Server: identify the VirtualCenter user.

When adding a GSX Server host to a farm through the Add Host wizard, 
VirtualCenter requires two user names in the following order: 

• The user specified in step 5 to add the host. This is the user who has 
administrator privileges on the GSX Server host.

• The VirtualCenter user.

VirtualCenter impersonates the VirtualCenter user on the managed host when 
accessing files and performing management and provisioning operations on 
a host. This user may be the same or different than the administrator user 
specified in step 5. This user must have sufficient privileges to access the 
physical resources that the virtual machines use, such as files and networks. 

Note: At any given point in time, there is only one username/password that 
VirtualCenter stores for a given host. That is the account for the VirtualCenter 
user. At step 5, you specify the administrator user that proves that you have the 
permission to work in VirtualCenter and on the host. If at this step, you choose 
different (maybe non-administrator) user, you are essentially saying, “Now that I 
have proven that I am for real, connect to that host and run all the virtual 
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machines as this other user.” If you choose to not specify a different user account 
here, you are essentially saying, “I want to connect to this host and perform 
VirtualCenter operations as this administrator”. 

8. Complete the Add Host wizard, click Finish.

The Add Host wizard searches the network for the specified host, performs the 
discovery to identify all the virtual machines on the host, and if possible, 
connects the host. If the wizard cannot connect the host, the host is not added 
to the inventory. If the wizard can connect to the host but for some reason 
cannot remain connected to the VirtualCenter server, the host is added, but is in 
an disconnected state. This occurs for example if the host is already being 
managed by another VirtualCenter server.

If you click Cancel, the host is removed from the VirtualCenter inventory.

If you are adding a GSX Server host: all virtual machines on that host are listed. 
This includes virtual machines that are designated as private within GSX Server. 
Though VirtualCenter can manage private virtual machines, only users with an 
appropriate VirtualCenter designated permission role can perform actions on a 
private virtual machine.
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Configuring Network Labels for GSX 

Server Hosts
Prior to using the migration feature or adding new virtual machines on a GSX Server 
host, network labels must be assigned to each network interface in each GSX Server 
host. Prior to configuring network labels, the GSX Server must be added to the 
VirtualCenter server.

VirtualCenter allows the management of GSX Server hosts, which is a powerful new 
feature. But VirtualCenter is centered around the concept of virtual machine 
migration, while the normal GSX Server console is centered around a single host. This 
different emphasis causes the two products to have very different views of virtual 
network connections. In VirtualCenter, the most important thing about a virtual 
network interface is what network it connects to, because that limits what possible 
hosts the virtual machine containing it could migrate to. 

The normal GSX Server methods for specifying network interfaces (Bridged, NAT, 
Host-Only, or Custom) do not apply in the VirtualCenter environment. For example: 

• A VirtualCenter-managed farm might include three physical networks: 

• One which connects through a firewall to the Internet 

• One which is internal to the server room 

• One which is dedicated for connection to networked storage. 

• On a GSX Server host, these networks might be set up as 

• the bridged network, 

• a custom network on vnet4, 

• a network not even visible to the virtual machines directly 

• On a second GSX Server host, the network might be set up as 

• only one network card, connected to the server-room network only. On this 
host the network would be a bridged network. 

Note: that in this example, knowing that a network is bridged is of no value at all in 
determining what network it is. 

VirtualCenter must be able to identify the actual network that the interface connects 
to. This has to be manually set by someone who knows the physical connections and 
GSX Server custom settings. 
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Specifically, VirtualCenter provides a method by for assigning a label or name to each 
network connection on each host. This network name becomes a global identifier for 
the actual network. In the example above, the administrator might choose to call the 
first network the main or corporate or intranet network, the second network the 
server link network, and the third network the storage network. 

These labels are used by VirtualCenter when a virtual machine is migrated. The virtual 
NICs are matched up to the networks on the new host by the network names. 

So in order to provision network cards to virtual machines on GSX Server hosts using 
VirtualCenter, you must name the network interfaces on each GSX Server host. To do 
this, use the management interface. This naming need only be done once per 
network per host.

To specify network labels for all the virtual NICs in your GSX Server virtual 
machines: 

This need only be done once. Refer to your GSX Server documentation for additional 
information. 

1. Register the GSX Server as a host with VirtualCenter.

2. Log into the management interface as root and/or Administrator. 

3. Click the Options tab. 

4. Click the Network connections link. 

A window displays a list of network adapters and network labels. On Linux 
systems all possible VMnets are displayed. On Windows systems only the 
adapters and labels that are enabled are displayed. 

5. Assign or change the labels as desired and click OK, or click Cancel to not accept 
the change. 

To configure a virtual machine to use a named network: 

1. From the management interface, select the Hardware tab. 

2. Select either Add a New, or Edit an Existing network adapter. 

3. Select Network Connection then click the Named radio button. 

4. Select the appropriate network from the pull down menu. 

Existing virtual machines on your GSX Server hosts continue to work, naming your 
networks does not modify the existing virtual machines in any way. Their virtual NICs 
continue to be read as bridged, NAT, etc. If you edit the virtual machine configuration 
under VirtualCenter, you have the option of changing them from their current value to 
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a network name value. Only VirtualCenter specific name options are offered. The GSX 
Server-specific values, such as Bridged, NAT, are not valid VirtualCenter options. 

If you migrate the virtual machines to a different GSX Server host without changing 
the NIC settings, the GSX Server-style name are applied to the new host's 
environment. This might result in a sudden change of network topology. 
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Connecting or Disconnecting a Host
You have the option to disconnect and reconnect a host being managed by a 
particular VirtualCenter server. This section describes how to reconnect a registered 
host.

Note: Disconnecting a host is different than removing the host from VirtualCenter. 
Disconnecting a host does not remove it from VirtualCenter, it only temporarily 
suspends all VirtualCenter monitoring activities. The host and its associated virtual 
machines remain in the VirtualCenter inventory. Removing a host removes the host 
and all its associated virtual machines from the VirtualCenter inventory.

To connect or disconnect to a host:

1. From the VirtualCenter client, display the inventory panel and select the 
appropriate host.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate host.

2. If needed, add the appropriate host to the VirtualCenter.

Refer to Adding a Host to a Farm on page 163.

3. Connect or disconnect the appropriate host.

Select the appropriate host icon in the inventory panel, and select Connect or 
Disconnect from the main or right-click popup menu. 
171



VMware VirtualCenter User’s Manual
VirtualCenter displays text indicating the transitional state for the host until it 
verifies and adjusts the licensing as needed and completes the transaction.

When the host is connection status to VirtualCenter is changed, the statuses of 
the virtual machines on that host are updated to reflect the change. If the host is 
disconnected the word is appended to the object name in parenthesis and the 
object is greyed out. If the host is connected, the disconnected designation is 
removed and the object name is in full black print.
www.vmware.com172



C H A P T E R  7  Working with Hosts
Using Host Power Options
You have the option to power down or restart (reboot) any VirtualCenter host. 
Powering down a host disconnects it, though it does not remove it from the 
VirtualCenter inventory. 

Caution: When you power off a VirtualCenter host, you must use the normal ESX 
Server or GSX Server startup processes outside of VirtualCenter. There is no start host 
option through VirtualCenter once the host has been shutdown. Refer to your ESX 
Server or GSX Server documentation for additional information.

Note: Disconnecting a host is different than removing the host from VirtualCenter. 
Disconnecting a host does not remove it from VirtualCenter, it only temporarily 
suspends all VirtualCenter monitoring activities. The host and its associated virtual 
machines remain in the VirtualCenter inventory. Removing a host removes the host 
and all its associated virtual machines from the VirtualCenter inventory.

To power off or reboot a host:

1. Select the host from the Inventory panel and open power operation dialog box.

Either select the menu File > Shut Down Host or select Shut Down Host from 
the host’s Summary tab.

2. Shutdown or restart the host, as appropriate. 

a. Click the Shut down or Restart button, as appropriate. 

b. Add any notes you would like to make describing why you shutdown or 
restarted (rebooted) the host and perhaps information on when the host 
should be restarted. 

c. Click OK.

VirtualCenter enters the provided text into the host system event log, then 
powers off the selected host.

3. VirtualCenter may try to reconnect to the shutdown host. If this occurs, cancel 
the connect command.
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Moving Hosts Between Farms
Hosts and virtual machines can be on only one farm at a time. To move a host from 
one farm to another, you must remove the host from the current farm, then add it to 
the new farm. When you add the host to the new farm, the virtual machines 
associated with the host are also moved to the new farm.

Automatically Reconnecting a Host
VirtualCenter automatically tries to reconnect to a host, if the connection is lost. 

Define how long VirtualCenter tries to re-establish the connection.

To configure automatic host reconnection:

1. From the VirtualCenter client, open the VMware VirtualCenter Settings dialog 
box, and select the Advanced tab.

Select File > VMware VirtualCenter Settings. When the dialog box appears, 
select the Advanced tab.

2. Enter a value in minutes in the host.reconnectThreshold field. Click OK.
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Removing a Host
Removing a host from VirtualCenter breaks the connection, stops all monitoring and 
managing functions of that host and of all the virtual machines on that host. The host 
and its associated virtual machines are removed from the inventory. Historical data 
remains in the VirtualCenter database. 

Note: If at all possible, remove hosts while they are connected. Removing a 
disconnect host does not remove the VirtualCenter agent from the host.

Note: Removing a host is different than disconnecting the host from VirtualCenter. 
Disconnecting a host does not remove it from VirtualCenter, it only temporarily 
suspends all VirtualCenter monitoring activities. The host and its associated virtual 
machines remain in the VirtualCenter inventory.

Removing a host from VirtualCenter does not remove the virtual machines from the 
host or datastore. It removes only VirtualCenter’s access to the host and virtual 
machines on that host.

The figure below illustrates process for removing a host from VirtualCenter. Refer to 
Abbreviations on page 16 for a description of abbreviations. In the example here, 
notice the lost link between the VirtualCenter server and the removed host, while the 
host files remain on the datastore.

Removing a Host
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To remove a host:

1. From the VirtualCenter client, display the inventory panel and select the 
appropriate host.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate host.

2. To remove the VirtualCenter agent from the host, ensure that the host is in a 
connected state. 

The host can be in a connected or disconnected to VirtualCenter state when you 
remove it. However, removing a host while disconnected does not remove the 
VirtualCenter agent from the host.

Note: Disconnecting a host is different than removing the host from 
VirtualCenter. Disconnecting a host does not remove it from VirtualCenter, it 
only temporarily suspends all VirtualCenter monitoring activities. The host and 
its associated virtual machines remain in the VirtualCenter inventory. Removing a 
host removes the host and all its associated virtual machines from the 
VirtualCenter inventory.

3. Select Remove.

Select the appropriate host icon in the inventory panel and select Remove from 
the main or right-click popup menu.

4. Confirm that you wish to remove the host and all its associated virtual machines.

Click Yes to remove the host. Click No to keep the host.

If you click Yes, VirtualCenter removes the host and associated virtual machines 
from the VirtualCenter environment. VirtualCenter then returns all associated 
CPU and migration licenses to available status.

Note: Removing the host does not power off or alter any of the virtual 
machines on the host. It only removes the host from VirtualCenter control.
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Allocating Host Resources
The Virtual Machine Resources dialog box lists all the virtual machines currently 
installed on the host. Use this dialog box to make adjustments to all the host’s virtual 
machines in a single view. Refer to Changing Virtual Machine Resources Settings on 
page 357 to view resource settings for individual virtual machines.

Note: This option is available for ESX Server hosts only.

To adjust the allocation of resources for each virtual machine on the host:

1. From the VirtualCenter client, display the inventory panel and select the 
appropriate host.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate host.

2. Select the host whose resources you wish to reallocate.

3. Select the Virtual Machine Resources option.

This can be found on the Edit main menu, on the host right-click menu, and in 
the host Summary tab commands list.

4. Select the CPU, memory, disk I/O, or network allocation to adjust.

Click the CPU, Memory, Disk I/O, or Network tab.

5. Select the virtual machine value to adjust.

Click the row representing the virtual machine whose allocation you are going 
to adjust. Click in the column of the value and edit.

Once in edit mode, keyboard navigation between editable fields applies. This 
includes arrow keys, Tab and Shift keys. Enter commits the changes.
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Shares and Shares Value columns — Entitle a virtual machine to a relative 
fraction of the host’s physical resource. For example, a virtual machine that has 
twice as many shares as another is generally entitled to consume twice as many 
resource, subject to the virtual machines assigned and respective minimum and 
maximum constraints, provided that the virtual machines are both actively using 
the resource they have been allocated.

Alternatively, to set a numeric value for shares, the value can also be set to low, 
normal, or high. By default, all shares for all VMs are set to normal. What these 
values mean in terms of the number of shares is a function of the virtual 
machine’s specific configuration.

Increasing the number of shares allocated to a virtual machine dilutes the 
effective value of all shares.

A virtual machine may under-utilize its allocation by idling when it is not busy. 
This extra time is not wasted; rather it is shared among virtual machines that 
remain active. Thus, a virtual machine may receive more than its allocation of the 
system.

Refer to your host virtualization platform documentation for additional 
information.

Min% and Max% columns — Set absolute guarantees for minimum and 
maximum CPU and memory.

If a minimum CPU or memory reservation is set on a virtual machine, that virtual 
machine receives at least the specified minimum percentage of a processor or 
MB of memory, regardless of changes in the total number of shares in the 
resource.

If the system does not have enough unreserved CPU time or memory available 
to guarantee the minimum requirement of a virtual machine, that virtual 
machine is not able to power on. A maximum reservation guarantees that a 
virtual machine never receives more than specified maximum percentage of a 
processor, even if extra time is available in the system. The maximum value for 
CPU is configurable. The maximum value for memory is not configurable.

CPU minimums and maximums are percentages of a single CPU. So a 
uniprocessor virtual machine range from 0 to 100%, and a 2P virtual machine 
from 0 to 200%.

Memory minimum and maximum is in MB, and the maximum is always the 
memory size of the virtual machine. 
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Traffic shaping and Kbps values — Found on the Network tab, it puts a cap on 
the average and peak network bandwidth a virtual machine can use, as well as 
how much traffic can be sent or received in a single burst. 

6. Specify the new value for the allocation.

a. If needed, click in the column heading to view a sorted list of values.

b. Select the row where you want to make a change. 

c. Click the value or empty field you wish to change. In some cases, a pull-down 
menu appears.

d. Select from the listed options or type a value in the field.

7. Close the Virtual Machine Resources screen. Click Close.
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Configuring a Host
Host settings are controlled through the VMware Management Interface. 

To configure a host through the VMware Management Interface:

1. From the VirtualCenter client, display the inventory panel and select the 
appropriate host.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate host.

2. If the host is not connected, connect it now.

Refer to Connecting or Disconnecting a Host on page 171.

3. Connect to the management interface for the selected host.

a. Select the appropriate host icon in the inventory panel.

b. Start the VMware Management Interface select:

Edit > Properties or Summary > Commands > Edit Host Configuration

VirtualCenter automatically starts your default browser.

4. Accept the security alerts.

These are generated from your Windows environment and appears only if your 
security settings require it.

5. Log on to the VMware Management Interface.

Enter the host username and password.

6. Make adjustments to the host settings as needed. Refer to your host 
virtualization platform documentation for information specific to modifying the 
host configuration and using the management interface.
www.vmware.com180



C H A P T E R 8

Connecting with Virtual Machines
This chapter describes virtual machine and virtual machine group tasks, including 
adding and removing a virtual machine to and from VirtualCenter, and powering on 
and off virtual machines. Refer to the appropriate chapter for information on 
deploying from a template, creating a clone from an existing virtual machine, creating, 
deleting, migrating, customizing, and editing the configuration of a virtual machine.

This chapter contains the following sections:

• Adding and Removing Virtual Machines on page 182

• Changing Virtual Machine Power States on page 185

• Answering a Pending Question on page 191

• Working with Virtual Machine Groups on page 193

You need to use a Virtual Machine Administrator role assigned to the virtual machine 
to perform the activities described in this chapter.
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Adding and Removing Virtual Machines
Add virtual machines to VirtualCenter through their hosts. Remove virtual machines 
from VirtualCenter control, and optionally from their host’s disk. 

The adding and removing virtual machine topics are covered in the following 
sections:

• Adding Existing Virtual Machines to VirtualCenter

• Removing Virtual Machines from VirtualCenter

• Returning a Virtual Machine to VirtualCenter

• Removing Virtual Machines from the Disk

Adding Existing Virtual Machines to VirtualCenter
When you add a host to VirtualCenter, VirtualCenter automatically discovers all the 
virtual machines on that host and adds them to the VirtualCenter inventory. If a host is 
disconnected, the already discovered virtual machines, continue to be listed as part of 
VirtualCenter.

If a host is disconnected then reconnected any changes to the virtual machines on 
that host are identified and VirtualCenter updates the list of virtual machines. For 
example, if virtualmachine3 is removed, and virtualmachine4 is added. 
The new list of virtual machines shows virtualmachine4 and shows 
virtualmachine3 as orphaned.

Refer to Adding a Host to a Farm on page 163 for information on adding a host and its 
associated virtual machines. 

Removing Virtual Machines from VirtualCenter
If a virtual machine is removed from VirtualCenter control, the link between the host 
and the virtual machine is severed. The host and VirtualCenter no longer recognize 
the virtual machine. However, the virtual machine remains on the datastore 
connected to the host. 

To remove a virtual machine:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Ensure that the virtual machine is powered down.

3. Remove the virtual machine from VirtualCenter, but not from the datastore.
www.vmware.com182



C H A P T E R  8  Connecting with Virtual Machines
Select the virtual machine in the inventory panel. From the main or right-click 
popup menu, select Remove.

4. Confirm that you want to remove the virtual machine from VirtualCenter. Click 
OK.

VirtualCenter removes references to the virtual machine and no longer tracks its 
condition. 

Note: Using the Remove option removes the virtual machine only from 
VirtualCenter. It does not remove the virtual machine from its datastore. Refer to 
Removing Virtual Machines from the Disk on page 183 for information about the 
Remove From Disk option.

Returning a Virtual Machine to VirtualCenter
If you have removed a virtual machine from a VirtualCenter, but did not remove it 
from the host’s datastore, and you wish to return it to VirtualCenter, refer to your host 
virtualization platform documentation and follow the procedures for adding an 
existing virtual machine to an ESX Server or GSX Server.

Removing Virtual Machines from the Disk
Through VirtualCenter, remove individual virtual machines from the datastore. 

To remove a virtual machine from VirtualCenter and the datastore:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Ensure that the virtual machine is powered down.

3. Select Remove From Disk from the virtual machine main or right-click popup 
menu.

Note: This removes all the files for the selected virtual machine, including the 
configuration file and the virtual disk files.
183



VMware VirtualCenter User’s Manual
4. Confirm removing the virtual machine from VirtualCenter and the datastore. 
Click OK.

VirtualCenter removes the virtual machine from its datastore entirely.
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Changing Virtual Machine Power States
There are several options for a virtual machine power state. Each virtual machine 
power state change has a different effect on the guest operating system in the virtual 
machine. 

There are also several access points for making changes to these power states. 
Manually select a power state change by selecting the virtual machine then the 
power option from either the main menu or the right-click popup menu. Alternatively, 
Schedule a power state change through the Tasks option in the navigation bar.

The power state topics are covered in the following sections:

• Understanding Virtual Machine Power States

• Understanding Transitional Power States

• Manually Powering a Virtual Machine On and Off

• Scheduling a Power State Change for a Virtual Machine

Understanding Virtual Machine Power States
The basic power state options include:

• Power on — Powers up the virtual machine and boots the guest operating 
system if the guest operating system is installed. 

• Power off — Powers down the virtual machine. The virtual machine does not 
attempt to gracefully shut down the guest operating system.

• Suspend — Pauses the virtual machine activity. All transactions are frozen until 
you issue a Resume command.

• Resume — Allows virtual machine activity to continue, and releases the 
Suspended state.

• Reset —Powers down the virtual machine and restarts it. 

The following power options perform extra functions in addition to the basic virtual 
machine power operations. These operations require that VMware Tools are installed 
in the virtual machine.

• Shut down guest — Shuts down the guest operating system. If the guest 
operating system automatically powers off its host, then the virtual machine also 
powers off. 

• Suspend after running script — Executes a virtual machine script, then places 
the virtual machine into Suspended mode. Refer to VMware Tools for 
information on setting up scripts.
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• Resume and run script — Releases the virtual machine from Suspended mode, 
and executes a virtual machine script. Refer to VMware Tools for information on 
setting up scripts.

• Power on and run script — Starts the virtual machine and executes a virtual 
machine script. Refer to VMware Tools for information on setting up scripts.

• Restart guest — Shuts down and restarts the guest operating system. Does not 
power off the virtual machine.

Toolbar power state buttons perform as follows:

• Power off — Performs a standard power off when VMware tools are not 
installed or unavailable, and a Guest OS power off when VMware tools are 
installed and available. A power off operation first displays a confirmation dialog 
box indicating that the guest operating system does not be shut down properly.

• Suspend — Performs a standard power on when a virtual machine is stopped, 
and resumes with scripts when the virtual machine is suspended and Vmware 
tools are installed and available. Performs a standard resume when VMware tools 
are not installed or unavailable.

• Power on — Performs a standard suspend when tools are not installed, and 
suspends with scripts when tools are installed and available. 

• Reset — Performs a standard reset when tools are not installed, and restarts the 
guest operating system when tools are installed and available. A reset operation 
first displays a confirmation dialog box indicating that the guest operating 
system is not shut down properly.

Note: The specific form of the power state action can be modified to include guest 
operating system shut downs or not, and to include running scripts or not. Refer to 
Changing Power State Options on page 354 for additional information.

Understanding Transitional Power States
Actions taken upon a virtual machine require that the virtual machine be in specific 
power states. Whenever a power operation is performed on a virtual machine, the 
virtual machine power state changes and all other commands are locked out until the 
first command is completed.
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The figure below illustrates states, transitions, and state changing commands for 
virtual machines. Refer to Abbreviations on page 16 for a description of abbreviations.

Virtual Machine Power State Changes

Manually Powering a Virtual Machine On and Off
Prior to performing any power state changing activity on a virtual machine, you must 
have added the virtual machine to your VirtualCenter environment. Refer to Adding 
and Removing Virtual Machines on page 182.

To manually change the power state of a virtual machine:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Choose the power option.

Through either the main or right-click popup menu, display the available 
options. Or select the power options from the toolbar. If an option is not 
currently available, it is grey and unselectable. 

The following options include the basic virtual machine power operations:
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• Power on

• Power off

• Suspend

• Resume

• Reset

Two options affect the guest operating system only:

• Shut down guest

• Restart guest

Note: The specific form of the power state action can be modified to include 
guest operating system shut downs or not, and to include running scripts or not. 
Refer to Changing Power State Options on page 354 for additional information.

After the power option is selected, VirtualCenter displays messages in the 
Summary tab indicating the transition modes. 

Scheduling a Power State Change for a Virtual Machine
To make a scheduled task to change the power state of a virtual machine:

1. Display the Tasks panel.

Click the Tasks option in the navigation bar. The list of scheduled tasks appears.

2. Start the New Task wizard. Click New in the toolbar.

3. Confirm continuing with the New Task wizard. Click Next.
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4. Select the task to create.

Click the pull-down menu and select the Change the power status of a virtual 
machine option. Click Next.

5. Select the power state to which to change the virtual machine.

Click the appropriate radio button. Click Next.

Note: The specific form of the power state action can be modified to include 
guest operating system shut downs or not, and to include running scripts or not. 
Refer to Changing Power State Options on page 354 for additional information.
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6. Select the virtual machine whose power state changes.

Select the virtual machine, then click Next.

7. Specify the timing of the task.

To see the calendar, click on the Later button and then the Date down arrow. 
When you have set the date and time, click Next.

8. Confirm creating the task. 

Optionally, specify an email address for notification when task is performed. Click 
Finish.

VirtualCenter adds the new task to the scheduled task list and completes it at the 
designated time. When it is time to perform the task, VirtualCenter first verifies 
that the user who created the task still has permission to complete the task. If the 
permission levels are not acceptable, a message is generated and the task is not 
performed.
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Answering a Pending Question
When VirtualCenter is performing a task that requires input from you, the Inventory 
Summary tab for the selected virtual machine displays Question Pending as the 
status. 

To answer a pending question for a virtual machine:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed.

2. Identify a question pending.

Check the virtual machine in the inventory panel. If the virtual machine is 
flashing, proceed.

3. Select the virtual machine, Summary tab. 

The State: status displays a Question pending link.
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4. Open the Answer Question dialog.

Double-click the Question Pending link. Or alternatively, with the virtual 
machine highlighted, select VM > Answer Question.

5. Answer the question dialog that appears. For example:
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Working with Virtual Machine Groups
Virtual machine groups are organizational structures. They can be added only to the 
virtual machine’s farm. Hierarchically, virtual machine groups contain virtual machines 
or additional virtual machine groups.

The figure below illustrates the VirtualCenter organizational components. Refer to 
Abbreviations on page 16 for a description of abbreviations.

Hierarchical Virtual Machine Groups

The virtual machine group topics are covered in the following sections:

• Adding a Virtual Machine Group

• Adding Virtual Machines to a Virtual Machine Group

• Moving Virtual Machines from a Virtual Machine Group

• Removing a Virtual Machine Group
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Adding a Virtual Machine Group
To add a virtual machine group:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Select the appropriate farm. 

2. Add a new virtual machine group.

With the farm highlighted, from the main or right-click popup menu, select New 
VM Group. VirtualCenter adds a New Group to the inventory panel.

Adding Virtual Machines to a Virtual Machine Group
When you create a virtual machine group, it is empty. Drag and drop the virtual 
machines as needed to the new virtual machine group.

To add virtual machines to the virtual machine group:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. 

2. If needed, add the virtual machine group to the farm that contains the virtual 
machines you wish to group.

3. Move the virtual machine to the virtual machine group.

Select the appropriate virtual machine and drag it to the virtual machine group. 
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Moving Virtual Machines from a Virtual Machine Group
Moving a virtual machine from a virtual machine group does not remove the virtual 
machine from the host, the farm, or VirtualCenter. It just moves it from the 
organizational structure of the virtual machine group.

To move a virtual machine from the virtual machine group:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. 

2. Move the virtual machines.

Select the appropriate virtual machines and drag them out to the farm or 
another virtual machine group. 

Moving virtual machines between virtual machine groups on the same farm 
does not move them between hosts. 

Removing a Virtual Machine Group
Removing a virtual machine group removes all its hierarchical contents from the 
VirtualCenter environment. These contents includes any virtual machines contained 
within the group. This process removes control of the virtual machines from 
VirtualCenter and the host. 

To remove a virtual machine group:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. 

2. Power down all virtual machines in the virtual machine group to be removed. 

3. If needed, remove any virtual machines from the virtual machine group.

Select the virtual machine and drag it to the farm icon or another group.

Note: Removing a virtual machine group removes the virtual machines, 
contained within the virtual machine group, from VirtualCenter.

4. Remove the virtual machine group.

Select the appropriate virtual machine group, and from either the main or right-
click popup menu, select Remove.

5. Select whether to remove the virtual machines in the virtual machine group.
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If there are no virtual machines in the virtual machine group, VirtualCenter 
removes the virtual machine group without a confirmation message. 

a. Click the Remove VM Files check box.

If this box is selected the virtual machines are removed from the datastore.

If this box is not selected the virtual machines remain on the datastore.

b. Confirm that you want to remove the virtual machine group. Click Yes.

VirtualCenter removes the selected virtual machine group and all items 
contained within it from the hierarchy and the VirtualCenter environment. Any 
assigned CPU and migration licenses return to available status.
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Migrating Virtual Machines
This chapter describes how to move a virtual machine from one host to another. 
Moving a virtual machine from one host to another is called migrating. Migrating a 
powered off virtual machine is a migration. Migrating a powered up virtual machine is 
a migration with VMotion. Migration with VMotion requires VMotion licensing and 
specific configuration. Refer to Installing VMware VirtualCenter on page 63 for 
VMotion requirements. You cannot migrate a virtual machine when a virtual machine 
is in a suspended state.

This chapter contains the following sections:

• Understanding the Migration Options on page 199

• Migrating Powered Off Virtual Machines on page 203

• Enabling VMotion on page 208

• Moving Powered On Virtual Machines on page 210

You need a Virtual Machine Administrator role assigned to both the hosts in the 
migration to perform the activities described in this chapter.

Note: Copying a virtual machine is creating a new virtual machine. It is not a form of 
migration. Refer to Copying Virtual Machines on page 269 for additional information.
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Note: You cannot migrate a virtual machines with raw, clustered, undoable, or 
append mode disks. You cannot migrate with VMotion, virtual machines with raw, 
clustered, and non-persistent mode. If you have clustered disks, you can store them 
on separate VMFS volumes from the virtual machines prior to migrating them using 
VMotion. Also you cannot migrated GSX Server virtual machines with IDE disks to an 
ESX Server host.

Note: Migration occurs between hosts on the same farm. Only migrations between 
GSX Server version 3.1 and ESX Server version 2.1.1 are supported. Migrations of virtual 
machines with IDE disks from GSX Server hosts to ESX Server hosts are not supported.
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Understanding the Migration Options
This chapter describes how to perform the two types of migration:

• Migration — Moving a powered off virtual machine. 

• Migration with VMotion — Moving a virtual machine between hosts while the 
virtual machine is powered on and performing transactions. This functionality 
has specific requirements, including the activation of VMotion on both the 
source and target host. When a migration with VMotion is performed, the 
operations of the virtual machine can continue without interruption. 

Note: Migration with VMotion is possible only between ESX Server hosts.

Virtual machines can be moved between hosts within the same farm. Virtual 
machines cannot be moved between farms. 

The migration general topics are covered in the following sections:

• Understanding Migration with VMotion

• Understanding Migration

Understanding Migration with VMotion
VMotion allows working processes to continue throughout a migration with VMotion. 
During a migration with VMotion you move only the virtual machine configuration file 
from host to host. The associated virtual disk remains in the same location on the SAN 
storage that is shared between the two hosts. Once the configuration file is migrated 
to the alternate host, the virtual machine is then managed by that new host. 

When you move the configuration file, you also move the entire state of the virtual 
machine to the new host, even while the data storage remains in the same location 
on the SAN. 

The state information includes the current memory content and all the information 
that defines and identifies the virtual machine. The memory content includes 
transaction data and whatever bits of the operating system and applications are in the 
memory. The defining and identification information stored in the state includes all 
the data that maps to the virtual machine hardware elements, such as BIOS, devices, 
CPU, MAC addresses for the Ethernet cards, chip set states, registers, and so forth.

Migration with VMotion happens in four stages:

1. When the migration with VMotion is requested, VirtualCenter verifies that the 
existing virtual machine is in a stable state with its current host. 
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2. The migration begins when VirtualCenter makes a baseline copy of the current 
memory content and stores it on the target host. 

3. When the baseline copy is complete, VirtualCenter copies the last changes in the 
current memory content and copies the virtual machine state information to the 
target host. 

4. The virtual machine resumes its activities on the new host.
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The figure below illustrates the process of migration of powered on virtual machines 
with VMotion. Refer to Abbreviations on page 16 for a description of abbreviations.

Migration with VMotion

Understanding Migration
Migration requires that the virtual machine being migrated is powered off prior to 
beginning the migration process. Migration is the process of moving a virtual 
machine from one host to another. With a migration, you also have the option of 
moving the associated disks from one host to another. A migration consists of the 
following steps:

1. A copy of the configuration file and the associated virtual disks are placed on the 
new host and in the associated volume storage area. 
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2. The virtual machine is managed on the target host and unregistered on the 
source host.

3. After the migration is completed, the old version of the virtual machine is 
deleted from the source host.

The figure below illustrates the process for migration of powered off virtual machines. 
Refer to Abbreviations on page 16 for a description of abbreviations.

Migration

If any error occurs during migration, the virtual machines revert to their original states 
and locations. 
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Migrating Powered Off Virtual Machines
Move virtual machines manually or set up a scheduled task to perform the migration.

The migration topics are covered in the following sections:

• Migrating a Powered Off Virtual Machine Manually

• Creating a Scheduled Task to Migrate a Virtual Machine

Migrating a Powered Off Virtual Machine Manually
To manually migrate a powered-off virtual machine:

1. From the VirtualCenter client, view the inventory panel to display the virtual 
machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Ensure the virtual machine is powered off.

• If the virtual machine is on, power it off.

• If the virtual machine is in suspended mode you must first resume it then 
power it off.

• If the virtual machine is in resumed mode, wait until it powers on, then power 
it off.

3. Start the Migration wizard.

In the inventory panel, select the desired virtual machine. Then perform one of 
the following:

• From the main or right-click popup menu, select the Migrate option. 

• From the information panel Summary tab, click the Migrate to New Host 
button. 

• Drag and drop the virtual machine on the target host.

The Migration wizard starts.

4. Confirm the Migration wizard. Click Next.
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5. Select the target host for the virtual machine. Click Next.

6. Select a datastore for the virtual machine. Click Next.

7. Complete the wizard. Click Finish.

VirtualCenter moves the virtual machine, including the virtual disks, to the new 
host. Event messages appears in the Events tab. The Summary tab updates the 
status and state throughout the migration.
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Creating a Scheduled Task to Migrate a Virtual Machine
This process sets up a scheduled task to migrate a powered off virtual machine. 
VMotion is not used for this type of task.

To create a scheduled task that migrates a virtual machine:

1. Display the Tasks panel.

Click the Tasks option in the navigation bar. The list of scheduled tasks appears.

2. Start the New Task wizard. Click New in the toolbar.

3. Confirm continuing with the New Task wizard. Click Next.

4. Select the task to create.

Click the pull-down menu and select the Migrate a Virtual Machine option. 
Click Next.
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5. Select the virtual machine to migrate. Click Next.

6. Select the target host for the virtual machine. Click Next.
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7. Select a datastore for the virtual machine. Click Next.

8. Set the time and date when you want to migrate the virtual machine to be 
migrated. Click Next.

Click Later, then click the drop-down arrow to select a date from the displayed 
calendar. A red circle indicates today’s date and a dark circle indicates the 
scheduled date.

9. Confirm creating the task. 

Optionally, specify an email address to receive notification when the task is 
performed. Click Finish.

VirtualCenter adds the new task to the scheduled task list and completes it at the 
designated time. When it is time to perform the task, VirtualCenter first verifies 
that the user who created the task still has permission to complete the task. If the 
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permission levels are not acceptable, VirtualCenter sends a message to the log 
and the task is not performed. Similarly, if the virtual machine is not in the correct 
state, VirtualCenter sends a message to the log and the task is not performed.

Enabling VMotion
You must enable VMotion on both the target and the source host to support 
migration with VMotion.

Note: This applies to ESX Server hosts only.

To enable a host for VMotion:

1. Ensure that the host is properly configured. 

• Refer to VirtualCenter VMotion Requirements on page 48 for the list of 
VMotion requirements.

• Refer to Adding Licenses on page 116 to ensure that you have sufficient 
VMotion licenses.

2. From the VirtualCenter client, display the inventory panel to view the host.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate host.

3. Display the host properties dialog box. 

From the main menu, right-click popup menu, or Summary tab button, select 
Host Properties.

4. Enable VMotion. Select the VMotion tab.
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To enable VMotion: Click Yes. Enter the network adapter, IP address, and 
gateway for the host, if the fields are not pre-filled. Click OK.

This is the information for the migration network, including which NIC it uses, 
and its IP address and gateway. The migration network is preferably its own 
separate network. 

To leave VMotion disabled: Click No then click OK.

If VMotion is enabled, VirtualCenter checks for a migration license and adds the 
license to the host information.
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Moving Powered On Virtual Machines
Move virtual machines that are powered on manually or set up a scheduled task.

Note: Powered on virtual machines can be moved between ESX Server hosts. This 
type of migration, migration with VMotion cannot be performed with GSX Server 
hosts at this time.

The migration with VMotion topics are covered in the following sections:

• Migrating with VMotion a Virtual Machine Manually

• Creating a Scheduled Task to Migrate a Virtual Machine with VMotion

Note: Disconnect any remote consoles that are external to VirtualCenter and 
connected to the virtual machine you are migrating. Though the virtual machine 
appears to be migrating, until you disconnect the external remote console, the 
migration does not complete. If the virtual machine is connected to the console from 
Console tab in VirtualCenter, the migration with VMotion completes without any 
intervention.

Migrating with VMotion a Virtual Machine Manually
To manually migrate a powered on virtual machine:

1. From the VirtualCenter client, display the inventory panel to view the virtual 
machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.
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2. Ensure that both the source and target hosts are VMotion-enabled, and using 
the same SAN. 

For each host, click the host. Select the Summary tab. Check the VMotion 
Enabled field and the Datastores section. The VMotion Enabled field should say 
Yes. Datastores on both hosts should list the same name. 

Refer to VirtualCenter VMotion Requirements on page 48, Adding Licenses on 
page 116, and Enabling VMotion on page 208 for additional information.

3. Display the inventory panel and select the appropriate farm.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.
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4. Disconnect any peripheral devices connected to the virtual machine.

a. Select the virtual machine, power it down if it is powered on.

b. Select Edit > Properties to display the Virtual Machine Properties dialog box.

c. Unselect the Connect box for each peripheral device. Peripheral devices 
include floppy drives, CD-ROM drives, and serial and parallel devices. 

d. Click OK.

5. Start the migration with VMotion wizard.

In the inventory panel, select the desired virtual machine. Then perform one of 
the following:

• From the main or right-click popup menu, select the Migrate option. 

• From the information panel Summary tab, click the Migrate to New Host 
button. 

• Drag and drop the virtual machine on to the target host.

The migration with VMotion wizard starts.

6. Confirm the migration with VMotion wizard. Click Next.

7. Select the migration priority level. 

Set the priority of the migration so ensure that sufficient CPU resources are 
available on both the source and target hosts to perform the migration. 

Click the appropriate button, then click Next.

8. Confirm the migration with VMotion wizard. Click Finish.
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VirtualCenter moves the selected virtual machine from the original host to the 
target host. The virtual disks remain in the same location on the shared 
datastore.

Creating a Scheduled Task to Migrate a Virtual Machine with 
VMotion
This process sets up a scheduled task to migrate a powered on virtual machine using 
VMotion.

To create a scheduled task that migrates a virtual machine with VMotion:

1. Display the Tasks panel.

Click the Tasks option in the navigation bar. The list of scheduled tasks appears.

2. Start the New Task wizard. Click New in the toolbar.

3. Confirm continuing with the New Task wizard. Click Next.

4. Select the task to create.

Click the pull-down menu and select the Migrate a Virtual Machine option. 
Click Next.
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5. Select the virtual machine to migrate. Click Next.

6. Select the target host for the virtual machine. Click Next.
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7. Select a priority for the migration. 

Set the priority of the migration so ensure that sufficient CPU resources are 
available on both the source and target hosts to perform the migration. Click 
Next.

8. Set the time and date when you want the virtual machine to migrate. Click Next.

Click Later, then click the drop-down arrow to select a date from the displayed 
calendar. A red circle indicates today’s date and a dark circle indicates the 
scheduled date.

9. Confirm creating the task. 

Optionally, specify an email address to receive notification when the task is 
performed. Click Finish.
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VirtualCenter adds the new task to the scheduled task list and completes it at the 
designated time. When it is time to perform the task, VirtualCenter first verifies 
that the user who created the task still has permission to complete the task. If the 
permission levels are not acceptable, VirtualCenter sends a message to the log, 
and the task is not performed. Similarly, if the virtual machine is not in the correct 
state and VMotion is not enabled, VirtualCenter sends a message to the log, and 
the task is not performed.
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Creating New Virtual Machines
This chapter describes how to create virtual machines through the New Virtual 
Machine wizard. This wizard walks you through the steps required to define a virtual 
machine. This chapter includes information on setting parameters based on the guest 
operating system used and the resources allocated. After you create the virtual 
machine, you must install the guest operating system. 

This chapter contains the following sections:

• Changing the Default Virtual Machine Directory on page 219

• Creating Virtual Machines Using the New Virtual Machine Wizard on page 220

• Creating Customized New Virtual Machines Using the New Virtual Machine 
Wizard on page 226

• Installing a Guest Operating System and VMware Tools on page 242

You need to use a Virtual Machine Administrator role assigned to the host to perform 
the activities described in this chapter.

Virtual machines created through VirtualCenter have root ownership. This allows 
VMware processes running on the host with root privileges. These processes can take 
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action (create files, spawn other processes, etc.) “as root” if they decide that it is 
appropriate.

VirtualCenter sends commands to these processes. It uses the vpxuser login and 
password to authenticate the commands, such as, to prove to the host processes that 
the commands are coming from a legitimate VirtualCenter.

The only reason that the root password is needed in the initial connection process is 
to prove that you have the necessary permissions for creating a vpxuser login/
password.
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Changing the Default Virtual Machine 

Directory
VirtualCenter creates the virtual machine using the settings you specified. The virtual 
machine files are placed in the /home directory. In VirtualCenter 1.0.x virtual 
machines were placed in the /vpx directory. Update any scripts you created that 
point to the /vpx directory. 

The /home directory is the default behavior but is configurable on a per-host basis. To 
change the default location, add the following line to the configuration file, /etc/
vmware/config, on each appropriate ESX Server host: 

serverd.vpx.defaultVmDir = "/whatever/your/path/is" 

Mixing these two directories is not a concern. However, if a virtual machine was 
initially in /vpx/vms, and it is migrated off of the host then later returned to the host, 
it is placed in the newly designated directory, not where it was originally discovered. 
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Creating Virtual Machines Using the 

New Virtual Machine Wizard
New virtual machines are added to hosts. You must select a host to be able to start the 
New Virtual Machine wizard.

Note: All virtual machines on a GSX Server host created through VirtualCenter are 
automatically assigned RunAs user mode.

To create a new virtual machine through the New Virtual Machine wizard:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed.

2. Select the host and start the New Virtual Machine wizard.

In the information panel, select the host to which to add the new virtual 
machine. 

From the main or right-click popup menu, select the New Virtual Machine 
option. Click Next.

3. Select whether to use a typical configuration or customize the configuration.

Note: This is not the same as customizing a template.
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If you select Typical: the wizard prompts for:

• The guest operating system

• The virtual machine name and the location of the virtual machine’s files

• The network connection label

• A virtual disk size (capacity) and settings

Click the Typical radio button. Click Next. Proceed to step 4.

If you select Custom: you have the opportunity to modify, rather than accept 
the default values, for the following:

• Disk type (IDE or SCSI)

• SCSI adapter type

• Use an existing vmdk disk instead of creating a new disk

• Set memory size

Click the Custom radio button. Click Next. Proceed to Creating Customized New 
Virtual Machines Using the New Virtual Machine Wizard on page 226.

4. Select a group location for the new virtual machine.
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5. Select the guest operating system to be used.

Click the guest operating system arrow and select the appropriate guest 
operating system. Click Next.

This dialog box asks which operating system to install in the virtual machine. The 
New Virtual Machine Wizard uses this information to select appropriate default 
values, such as the amount of memory needed. 
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6. Specify a name for the virtual machine and datastore volume for the virtual disks.

For GSX Server hosts: the name listed is the local datastore or the datastore 
specified in the VirtualCenter Host Configuration dialog. Each GSX Server host is 
only allowed one datastore.

For ESX Server hosts: the names listed are the configured vmfs volumes for 
that host. 

a. Enter the virtual machine name to use.

The name you enter in the Virtual Machine Name field is the name that is 
listed in the VMware Management Interface. Enter a useful name. The name 
can be up to 80 characters long, and contains alphanumeric characters and 
the underscore (_) and hyphen (-) characters. It should also be unique across 
all virtual machines.

b. Scroll through and select the datastore on the host to use for storing the 
virtual disk files. 

c. Click Next.

For GSX Server hosts only: This name becomes the name of the folder which 
stores the files associated with this virtual machine. Each virtual machine should 
have its own folder. All associated files, such as the configuration file and the disk 
file, are placed in this folder. 
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Be sure that the entry in the Location field is unique. Duplicate names on a host 
can cause confusion, therefore it is recommended. Duplicate names are not 
allowed within a virtual machine group. 

7. Select Network Interface Card (NIC) to define the virtual network name to use. 
Click Next.

8. If you are creating a new virtual disk, select the size of the virtual disk.

a. Enter the disk size. Click Next.
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For GSX Server hosts: The Allocate all disk space now and Split disk into 2 GB 
files options are available. Click the check boxes as needed.

For ESX Server hosts: The available space on the selected VMFS volume is 
listed.

b. Click Next.

Note: A new virtual machine with a blank virtual disk is like a new computer 
with a blank hard disk. You must install a guest operating system before use 
the virtual machine.

Make the Virtual Disk Big Enough

The virtual disk should be large enough to hold the guest operating system 
and all of the software that you intend to install, with room for data and 
growth. 

You cannot change the virtual disk’s maximum capacity later. But, you can 
install additional virtual disks later by using the Virtual Machine Properties 
dialog box.

For example, you need about 500MB of actual free space on the file system 
containing the virtual disk to install Windows XP and applications such as 
Microsoft Office inside the virtual machine. 

c. Click Finish on the Ready to Submit Task panel.

VirtualCenter proceeds to create the virtual machine you specified using the 
default settings. The virtual machine files are placed in the /home directory. 
In VirtualCenter 1.0.n virtual machines were placed in the /vpx directory. 
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Creating Customized New Virtual 

Machines Using the New Virtual Machine 

Wizard
New virtual machines are added to hosts. You must select a host to be able to start the 
New Virtual Machine wizard.

This section describes the steps taken when the Customize option is selected in the 
New Virtual Machine wizard. 

Note: This section is not describing the process of customizing a new virtual 
machine that is being created by cloning an existing virtual machine or deploying a 
template. 

Note: All virtual machines on a GSX Server host created through VirtualCenter are 
automatically assigned RunAs user mode.

To create a customized new virtual machine through the New Virtual Machine 
wizard:

1. From the VirtualCenter client, display the inventory panel.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed.

2. Select the host and start the New Virtual Machine wizard.

In the information panel, select the host to which to add the new virtual 
machine. 

From the main or right-click popup menu, select the New Virtual Machine 
option. Click Next.

3. Select whether to use a typical configuration or customize the configuration.
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Note: This is not the same as customizing a template.

4. Specify the number of virtual processors. Click Next.
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5. Specify the memory allocation.

The dialog box shows the current available memory and typical memory 
allocations. The default setting in the Guest size (for memory) field depends on 
the guest operating system you have selected. You may need to change the 
memory allocation to meet the demands of applications you plan to run in the 
virtual machine. You may change this setting later, from the virtual machine’s 
Memory tab in the management interface. 

Enter the memory allocation for the new virtual machine. Click Next.

For ESX Server hosts: The blue triangle indicates the maximum runnable 
memory. 

For GSX Server hosts: The blue triangle data field is blank and does not apply.
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6. Select Network Interface Card (NIC) to define the network connection type. Click 
Next.

For GSX Server host virtual machines: you must configure network labels on 
the host before a NIC can be configured for the virtual machine. Refer to 
Configuring Network Labels for GSX Server Hosts on page 168 for additional 
information.
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7. Select I/O adapter type. Click Next.

8. Select a storage disk type for the new virtual machine. Click Next.

• For an ESX Server host: you can select the system LUN option. 

• For a GSX Server host: the system LUN option is not available.
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9. Proceed to the next section appropriate to your Disk selection and host type.

• Creating a New Virtual Disk on a GSX Server on page 231

• Creating a New Virtual Disk on an ESX Server on page 234

• Using an Existing Disk on page 236

• Using a System LUN Disk on an ESX Server on page 237

Then complete the process, as described in Completing the New Virtual 
Machine Process on page 241.

Creating a New Virtual Disk on a GSX Server
1. Select an IDE or SCSI type of disk. SCSI disk type is recommended.
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2. Allocated disk space.

3. Specify any Advanced options, as needed.
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4. Specify the virtual disk file name. 

If you are using an existing disk, locate the virtual disk. If you are creating a new 
disk, specify a location and name.

Note: Ensure that the path and file name are valid. Any errors in defining this 
information results in a failure to create the new virtual machine. If possible, use 
the default file location. This ensures that consistent naming is used for the 
configuration file and disk files, and ensures that the disk file name uses the 
datastore as a reference rather than the VMFS path.

5. Proceed with creating the new virtual machine. Click Finish.

VirtualCenter proceeds to create the virtual machine you specified using the 
custom settings. The virtual machine files are placed in the /home directory. In 
VirtualCenter 1.0.n virtual machines were placed in the /vpx directory.

You have completed the process for creating a new virtual machine.
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Creating a New Virtual Disk on an ESX Server
1. Select the size of the virtual disk. Click Next.

Note: A new virtual machine with a blank virtual disk is like a new computer 
with a blank hard disk. You must install a guest operating system before use the 
virtual machine.

Make the Virtual Disk Big Enough

The virtual disk should be large enough to hold the guest operating system and 
all of the software that you intend to install, with room for data and growth. 

You cannot change the virtual disk’s maximum capacity later. But, you can install 
additional virtual disks later by using the Virtual Machine Properties dialog box.

For example, you need about 500MB of actual free space on the file system 
containing the virtual disk to install Windows XP and applications such as 
Microsoft Office inside the virtual machine. 
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2. Specify the virtual disk file name. 

If you are using an existing disk, locate the virtual disk. If you are creating a new 
disk, specify a location and name.

Note: Ensure that the path and file name are valid. Any errors in defining this 
information results in a failure to create the new virtual machine. If possible, use 
the default file location. This ensures that consistent naming is used for the 
configuration file and disk files, and ensures that the disk file name uses the 
datastore as a reference rather than the VMFS path.

3. Proceed to Completing the New Virtual Machine Process on page 241.
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Using an Existing Disk
1. Select the disk to use.

2. Proceed to Completing the New Virtual Machine Process on page 241.
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Using a System LUN Disk on an ESX Server
1. Select an existing (logical unit number) LUN to map the disk to.

The dropdown list displays the available LUNs that are visible to the host. This is 
basically the set of LUNs not already involved in a vmfs.

The datastore list shows all datastores visible to the host, and notes for any that 
already have RDMs on them how many they have. This is because best practice 
is to put all the RDMs on one datastore, which is visible to all hosts. Do not set 
more than one RDM exist for the same LUN anywhere in the system.
237



VMware VirtualCenter User’s Manual
2. If you are reusing a LUN that already has an disk mapping file:

When the user selects a LUN in the list, and it already has an RDM file, the only 
option is to reuse that RDM. the "Map target LUN" checkbox and datastore list 
will be grayed out (the existing RDM file location will be shown in the list if I 
can swing that). The Compatibility radio group will be enabled, as that is a per-
VM setting (like Disk Mode and SCSI node). 
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3. If you are using a new LUN: Select a datastore to map.

If the selected LUN does not already have an RDM file, the "Map target LUN" 
checkbox will be enabled and default to checked, and the other controls will 
hence be enabled; if the user unchecks that box, that will disable the 
datastore and Compatibility controls.
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4. Select whether to map the LUN to a VMFS volume.

Because of the importance of choosing the right datastore and the "best 
practices" mentioned above, we will not always select a datastore by default. If 
there is only one datastore, or if there are multiple datastores but only one has 
existing RDMs, we will select that one, but in other conditions the dialog will 
start with no selected datastore. The "Finish" button will be disabled, and an 
extra message, in bold type to catch the eye, will explain what the user must 
do to enable it (note, the screenshot is flawed in that the message doesn't fit 
in its box):

5. Proceed to Completing the New Virtual Machine Process on page 241.
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Completing the New Virtual Machine Process
1. Specify the virtual disk node type and mode.

Select the SCSI node. 

Note: IDE disk type for the virtual disk is not supported.

Select the device mode. The choices are:

• Persistent — Changes are immediately and permanently written to the disk.

• Undoable — Changes are not saved until the virtual machine is powered off 
and you confirm to save the changes.

• Nonpersistent — Changes to the disk are discarded when you power off or 
revert to the snapshot.

• Append — Changes are saved when you power off the virtual machine.

Choose one device node type and one mode type. Click Next.

2. Proceed with creating the new virtual machine. Click Finish.

VirtualCenter proceeds to create the virtual machine you specified using the 
custom settings. The virtual machine files are placed in the /home directory. In 
VirtualCenter 1.0.n virtual machines were placed in the /vpx directory.

You have completed the process for creating a new virtual machine.
241



VMware VirtualCenter User’s Manual
Installing a Guest Operating System and 

VMware Tools
This section describes the following:

• Installing a Guest Operating System in a Virtual Machine

• Installing VMware Tools

Create your virtual machine disk and install an operating system on this virtual disk 
just as you do on a new physical machine, using a standard installation CD-ROM and 
formatting the virtual disk at the appropriate place in the installation process. 

Alternatively, install an operating system from image files. ISO image files of 
installation CD-ROMs and floppy image files of any floppy disks can be used for the 
installation. Use the VirtualCenter client to connect the virtual machine’s drives to the 
appropriate image files before you begin the installation.

Once you start the virtual machine, the normal operating system installation takes 
over. Answer the prompts that appear on the virtual machine console to install the 
guest operating system.

After your guest operating system is installed, follow the directions below for installing 
VMware Tools and the network driver. 

Installing a Guest Operating System in a Virtual Machine 
To install a guest operating system and other software, use the virtual machine 
console, found on the Console tab for the Inventory option in the navigation bar. 
Choose an installation method:

• Configure the virtual machine to connect to the host CD-ROM and boot an 
operating system installation disk from it.

• Configure the virtual machine CD-ROM as a path to a networked ISO file and 
boot from that. 

CD-ROM drives are automatically created when new virtual machines are created. If 
you are planning to install the guest operating system from an ISO image, use the 
Virtual Machine Properties dialog box to change the CD-ROM option before powering 
on the virtual machine. Refer to Changing Hardware Configuration of a Virtual 
Machine on page 321 for information on using the Virtual Machine Properties dialog 
box.

Floppy devices are automatically created when new virtual machines are created. 
However, the virtual machines start with the floppy device disconnected. Use the 
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Virtual Machine Properties dialog box to change the CD-ROM option before powering 
on the virtual machine, if needed. Refer to Changing Hardware Configuration of a 
Virtual Machine on page 321 for information on using the Virtual Machine Properties 
dialog box.

If you are installing Windows XP Professional, the floppy device needs to be 
connected because the LSI Logic SCSI drivers install from a floppy or floppy image file. 

To install the guest operating system over a CD-ROM drive:

1. Insert the installation CD-ROM for your guest operating system in the host’s CD-
ROM drive. 

2. Click Power On on the remote console toolbar to begin setting up your guest 
operating system. For details on installing specific guest operating systems refer 
to the VirtualCenter release notes and the Guest Operating System Installation 
Manual which can be found at: www.vmware.com/support/guestnotes/doc/
index.html

To install the guest operating system over a network:

1. Prepare ISO image files of installation CD-ROMs and floppy image files of any 
floppy disks needed for the installation. 

2. The installation instructions in this section assume you are installing from 
physical media. If you are using image files, connect the virtual machine’s CD-
ROM or floppy drives to the appropriate image files before you begin installing 
the guest operating system.

Installing a Guest Operating System on a New Virtual Disk
When you are installing a guest operating system on a new virtual disk, you may see a 
message warning you that the disk is corrupted and asking if you want to place a 
partition table on the disk. This message does not mean there is any problem with 
your physical hard disk. It simply means some data needs to be written to the file that 
holds your virtual hard disk. All you need to do is respond Yes. You also need to 
partition and format the virtual disk as you would with a new, blank hard drive. 

Installing a Guest Operating System on a Previously Formatted Raw Disk
If you try to install a guest operating system on a raw or physical disk that was 
formatted previously with a file system, you may see a No operating system 
error when you power on the virtual machine. This message appears because the 
boot order specified in the virtual machine’s BIOS defaults to the floppy disk, hard disk, 
and then CD-ROM drive. Instead of booting from the installation CD-ROM, the virtual 
machine tries to boot from the hard disk.
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Note: The raw disk option is not supported for virtual machines on a GSX Server 1.1 
host. To work around this issue, do one of the following:

• Change the boot order in BIOS so the virtual machine boots from the CD-ROM 
drive before it tries the hard disk. When the virtual machine boots, enter the BIOS 
and change the boot order on the Boot menu.

• Zero out the first 64KB of the raw disk using dd or a similar advanced utility.

Installing VMware Tools
It is very important that you install VMware Tools in the guest operating system. If you 
do not install VMware Tools, the graphics environment within the virtual machine is 
limited to VGA mode graphics. 

With the VMware Tools SVGA driver installed, virtual machines support up to 32-bit 
displays and high display resolution, with significantly faster overall graphics 
performance. 

Other tools in the package support time synchronization between the server and the 
guest, automatic grab and release of the mouse cursor, copying and pasting between 
the guest and the management workstation, and improved networking performance.

Note: Refer to your ESX Server or GSX Server Administration manual for specific 
instructions on installing and configuring VMWare Tools.
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Working with Templates
This chapter describes creating and importing templates. A template is a golden 
image of a virtual machine that can be used as a master copy to create and provision 
new virtual machines. This chapter contains the following sections:

• Understanding Templates on page 246

• Preparing for Templates on page 252

• Creating Templates on page 257

• Cloning a Template on page 263

• Deleting a Template on page 264

• Editing a Template on page 266

• Reimporting a Template on page 267

VirtualCenter catalogs and manages the templates. VirtualCenter displays a list of 
available templates with a name and a brief description. The templates can be stored 
in a template upload directory which is a directory local to the VirtualCenter server or 
on a VMFS volumes in a SAN.
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You need to use a Virtual Machine Administrator role assigned to the hosts where the 
templates is deployed.

Understanding Templates
A template is a golden image created from a virtual machine. The template, as did the 
source virtual machine, typically includes a specified operating system and a 
configuration which provides virtual counterparts to hardware components. A 
template can also include an installed guest operating system and a set of 
applications. 

The figure below illustrates creating a template from a managed virtual machine on 
an ESX Server and a GSX Server. Refer to Abbreviations on page 16 for a description of 
abbreviations.
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VirtualCenter uses virtual machine templates as a quick and consistent method for 
adding new virtual machines to the VirtualCenter environment. This process of 
deploying a template includes selecting the appropriate template and designating a 
VirtualCenter target host to receive the new virtual machine. The deployed virtual 
machine is added to the farm where the host resides. Refer to Creating Virtual 
Machines from a Template on page 270 for additional information on deploying 
templates.

The figure below illustrates creating a new virtual machine from a template 
(deploying a template) using the optional virtual machine customization feature. 
Refer to Abbreviations on page 16 for a description o abbreviations.
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Deploying a Template
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Templates are created from:

• Existing virtual machines. These virtual machines can be either:

• GSX Server and ESX Server virtual machines located on any VirtualCenter 
managed host.

To templatize a virtual machine on an ESX Server or GSX Server host, the host 
must be registered with VirtualCenter. 

• Workstation virtual machines stored on a disk local to the VirtualCenter 
server. 

• Existing templates, by making a copy (cloning) of the template.

Templates are stored at the following locations:

• Template upload directory — On the VirtualCenter server machine. A copy of 
the original virtual machine virtual disks are placed in the directory you specify as 
the template upload directory. 

This method is useful when your source virtual machine is not located on a SAN-
based storage device.

Templates in the template repository can be deployed to any host managed by 
VirtualCenter. 

• Datastore — On the managed host with the source virtual machine. Select a 
datastore, if there are several available. The datastore does not need to be the 
same datastore as the original virtual machine. 

This method is useful for rapidly deploying templates. 

After a template is created, if it is residing on a VMFS volume or a datastore other 
than the VirtualCenter template repository, it can be deployed to only hosts that 
have direct access to that datastore. 

On ESX Server hosts: the datastores are the VMFS volumes you configured for 
your ESX Server. You can configure any number of VMFS volumes per ESX Server 
host. 

On GSX Server hosts: the datastore is a designated directory. Each GSX Server 
host is allowed only one datastore at a time. You can change the designated 
datastore and rename it, but only one at a time is allowed. Refer to Configuring 
Datastores on GSX Server Hosts on page 253 for information on designating a 
GSX Server datastore. 
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Note: If a host that has a templates stored locally (not in the template 
repository) is removed from VirtualCenter, all the templates are also removed. 
Returning the host to VirtualCenter does not re-register the templates.

• Local to the source virtual machine — This option is available for, but not 
limited to, importing Workstation formatted virtual machines and is not 
recommended.

This method is useful when your source virtual machine is located on a SAN-
based storage device. 
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The figure below illustrates the options for creating a template from various virtual 
machine sources. This includes, ESX Server golden images, as well as managed and 
unmanaged virtual machines. Refer to Abbreviations on page 16 for a description of 
abbreviations.
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Preparing for Templates
Prior to creating a template:

• Verify that your system meets the requirements for creating and using 
templates. Refer to VirtualCenter Template Requirements on page 49. 

• Review and complete the steps in the following sections:

• Specifying an Upload Directory for Templates

• Configuring Datastores on GSX Server Hosts

• Using a GSX Server or Workstation Virtual Machine as a Template

• Using an ESX Server Golden Image as a Template

• Using an Unmanaged Virtual Machine as a Template

• Using a Managed Existing Host Virtual Machine as a Template

Specifying an Upload Directory for Templates 
When you import a template, you have the option to keep the source virtual machine 
in its original location or have a copy placed into a host located within VirtualCenter.

When you import a template and select the upload directory option, the new 
template is copied to the upload directory location. The upload directory must be in a 
location relative to the VirtualCenter server and local to the VirtualCenter server. It 
cannot be a network share that is mapped as a local drive.

When you create the template you must have Virtual Machine Administrator or 
greater role permission on the host. When you deploy a template from the upload 
directory, you must have Virtual Machine Administrator or greater role permission on 
the target host.

Note: If you change the upload directory, all subsequently created templates are 
stored in the new template upload directory. Templates stored in the old upload 
directory continue to work.

Note: The template upload directory cannot reside on a network share.

To specify a location for importing templates:

1. From the VirtualCenter client, open the VMware VirtualCenter Settings dialog 
and select the Templates tab.

Select File > VMware VirtualCenter Settings.
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2. Enter the template upload directory location. Click OK.

a. Scroll to the Template Upload Directory field. 

b. Enter the full absolute path of the directory to use as the upload directory.

This path references a directory to which VirtualCenter has access. 

The path is the location of templates upload directory. It must be a directory 
local to VirtualCenter server. It must not be a network share mapped locally. It 
must be a valid directory path and the directory must exist. Set the template 
upload directory before you create any templates.

Configuring Datastores on GSX Server Hosts
When a GSX Server host is added to VirtualCenter, the Add a Host wizard defaults the 
datastore location for all the virtual machines on that host. Only one datastore is 
allowed per GSX Server. All virtual machine files are stored at the root directory where 
GSX Server is installed on its host if the datastore is not specified.

Note: You do not set datastores for an ESX Server host through VirtualCenter. 
Datastores on an ESX Server are the VMFS volumes that are set when you configured 
the ESX Server. Refer to your ESX Server documentation for information on 
configuring VMFS volumes.

To specify a different directory location for the datastores of a particular GSX 
Server: 

1. Select and verify the host is a GSX Server host.
253



VMware VirtualCenter User’s Manual
View the host summary page. The title bar lists the host name, host type (GSX 
Server or ESX Server), and the virtualization platform version.

2. Open the Host Properties box. Select the Datastore tab. 

3. In the field, type the name of the datastore and the path to the datastore. 

• This must be in the appropriate format, Linux or Windows path for a GSX 
Server and as a vmfs-label:disk-name for an ESX Server system. 

To view the format, check the Host Summary page, Datastore field. The path 
specified there is appropriate for the host type, Linux or Windows. 

datastore name

host title bar
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• The VirtualCenter user must have read and write permissions on the directory 
selected. 

Specify the template location as a URL that is on a Network Attached Storage 
(NAS) local network location. 

• This must be a local directory. 

• Each GSX Server host is allowed one datastore.

Using a GSX Server or Workstation Virtual Machine as a 
Template
To use a virtual machine that is already configured as a template:

1. Power down the virtual machine.

2. If you have a Workstation or an older GSX Server virtual machine:

• Upgrade the virtual machine to Workstation 4.0 or GSX Server 2.5 or later, if 
needed.

• The source virtual machine must be local to the VirtualCenter server. 

• If the source virtual machine is not local, you must copy the virtual machine to 
a folder local to the VirtualCenter server. 

Using the method of your choice, copy the contents of the virtual machine 
folder. The contents include, but are not limited to, the following files:

Virtual machine configuration file with a .vmx or .cfg extension.

Virtual disk files with a .vmdk or .dsk extension. There could be several 
virtual disk files. Copy all of them.

Note: Edit the disk location of any disks that were specified with absolute 
paths. When you update the paths to the disk you can use relative or absolute 
paths to specify the new location of the disks.

Note: If the source machine has IDE disks it cannot be used as a template for 
ESX Server or GSX Server hosts.

3. Proceed to Creating Templates on page 257.

Using an ESX Server Golden Image as a Template
To use an existing ESX Server golden image as a VirtualCenter template:

1. Use your standard ESX Server procedures to import the golden image and create 
a virtual machine.

Refer to your ESX Server documentation for additional information.
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2. If the ESX Server host is an unmanaged host, proceed to Using an Unmanaged 
Virtual Machine as a Template on page 256.

If the ESX Server host is a managed host, proceed to Using a Managed Existing 
Host Virtual Machine as a Template on page 256.

Using an Unmanaged Virtual Machine as a Template
To use an existing virtual machine on an unmanaged host as a template:

1. Power down the virtual machine.

2. If you have a virtual machine that resides on a host that is not managed with 
VirtualCenter, perform the following:

• Upgrade to ESX Server 2.0.1 or later. or GSX Server 3.1

Refer to your host virtualization platform documentation for additional 
information.

• Temporarily register the ESX Server or GSX Server host with the virtual 
machine that is the source for the template. 

You may need to adjust to your managed hosts to ensure you have sufficient 
VirtualCenter licenses.

• Create the template, by selecting the Copy files to template upload 
directory option. 

Refer to Creating Templates on page 257 for information on creating the 
template.

• Unregister the ESX Server or GSX Server host.

Note: If a host that has a templates stored locally (not in the template 
repository) is removed from VirtualCenter, all the templates are also removed. 
Returning the host to VirtualCenter does not re-register the templates.

3. Proceed to Creating Templates on page 257.

Using a Managed Existing Host Virtual Machine as a Template
To use a managed ESX Server or GSX Server virtual machine as a template:

1. Power down the virtual machine.

2. Proceed to Creating Templates on page 257.
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Creating Templates
If you plan to store a template in the VirtualCenter upload directory, refer to Specifying 
an Upload Directory for Templates on page 252 and define the upload directory 
location before proceeding.

Note: You cannot create a template from a virtual machine with undoable disks that 
have redo logs (on ESX Server hosts), or a virtual machine with snapshots (on GSX 
Server hosts).

To import a template from a virtual machine:

1. Start VirtualCenter and log on to the VirtualCenter server.

2. Choose a method for starting the New Template wizard.

From the inventory panel:

a. Click the Inventory option in the navigation bar. 

The inventory panel and the information panel display the managed farms, 
hosts, virtual machines information. The Inventory toolbar appears.

b. Expand the inventory as needed, and click the appropriate virtual machine.

c. Start the New Template wizard.

From the main or right-click popup menu select New Template from this 
Virtual Machine.

From the Templates Navigation panel:

a. Click the Templates option in the navigation bar.

b. Click the New button in the Templates toolbar.

3. Confirm to proceed with the New Template Wizard. Click Next.
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4. If you are starting from the Templates New Template panel: select a virtual 
machine managed by VirtualCenter. Click Next.

The options are:

A virtual machine in the VMware VirtualCenter Inventory. — Use this option to 
create a template from a virtual machine on a managed host.

A virtual machine on a local or network file system that is not in the VMware 
VirtualCenter inventory. — Use this option to create a template from a virtual 
machine that is not being managed by VirtualCenter.
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5. If you are selecting a non-managed virtual machine: locate the source virtual 
machine. Click Next.

Type or copy the full path to the source virtual machine configuration file. This 
file has either a .vmx or a .cfg extension. 

The Browse option is available only when the VirtualCenter client is running on 
the same machine as the VirtualCenter server. If the Browse option is not 
available, type the path to the virtual machine configuration file in the textbox. 

Note: The path you specify is the path for the VirtualCenter server, not the path 
on the machine running your VirtualCenter client.

If you are not running the VirtualCenter client on the same machine as the 
VirtualCenter server, type in the path on the VirtualCenter server machine where 
the template source virtual machine is located.

Note: This file must be in a folder or file system local to the VirtualCenter server.

Note: The source virtual machine should not use IDE virtual disks.
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6. If you are using a managed virtual machine and started from the 
Templates New Template panel: select the managed virtual machine to use as 
the source for the template. Click Next.

7. Give the new template a name and description. Click Next.

Enter a useful name and a brief description of the template. This description can 
include the operating system, applications, versions, and intended uses for the 
template. The name can be up to 80 characters long, and contain alphanumeric 
characters and the underscore (_) and hyphen (-) characters. The name should 
also be unique across all templates. 
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8. Specify the target location of the template files. Click Next.

The choices are:

• On the VMware VirtualCenter server — This option makes copies of the 
virtual machine disk files and places copies into the VirtualCenter upload 
directory. 

Copying the files can take some time. After the importing template process, 
the source virtual machine is available for normal operations. Refer to 
Specifying an Upload Directory for Templates on page 252 for information on 
specifying and using the VirtualCenter upload directory. 

Use this option if the source disk is not on a SAN. This option ensures the 
template can be deployed to any managed host.

• On a datastore — This option adds a reference to the location of the files. 

The virtual machine disks are copied to the VMFS volume that you specify. 

Use this option when the virtual disk resides in a VMFS volume on a SAN. This 
ensures a rapid deploy of a new virtual machine because it is a local disk copy.
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9. If you selected On a datastore: 

Select the datastore location in which to place the new template. Click Next.

10. Complete the importing template process. Click Finish.

VirtualCenter adds the configuration file data into the VirtualCenter database 
and adds the template to the list of available templates. To view the list, click the 
Templates option in the navigation bar. 

Copying the source virtual machine to the template upload directory, can take a 
long time, depending upon the size of the source virtual machine. Refer to the 
Tasks panel to view the progress of creating the template.

To check the progress of the new template creation, click the Show Active Task 
toggle. A progress bar displays the percentage of completion.
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Cloning a Template
To clone an existing template to create an additional template:

1. From the VirtualCenter client, display the information panel of the Templates 
function. Click the Templates option in the navigation bar. 

The information panel changes to display the list of current templates and the 
template toolbar.

2. Select the appropriate template. Click the Clone toolbar button.

3. Confirm adding a new template. Click Next.

4. Give the new template a name and description. Click Next.

Enter a useful name and a brief description of the template. Description 
information can include for example, the operating system, applications, 
versions, and intended uses for the template. The name can be up to 80 
characters long, and can contain alphanumeric characters and the underscore 
(_) and hyphen (-) characters. It should also be unique across all templates. 

5. Pass through the target location screen. Click Next.

The template files are always copied to the template upload directory.

6. Complete the importing template process. Click Finish.

VirtualCenter displays the Tasks inventory panel for reference and adds the 
cloned template to the list in the information panel. The virtual disks are copied 
to the template upload directory.

Refer to the Tasks panel to view the progress of the cloning operation.
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Deleting a Template
You have the option to remove a template from VirtualCenter inventory and removing 
the template files from disk.

Deleting a Template from VirtualCenter
To delete an existing template from VirtualCenter inventory:

1. From the VirtualCenter client, display the information panel of the templates 
function.

Click the Templates option in the navigation bar. 

The information panel changes to display the list of current templates and the 
template toolbar.

2. Select and right-click the appropriate template, select the Remove option from 
the menu.

3. Confirm removing the template from the VirtualCenter database. Click OK.

All non-datastore template files are removed from the VirtualCenter inventory.

4. If the template is stored on a datastore, they cannot be removed from the 
VirtualCenter inventory until they are removed from disk.

Proceed to Deleting a Template from Disk on page 264.

Deleting a Template from Disk
To delete an existing template from VirtualCenter inventory:

1. From the VirtualCenter client, display the information panel of the templates 
function.

Click the Templates option in the navigation bar. 

The information panel changes to display the list of current templates and the 
template toolbar.

2. Select and right-click the appropriate template, select the Remove option from 
the menu.
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3. Confirm removing the template from the VirtualCenter database. Click OK.

All non-datastore template files are removed from the VirtualCenter inventory.
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Editing a Template
To change the template virtual machine:

1. Deploy the template.

2. Edit the resulting virtual machine.

3. Create a new template from the edited virtual machine.

To change the name and description of a template:

1. From the VirtualCenter client, display the templates function.

Click the Templates option in the navigation bar. 

The information panel changes to display the list of current templates and the 
template toolbar.

2. Select the appropriate template. 

3. Select the Properties option to display the Template Properties dialog box.

Choose from either Edit > Properties or right-click > Properties.

Enter a useful name and a brief description of the template. The description can 
include the operating system, applications, versions, and intended uses for the 
template. The name can be up to 80 characters long, and contains alphanumeric 
characters and the underscore (_) and hyphen (-) characters. The name should 
also be unique across all templates. 

Modify the template name or the template description. Edit the text as needed. 
Click OK.
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Reimporting a Template
If you have pre-existing VirtualCenter templates that currently are not recognized by 
VirtualCenter, for example, you may have moved to a different server, and you want to 
add them to VirtualCenter, perform one of the following:

If the templates were VirtualCenter server repository based templates:

1. Browse to the template folder

2. Select the configuration file associated with the desired template.

3. Add the template. 

This does not require copying any files.

If the templates were not stored in the VirtualCenter repository, that is they were kept 
on VMFS-based datastore:

1. Manually copy the templates from the old server to the new VirtualCenter 
template repository server.

2. Browse to the template folder

3. Select the configuration file associated with the desired template.

4. Add the templates one by one. 

This does not require copying any files. You don't have to create virtual 
machines, and there is no additional copying involved.
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Copying Virtual Machines
This chapter describes how to create a new virtual machine by deploying a template 
by cloning an existing virtual machine. Both of these methods provide options to 
customize the new virtual machine as you create it. This chapter does not describe 
the customization options. Refer to Customizing Guest Operating Systems on 
page 295 for detailed customization information. Refer to Creating New Virtual 
Machines on page 217 for information on creating a virtual machine from scratch. 

This chapter contains the following sections:

• Creating Virtual Machines from a Template on page 270

Use templates to create new virtual machines when you want to create one or 
more virtual machines easily from a reservoir of virtual machines, each with a 
specific and consistent configuration and data state.

• Creating Virtual Machines by Cloning an Existing Virtual Machine on page 283

Use the cloning method to create a new virtual machine when you want to 
create a copy of an individual, typically currently operating, virtual machine.
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You need to use a Virtual Machine Administrator role assigned to farm where the 
deployed or cloned virtual machine is located to perform the activities described in 
this chapter.

Creating Virtual Machines from a 

Template
A template is a golden image of a virtual machine. This image typically includes a 
specified operating system and configuration which provides virtual counterparts to 
hardware components. Typically, a template will include an installed guest operating 
system and a set of applications. Templates are a reservoir of specifically configured 
virtual machines ready to be deployed to a host within VirtualCenter.

VirtualCenter uses templates to create new virtual machines. This is called deploying a 
template. You can deploy a template to any host in the VirtualCenter environment. 
The deploying process includes selecting the appropriate template and designating a 
VirtualCenter target host to receive the new virtual machine. When complete, the 
deployed virtual machine is added to the inventory panel farm where the host resides.
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The figure below illustrates creating a customized virtual machine. Refer to 
Abbreviations on page 16 for a description of abbreviations.

Deploying a Template

The deploying template topics are covered in the following sections:

• Manually Deploying Virtual Machine from a Template

• Creating a Scheduled Task to Deploy a Template
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Manually Deploying Virtual Machine from a Template 
To manually start the Template Deployment wizard:

1. Start VirtualCenter and log on to the VirtualCenter server.

2. Choose a method for starting the Deploy Virtual Machine from Template wizard.

From the inventory panel:

a. Click the Inventory option in the navigation bar. 

The inventory panel and the information panel display the managed farms, 
hosts, and virtual machine information. The Inventory toolbar appears.

b. Expand the inventory as needed, and click the target host.

This is the host on which the new virtual machine will be located.

c. Start the Deploy Virtual Machine from Template wizard.

From the main or right-click popup menu, select Deploy Virtual Machine 
from Template.
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d. Select the template to deploy.

From the templates panel:

a. Click the Templates option in the navigation bar.

b. Select the template to deploy.

c. Click the Deploy button in the templates toolbar.

3. Confirm the start of the Deployment wizard. Click Next.
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4. Specify the new virtual machine name. Click Next.

Enter a name for the new virtual machine. Click Next.

Note: The virtual machine name cannot exceed 40 characters.

5. Select the farm on which to deploy the new virtual machine. Click Next.
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6. Specify the host on which to deploy the new virtual machine. Click Next.

7. Select the datastore on which to store the new virtual machine configuration file 
and virtual disks. Click Next.

This specifies the location for the new virtual machine configuration and disk 
files.

The virtual machine must be placed on a datastore. Select from the list. 

Note: On ESX Server, the disks files are not pre-allocated. That is the virtual disk 
files start small and grow as you add application files and data to your virtual 
machine.
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8. Select the network interface card (NIC) to use for the new virtual machine. Click 
Next.

9. Specify a resource allocation level. Click Next.
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10. Select whether to customize the new virtual machine as it is deployed. 

The options are:

• Start the guest customization wizard — Opens the customization wizard. 
Refer to Customizing Guest Operating Systems on page 295 for information 
on using the Guest Customization wizard.

• Import customization from an XML file — Browse for and select an existing 
XML file with customization already defined. 

Click Browse and select the appropriate XML file. Click Next.

• Do not customize the guest operating system — Proceeds with the current 
deploy and does not make any additional changes to the guest operating 
system.

Select the appropriate option and click Next.

11. Complete the Template Deployment wizard. Click Finish.

VirtualCenter displays the Tasks inventory panel for reference, makes a copy of 
the template, applies changes as specified, and stores the new virtual machine 
on the designated host location.

Creating a Scheduled Task to Deploy a Template
To deploy a virtual machine from a template as a scheduled task:

1. Display the Tasks panel.

Click the Tasks option in the navigation bar. The list of scheduled tasks appears.

2. Start the New Task wizard. Click New in the toolbar.

3. Confirm continuing with the New Task wizard. Click Next.
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4. Select the task to create.

Click the pull-down menu and select the Deploy Virtual Machine from a 
Templates option. Click Next.

5. Select the template to deploy. Click Next.
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6. Select virtual machine group in which to place new virtual machine. Click Next.

7. Select a host on which to place new virtual machine. Click Next.
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8. Specify a name for the new virtual machine. Click Next.

9. Select the datastore volume on which to store the new virtual machine 
configuration file and virtual disks.

The virtual machine disk files must be placed on a data store. Select from the list. 
Click Next.
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10. Select the network interface card (NIC) to use for the new virtual machine. Click 
Next.

11. Specify a resource allocation level. Click Next.
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12. Select whether to customize the virtual machine as it is deployed. Click Next.

13. Set when you want the virtual machine to be deployed. Click Next.

Click Later, then click the drop-down arrow to select a date from the displayed 
calendar. A red circle indicates today’s date and a dark circle indicates the 
scheduled date.

14. Confirm creating the task. Optionally, specify an email address for notification 
when task is performed. Click Finish.

VirtualCenter adds the new task to the scheduled task list and completes it at the 
designated time. When it is time to perform the task, VirtualCenter first verifies 
that the user who created the task still has permission to complete the task. If the 
permission levels are not acceptable, VirtualCenter logs a message and the task 
is not performed.
www.vmware.com282



C H A P T E R  1 2  Copying Virtual Machines
Creating Virtual Machines by Cloning an 

Existing Virtual Machine
A clone is a copy plus customization of a virtual machine. When you create a clone, 
VirtualCenter provides an option to customize the guest operating system of that 
virtual machine. You can place the new clone on any host within the same farm as the 
original virtual machine. 

The figure below illustrates the creating a new customized virtual machine by cloning 
an existing virtual machine. Refer to Abbreviations on page 16 for a description of 
abbreviations.

Creating a Clone
283



VMware VirtualCenter User’s Manual
The cloning a virtual machine topics are covered in the following sections:

• Manually Cloning a Virtual Machine

• Creating a Scheduled Task to Clone a Virtual Machine

Manually Cloning a Virtual Machine
To manually start the Virtual Machine Cloning wizard:

1. Start VirtualCenter and log on to the VirtualCenter server.

2. Start the Clone a Virtual Machine wizard, from the inventory panel:

a. Click the Inventory option in the navigation bar. 

The inventory panel and the information panel display the managed farms, 
hosts, and virtual machine information. The Inventory toolbar appears.

b. Expand the inventory as needed, and click the source virtual machine.

c. Start the Clone a Virtual Machine wizard.

From the main or right-click popup menu, select Clone.

3. Confirm continuing with the Clone wizard. Click Next.

4. Select a target host for the clone. Click Next.
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5. Select a Virtual Machine Group for the clone. Click Next.

6. Assign a name to the clone. 

Enter a name. Click Next.
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7. Select the datastore location.

Select a location from list. Click Next.

8. Assign the network interface cards (NIC).

Select from the list, if there is more than one NIC. Click Next.
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9. Specify the resource allocation level. 

The resource allocating level tells VirtualCenter what percentage of the host 
resources to make available to the new virtual machine.

Click the appropriate radio button. Click Next.

10. Select whether to customize the new virtual machine as you create it.

Click the appropriate radio button. Click Next.

If you select the customization option, refer to Customizing Guest Operating 
Systems on page 295 for description of the customization wizard and options.

If you decide not to customize the new virtual machine as part of the cloning 
process, proceed to the next step.

11. Complete the Cloning a Virtual Machine wizard. Click Finish.
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VirtualCenter displays the Tasks inventory panel for reference and makes a copy 
of the virtual machine, applies changes as specified, and stores the virtual 
machine on the designated host location.

Creating a Scheduled Task to Clone a Virtual Machine
To create a scheduled task to clone a virtual machine:

1. Display the Tasks panel.

Click the Tasks option in the navigation bar. The list of scheduled tasks appears.

2. Start the New Task wizard. Click New in the toolbar.

3. Confirm continuing with the New Task wizard. Click Next.

4. Select the task to create.

Click the pull-down menu and select Deploy Virtual Machine from a Templates. 
Click Next.
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5. Select the virtual machine to clone. Click Next.

6. Select a target host for the clone. Click Next.
289



VMware VirtualCenter User’s Manual
7. Select a farm for the clone. Click Next.

8. Assign a name to the clone.

Enter a name. Click Next.
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9. Select the datastore location.

Select a location from the list. Click Next.

10. Assign the network interface cards (NIC).

Select from the list, if there is more than one NIC. Click Next.
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11. Specify the resource allocation level. 

The resource allocation level tells VirtualCenter what percentage of the host 
resources to make available to the new virtual machine.

Click the appropriate radio button. Click Next.

12. Select whether to customize the new virtual machine as you create it.

Click the appropriate radio button. Click Next.

If you select the customization option, refer to Customizing Guest Operating 
Systems on page 295 for description of the customization wizard and options.

If you decide not to customize the new virtual machine as part of the cloning 
process, proceed to the next step.
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13. Set the time and date when you want the virtual machine to be deployed. Click 
Next.

Click Later, then click the drop-down arrow to select a date from the displayed 
calendar. A red circle indicates today’s date, and a dark circle indicates the 
scheduled date.

14. Confirm creating the task. 

Optionally, specify an email address for notification when task is performed. Click 
Finish.

VirtualCenter adds the new task to the scheduled task list and completes it at the 
designated time. When it is time to perform the task, VirtualCenter first verifies 
that the user who created the task still has permission to complete the task. If the 
permission levels are not acceptable, VirtualCenter sends a message to the log 
and the task is not performed.
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Customizing Guest Operating 
Systems
This chapter describes how to customize your guest operating systems. You 
customize your guest operating system when you create a virtual machine in 
VirtualCenter from a template or as a clone.

This chapter contains the following sections:

• Preparing for Guest Customization on page 297

• Beginning the Guest Customization Process on page 300

• Customizing New Guest Operating Systems on page 303

• Completing a Guest Operating System Customization on page 314

You need to use a Virtual Machine Administrator role assigned to the target host 
where the virtual machine is located to perform the activities described in this 
chapter.

When a new virtual machine is deployed or cloned, starting the Guest Customization 
wizard is an option. 

Customizing Windows guest operating system options include:

• Join workgroups and domains
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• Network interface configuration

• Domain suffix, security ID (SID) change

Customizing Linux guest operating system options include:

• Host name

• Domain suffix

• Network interface configuration
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Preparing for Guest Customization
When you deploy a template or clone an existing virtual machine, you have the 
opportunity to customize the new guest operating system. A Guest Customization 
wizard guides you through the configuration options. 

Before you run the Guest Customization wizard, that means, before you start the 
Template Deployment or Clone wizards, if you intend to perform a Guest 
Customization, perform the following:

• Verify that your system meets the guest customization requirements listed in 
VirtualCenter Guest Operating System Customization Requirements on page 50. 

• Install the required components on the Windows machine where the 
VirtualCenter server is installed. 

Installing the components required to support guest operating system customization 
are covered in the following sections:

• Installing the Microsoft Sysprep Tools

• Installing the VMware Open Source Components

Installing the Microsoft Sysprep Tools
If you plan to customize a Windows guest operating system, you must first install the 
Microsoft Sysprep tools on your VirtualCenter client machine. 

In the physical world, computers are typically deployed from disk image files created 
using tools such as Ghost and DriveImage. To create an image of a Windows 
computer, you typically run Microsoft Sysprep on the template computer and then 
capture or creates an image from that computer. Sysprep prepares the template 
computer for deployment by installing special software that reconfigures the 
operating system on the next boot.

In VirtualCenter, you never have to run Sysprep manually on a virtual machine before 
use the virtual machine as a template or the source of a clone operation. 
VirtualCenter’s guest customization technology automatically performs the Sysprep 
preparation step during deploy or cloning operation.

Manually running Sysprep in a template virtual machine or source virtual machine is 
unnecessary, but harmless. VirtualCenter automatically runs Sysprep on the virtual 
machine a second time, overriding and overwriting files and configuration settings 
from the first Sysprep operation.

The following process must be performed once if you are going to customize virtual 
machines with any of the supported Windows guest operating systems installed. 
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Refer to VirtualCenter Guest Operating System Customization Requirements on 
page 50 for a list of the supported guest operating systems.

To install the Microsoft Sysprep tools:

1. Download the Sysprep package from the Microsoft Web site. 
www.microsoft.com/windows2000/downloads/tools/sysprep/default.asp

Though the Sysprep version indicates Windows 2000, it works with both 
Windows XP Professional and Windows Server 2003.

2. Run the Microsoft installer.

Q257813_w2k_spl_x86_en.exe

3. Locate the directory to place the expanded files.

a. From the dialog box Browse to the default installation location:

C:\[VirtualCenter_installation_directory]\resources\
windows\sysprep\1.1

b. Click OK.

The expanded directory structure resembles the following:

...\resources\windows\sysprep\1.1\

...\resources\windows\sysprep\1.1\contents.txt

...\resources\windows\sysprep\1.1\docs\...

...\resources\windows\sysprep\1.1\tools\...

...\resources\windows\sysprep\1.1\samples\...

You are now ready to customize a new virtual machine with supported Windows 
guest operating system as you clone an existing virtual machine or deploy a 
template.

Installing the VMware Open Source Components
If you plan to customize a Linux guest operating system, you must first install the 
VMware Open Source components on your VirtualCenter server machine. VMware 
has packaged these components into a separate package called VMware Open 
Source Components, which you download from the VMware Web site. Refer to: 
www.vmware.com/download

Perform the following process once on the VirtualCenter server to support the Linux 
guest operating systems:

• Red Hat Enterprise Linux AS 3.0

• Red Hat Advanced Server 2.1

• SUSE LINUX Enterprise Server 8
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To install the VMware Open Source Components:

1. On the machine running VirtualCenter server, disable any anti-virus application 
that interferes with Active Scripting.

VirtualCenter server uses Windows Active Scripting to perform some of its tasks. 
Certain anti-virus applications may disable active scripting or block scripts from 
accessing system resources. When this happens, some features of VirtualCenter 
behave unexpectedly or fail to work. In Norton AntiVirus, the feature is called 
Script Blocker. in McAfee, it's known as ScriptStopper. If you have one of these, or 
another anti-virus application that interferes with Active Scripting, it is important 
that you disable these features on the machine running VirtualCenter server.

2. From your VirtualCenter server machine, open a browser.

Perform this on every machine that has a VirtualCenter server. 

3. Locate, download, and start the VMware Open Source Components installer.

a. Go to the browser path: www.vmware.com/download

b. Follow the link to the VirtualCenter download page.

c. Click the download link to the Open Source Components installer.

Answer the prompts to place the installer file on your system.

4. Start the Open Source Components installer.

Double-click on the VMware Open Source Components .exe file.

The VMware Open Source Components installer starts up and displays a 
download dialog box.

5. Complete the installation.

Follow the installer instructions.

You are now ready to customize a new virtual machines with a supported Linux 
guest operating system as you clone an existing virtual machine or deploy a 
template.
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Beginning the Guest Customization 

Process
The Guest Customization wizard option appears during the virtual machine 
deployment or cloning process.

The beginning the guest customization topics are covered in the following sections:

• Entering the Guest Customization Wizard from the Template Deployment 
Process

• Entering the Guest Customization Wizard from the Cloning Process

Entering the Guest Customization Wizard from the Template 
Deployment Process
Add a new virtual machine to a host by deploying a managed template.

To start the guest operation system customization wizard:

1. From the VirtualCenter client Schedule Task panel, start the Template 
Deployment wizard.

a. Display the Tasks panel, by clicking the Tasks option in the navigation bar.

The list of existing scheduled tasks appears.

b. Start the New Task wizard. Click New in the toolbar.

c. Confirm continuing with the New Task wizard. Click Next.

d. Select the task to create. Click the pull-down menu and select the Deploy a 
virtual machine from Templates option. Click Next.

2. Proceed with the Template Deployment wizard screens.

Refer to Creating Virtual Machines from a Template on page 270 for more 
detailed description.

a. Confirm continuing with the Template Deployment wizard. Click Next.

b. Select a template to deploy. Click Next.

c. Select a farm to which to deploy. Click Next.

d. Select a host to which to deploy. Click Next.

e. Specify a name for the new virtual machine. Click Next.

f. Select the storage location for the virtual machine configuration and disk files. 
www.vmware.com300



C H A P T E R  1 3  Customizing Guest Operating Systems
Click the appropriate volume from the displayed list of possible datastores. 
Click Next.

g. Select the virtual networks for each of the virtual machine’s Network Interface 
Cards (NICs).

Click the appropriate network from the pull-down menu. Click Next.

h. Set the resource priority for this virtual machine. 

Click the appropriate radio button. Click Next.

3. Select whether to customize the new guest operating system.

Click Start the guest customization wizard. Click Next. Proceed to Customizing 
New Guest Operating Systems on page 303.

Entering the Guest Customization Wizard from the Cloning 
Process
A new virtual machine can be added to a host by cloning a existing virtual machine.

To start the guest operation system customization wizard:

1. From the VirtualCenter client Schedule Task panel, start the Clone wizard.

a. Display the Tasks log, by clicking the Tasks option in the navigation bar.

The list of existing scheduled tasks appears.

b. Start the New Task wizard. Click New in the toolbar.

c. Confirm continuing with the New Task wizard. Click Next.

d. Select the task to create. Click the pull-down menu and select the Clone an 
existing virtual machine option. Click Next.

2. Proceed with the Clone wizard.
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a. Select a virtual machine to clone. Click Next.

b. Select a host for the new clone. Click Next.

c. Specify a name for the new clone. 

Type a name and click Next.

d. Select the volume on which to store the new clone’s files. Click Next.

e. Specify the network interface card (NIC) for the new clone. Click Next.

f. Specify the resource priority for the new clone. Click Next.

3. Select whether to customize the new clone.

Click Start the guest customization wizard. Click Next. Proceed to Customizing 
New Guest Operating Systems on page 303.
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Customizing New Guest Operating 

Systems
The customizing process varies, depending upon the guest operating system to be 
used in the new virtual machine. Refer to VirtualCenter Guest Operating System 
Customization Requirements on page 50 for a list of supported guest operating 
systems.

The customizing guest operating system topics are covered in the following sections:

• Customizing a Windows Guest Operating System

• Customizing a Linux Guest Operating System

Customizing a Windows Guest Operating System
To customize a Windows 2000, Windows XP Professional, or Windows Server 2003 
guest operating system while deploying a template or cloning a virtual machine, 
perform the following.

Note: The use of dynamic disks with Windows 2000, is not supported in 
VirtualCenter.

To customize a Windows guest operating system:

1. Start the Guest Customization wizard.

You cannot start the Guest Customization wizard from a menu or toolbar option. 
The Guest Customization wizard starts indirectly from the VirtualCenter 
Template Deployment or Clone wizard. 

• If you are deploying a template to create a new virtual machine. Refer to 
Creating Virtual Machines from a Template on page 270.

• If you are cloning an existing virtual machine. Refer to Creating Virtual 
Machines by Cloning an Existing Virtual Machine on page 283.

2. Confirm continuing with the Guest Customization wizard. Click Next.
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3. Optionally, specify registration information. 

The owner’s name and organization are for your reference purposes only. They 
do not affect the functioning of the virtual machine.

Enter the name of a person, user, or group, and of the organization in the 
appropriate fields. Click Next.

4. Specify a computer name for the virtual machine. Click Next.

The host, or computer name, is the name given to the particular instance of a 
guest operating system. The operating system uses this name to identify itself on 
the network. On Windows systems it is called the computer name. On most 
other operating systems it is called the host name. 

This is not the same as the virtual machine name. That was declared earlier in the 
Clone or Template Deployment wizard.
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5. Specify a Windows license key for the new guest operating system. For Windows 
Server operating systems, enter the license mode. Click Next.

6. Specify the password for the Administrator account. 

If you specify a new administrator password and the source Windows virtual 
machine or template already has one, then you must select the Delete all user 
accounts option in step 11. Otherwise the old administrator password is not 
changed.

Enter the password for the Administrative user. Enter it again in the Confirm 
Password field. Click Next.
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7. Specify a time zone. Click Next.

8. Specify any commands to be run the first time the new virtual machine is 
started.

Type the command string in the field. Click Add. Use the Delete and Move 
options the commands in the appropriate order.
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9. Select whether to use typical or customize network settings. Click Next.

The options are: 

• Typical settings — VirtualCenter automatically configures all network 
interfaces from a DHCP server.

• Custom settings — You specify the network settings. 

10. If you use custom network settings:

a. Select the network interface card (NIC) to customize. Click Next.

Optionally, select the NIC, then click Customize to make additional 
specifications.
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b. If you are customizing the NIC network properties, select the method and 
enter the IP and DNS server addresses. 

Specify an IP Address and DNS Server. Click OK to close this dialog box and 
return the previous dialog box. Then click Next on the Network Guest 
Customizations dialog box.

c. Specify the WINS address.

Click the WINS tab. Type the appropriate IP addresses. Click OK to close this 
dialog box and return the previous dialog box. Then click Next on the 
Network Guest Customizations dialog box.
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Join a workgroup or domain.

Enter the workgroup and domain identification information. Click Next.

11. Select additional guest operating system options.

The options are:

Generate New Security ID (SID) — This option is set to default.

Delete all user accounts — If you specify a new administrator password in step 
6, and the source Windows virtual machine or template already has one, then 
you must select the Delete all user accounts option here. Otherwise the old 
administrator password is not changed.

Click the buttons to configure any desired options. Click Next.
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12. Optionally, save the customized options as an .xml file. 

Specify a filename and location. Click Next. 

VirtualCenter saves the customized configuration parameters in an .xml file. 
Later, import these predefined customized parameters, when deploying a 
template or cloning an existing virtual machine. 

If the customization settings are saved to a file then the administrator password 
of the Windows virtual machine and the domain administrator’s password, as 
applicable, are stored in encrypted format in the .xml file. 

13. Complete the Guest Customization wizard. Click Finish.

VirtualCenter closes the Guest Customization wizard and returns you to the 
Deploy a Template or Clone a Virtual Machine wizard to complete that wizard. 

Customizing a Linux Guest Operating System
To customize a Linux RedHat Advanced Server or Linux SuSe guest operating system 
while deploying a template or cloning a virtual machine:

1. From the VirtualCenter Template or Clone wizard, start the Guest Customization 
wizard.

This wizard starts as a subset of one of the following wizards:

• Deploying a template to create a new virtual machine. Refer to Creating 
Virtual Machines from a Template on page 270.

• Cloning an existing virtual machine. Refer to Creating Virtual Machines by 
Cloning an Existing Virtual Machine on page 283.

2. Confirm continuing with the Guest Customization wizard. Click Next.
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3. Optionally, specify a hostname and domain suffix for this virtual machine. Click 
Next.

The host, or computer name, is the name given to the particular instance of a 
guest operating system. The operating system uses this name to identify itself on 
the network. On Windows systems it is called the computer name. On most 
other operating systems it is called the host name. 

This is not the same as the virtual machine name. That name was declared earlier 
in the Clone a Virtual Machine or the Deploy a Template wizard. 

4. Select the network settings. 

Select the appropriate radio button. Click Next.

• Typical settings — VirtualCenter automatically configures all network 
interfaces from a DHCP server.

• Custom settings — You specify the network settings. 
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5. If you use custom network settings:

a. Enter the DNS addresses.

Enter a DNS name. Click Add. Enter the DNS addresses. Click Next.

b. Select the Network Interface Card (NIC) to customize. Click Next.

Optionally, select the NIC, then click Customize to make additional 
specifications.
www.vmware.com312



C H A P T E R  1 3  Customizing Guest Operating Systems
c. If you are customizing the NIC network properties, select the method and 
enter the IP and DNS server addresses. 

Click OK to close this dialog box and return the previous dialog box. Then click 
Next on the Network Customizations dialog box.

6. Optionally, save the customized options in an .xml file. 

Specify a filename and location. Click Next. 

VirtualCenter saves the customized configuration parameters in an .xml file. 
Later, import these predefined customized parameters, when deploying a 
template or cloning an existing virtual machine.

7. Complete the Guest Customization wizard. Click Finish.

VirtualCenter closes the Guest Customization wizard and returns you to the 
Deploy a Template or Clone a Virtual Machine wizard to complete that wizard. 
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Completing a Guest Operating System 

Customization
Customization completes when the new virtual machine boots for the first time. 
Windows guest operating system virtual machines, sometimes require a reboot after 
the initial boot. Linux guest operating system virtual machines do not require a reboot 
after the initial boot. The customization process does not complete until the guest 
operating system boots, runs the finalization scripts, and reaches the logon screen. 

If the new virtual machine encounters errors when booting for the first time, many of 
those errors are reported in a system log. Customization errors seen after booting up 
the customized virtual machine are logged in both Linux as well as Windows guest 
operating systems. In Linux these are errors are logged to /var/log/boot.log. 
In Windows they are written to the Event Viewer under Application Log. 

Steps required to finalize guest operating system customization are covered in the 
following sections:

• Completing Linux Guest Operating System Customization

• Completing Windows Guest Operating System Customization

Completing Linux Guest Operating System Customization
A customized Linux virtual machine does not need any additional reboots and is 
operational as soon as the logon screen appears after the first boot. If configuration 
errors occur, they are displayed on the virtual machine’s console screen while the 
guest operating system is booting.

Completing Windows Guest Operating System Customization
When a customized virtual machine is powered on for the first time, its guest 
operating system runs a set of scripts that finalize the customization and 
configuration process. Depending on the guest operating system type, this process 
may involve additional reboots which are automatically performed by the scripts.

The customization process installs scrips that run once in the target virtual machine 
when it powers on (or boots) for the first time after being deployed or cloned. Those 
scripts complete the customization process by performing final configuration 
operations on the guest operating system.

After powering on for the first time, a customized Windows virtual machine 
automatically reboots twice to finalize the configuration process. It becomes 
operational when the logon screen appears after the second reboot. This process can 
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take several minutes, depending upon the speed and load of the host. If any errors 
occur during the final configuration process, events are logged to the guest operating 
system’s event database, and can be viewed using Program > Administrative Tools > 
Event Viewer from the Windows Start menu.

If any of the information required in the configuration finalization process is not 
correct, the guest operating system pauses when the new virtual machine boots and 
waits for you to enter the correct information. This information includes:

• The computer name is not unique. The computer name must be unique for the 
network on which the machine is deployed. 

• The product key is incorrect.

• The user specified to join a domain that does not exist.

• The DHCP server for the network is not functioning properly.

To determine if the system is waiting for information check the virtual machine icon in 
the inventory panel, if it is flashing, it is waiting for a response. Alternatively, check the 
Status field in the virtual machine Summary tab. If it is displaying a link, the system is 
waiting for a response. Refer to Answering a Pending Question on page 191 for 
additional information.
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Editing an Existing Virtual 
Machine Configuration
This chapter describes how to edit or customize your existing virtual machines. 
Perform these activities after you create the virtual machine and install the guest 
operating system. This chapter contains the following sections:

• Beginning to Edit the Virtual Machine Configuration on page 319

• Changing Hardware Configuration of a Virtual Machine on page 321

• Adding Hardware to a Virtual Machine on page 336

• Changing Virtual Machine Options on page 352

• Changing Virtual Machine Resources Settings on page 357

You need to use a Virtual Machine Administrator role assigned to the virtual machine 
you wish to edit in order to perform the activities described in this chapter.

Note: When you create a virtual machine and install the guest operating system, 
please install the VMware Tools. Installation of the VMware Tools is specific to the 
guest operating system installed. Please refer to Installing VMware Tools on page 244 
for information on installing the VMware Tools.
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Note: For comprehensive information about configuring the virtual machines, refer 
to your ESX Server, GSX Server, and Workstation documentation.
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Beginning to Edit the Virtual Machine 

Configuration
In addition to customizing a virtual machine while you create it, you have the option 
to edit the virtual machine configuration after you create it. This section describes 
how to customize an existing virtual machine. Refer to your VMware ESX Server or GSX 
Server documentation for information about all the ramifications of specific 
customizations.

To customize an existing virtual machine:

1. From the VirtualCenter client, display the inventory panel and expand the 
appropriate farm.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the virtual machine to customize.

2. Power off the virtual machine.

Most of the Virtual Machine Properties dialog box options are not editable if the 
virtual machine is powered on.

3. Display the Virtual Machine Properties dialog box.

Select Properties from the Edit menu or Edit Properties from the Summary tab.
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4. Make changes and or additions as needed. Click OK.

Select items on the Virtual Machine Properties dialog box, and complete the 
wizards. 

Refer to the appropriate section in this chapter for additional information. Refer 
to your ESX Server, GSX Server, and Workstation documentation for 
comprehensive information about configuring the virtual machines.
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Changing Hardware Configuration of a 

Virtual Machine
This section introduces the changes you can make to the virtual machine hardware. 
The following sections describe how to change the configuration of existing virtual 
hardware devices in a virtual machine:

• Changing DVD/CD-ROM Drive Configuration

• Changing Floppy Drive Configuration

• Changing Generic SCSI Device Configuration

• Changing Hard Disk Configuration

• Changing Memory Configuration

• Changing Ethernet Adapter (NIC) Configuration

• Changing Parallel Port Configuration

• Changing SCSI Controller Configuration

• Changing Serial Port Configuration

• Changing Video Configuration

• Changing Virtual CPU Configuration

• Changing Audio Configuration

• Changing Mouse Configuration

• Changing USB Configuration

Changing DVD/CD-ROM Drive Configuration
To change the DVD/CD-ROM drive configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the DVD/CD-ROM 
Drive in the Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the DVD/CD-ROM object in the Device panel.

3. Make changes as needed. 
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Select the device status, connection or virtual device node for the virtual 
machine to use. Click OK.

Changing Floppy Drive Configuration
To change the floppy drive configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the floppy drive in 
the Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the floppy drive object in the Device panel.

3. Make changes as needed 
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Select the device status, connection device or floppy image for the virtual 
machine to use. Click OK.

Changing Generic SCSI Device Configuration
To change the Generic SCSI Device drive configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the generic SCSI 
device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the generic SCSI device in the Device panel.

3. Make changes as needed. 
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Select the device status, connection, and node for the virtual machine to use. 
Click OK.

Changing Hard Disk Configuration
To change the hard disk configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the hard disk in 
the Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the hard disk in the Device panel.

3. Change the path to the hard disk. 
www.vmware.com324



C H A P T E R  1 4  Editing an Existing Virtual Machine Configuration
Select the disk file, capacity, and disk information for the virtual machine to use. 
Click OK.

4. Prepare to change the disk mode. Click Advanced.

5. Close out the Virtual Machine Properties dialog box. Click OK.

Changing Memory Configuration
To change the memory configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select memory in the 
Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the memory in the Device panel.

3. Make changes as needed.
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Adjust the size of the memory allocated to the virtual machine guest operating 
system. Click OK.

The range of memory supported is 4 MB to 3600 MB and is no longer limited to 
the physical memory of the host where the virtual machine resides. 

Changing Ethernet Adapter (NIC) Configuration
To change the ethernet adapter (NIC) configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the NIC in the 
Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the NIC in the Device panel.

3. Make changes as needed.
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Select the device status, adapter type, and network connection of the virtual 
machine. Click OK.

Changing Parallel Port Configuration
To change the parallel port configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the parallel object 
in the Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the parallel port in the Device panel.

3. Make changes as needed.
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Select the device status and connection for the virtual machine to use. Click OK.

Changing SCSI Controller Configuration
Note: Changing the SCSI controller may result in a virtual machine boot failure.

To change the SCSI controller configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the SCSI controller 
in the Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the SCSI controller in the Device panel.

3. Make changes as needed.
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Select the device attributes for the virtual machine to use. Click OK.

Changing Serial Port Configuration
To change the serial port configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the serial object in 
the Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the serial port in the Device panel.

3. Make changes as needed.
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Adjust the device status, connection and I/O mode for the virtual machine 
display. Click OK.

Changing Video Configuration
To change the video configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the video object in 
the Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the video in the Device panel.

3. Make changes as needed.
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Adjust the number of colors allocated to the virtual machine display. Click OK.

Changing Virtual CPU Configuration
To change the virtual CPU configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the virtual CPUs in 
the Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the virtual CPUs in the Device panel.

3. Make changes as needed.
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Adjust the number of processors allocated to the virtual machine display. Click 
OK.

Note: Update the licensing to adjust to the new number of virtual CPUs. Refer 
to Adding Licenses on page 116. If you configure a virtual machine to have two 
CPUs, you must update the licensing accordingly or an error results. Do not 
change the number of CPUs after you install the guest operating system. Not all 
guest operating systems support Symetric Multi-Processor (SMP). 

Default typical CPU configuration is for a single virtual CPU.

Changing Audio Configuration
To change the audio configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the audio in the 
Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the audio in the Device panel.

3. Make changes as needed.
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Specify whether to connect automatically when the virtual machine starts and 
select the type of sound adapter. Click OK.

Changing Mouse Configuration
To change the mouse configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the mouse in the 
Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the mouse in the Device panel.

3. Make changes as needed.

Specify how VirtualCenter should detect the type of mouse connected to the 
virtual machine. Click OK.
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Changing USB Configuration
To change the USB configuration:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box, then select the USB in the 
Device panel.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

Click the Hardware tab. Click the USB in the Device panel.

3. Make changes as needed.

Specify whether to automatically detect all USB devices upon startup of the 
virtual machine. Click OK.
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Adding Hardware to a Virtual Machine
This section describes how the add hardware devices to an existing virtual machine. 
Adding individual hardware devices is described in the following sections:

• Adding a DVD/CD-ROM Drive

• Adding a Floppy Drive

• Adding a Generic SCSI Device

• Adding the Hard Disks

• Adding a Ethernet Adapter (NIC)

• Adding a Parallel Port

• Adding a Serial Port

Adding a DVD/CD-ROM Drive
To add a DVD/CD-ROM drive to a virtual machine:

1. From the VirtualCenter client, select the virtual machine to customize.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. Click the Hardware tab. 

Select any device.

4. Start the Add Hardware wizard. 

Click the Add button.

5. Select the DVD/CD-ROM device to add. Click Next.
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6. Select the connection type. Click Next.

7. Select device.

Select the type of device, select a type from the list, or enter the name of the 
device. 
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8. If you selected an ISO image: locate the image.

9. If you selected the Advanced button: select a device node. 

a. Click Advanced button in the Choose DVD/CD-ROM Device screen.

b. Select the appropriate device node. 

c. Click Back.

10. Complete the process. Click Finish.

Adding a Floppy Drive
To add a floppy drive to a virtual machine:
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1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. Click the Hardware tab. 

Select any device.

4. Start the Add Hardware wizard. 

Click the Add button.

5. Select the floppy drive device to add. Click Next.

6. Select the type of floppy media.

Select the appropriate radio button. Click Next.
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7. If you are using a physical floppy drive: either select the device or enter the 
name of the floppy device and whether to connect it when the virtual machine 
powers on. 

8. If you are using an ISO image: select the image.

9. Complete the Add Hardware wizard. Click Finish.

Adding a Generic SCSI Device
To add a generic SCSI device to a virtual machine:

1. From the VirtualCenter client, select the virtual machine.
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Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. Click the Hardware tab. 

Select any device.

4. Start the Add Hardware wizard. 

Click the Add button.

5. Select the generic SCSI device to add. Click Next.

6. Make changes as needed. 

Select a SCSI device. Select whether or not to connect the device when the 
virtual machine powers on. Select a node. Click Finish.

Adding the Hard Disks
To add a hard disk to a virtual machine:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.
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3. Click the Hardware tab. 

Select any device.

4. Start the Add Hardware wizard. 

Click the Add button.

5. Select the hard disk device to add. Click Next.

• If it is an ESX Server virtual machine: you can select the third option. 

• If it is a GSX Server virtual machine: the third option is not displayed.

Select the appropriate radio button. Click Next.

6. If you select new virtual disk:

a. Select the type of disk.
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b. Select the new disk capacity. Click Next.

Enter the disk size. Click Next.

For GSX Server hosts: The Allocate all disk space now and Split disk into 2 GB 
files options are available. Click the check boxes as needed.

c. Complete the process. Click Finish.

7. If you select existing virtual disk:

a. Specify the existing disk file.

b. Complete the process. Click Finish.
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8. If you select System LUN/Disk (ESX Server only):

a. Specify a disk local to the VirtualCenter server.

b. Complete the process. Click Finish.

Adding a Ethernet Adapter (NIC)
To add a Ethernet adapter to a virtual machine:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. Click the Hardware tab. 

Select any device.

4. Start the Add Hardware wizard. 

Click the Add button.

5. Select the ethernet adapter device to add. Click Next.

6. Make changes as needed. Click Finish.
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Select the network label and whether to connect the device when the virtual 
machine powers on.

Adding a Parallel Port
To add a parallel port to a virtual machine:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. Click the Hardware tab. 

Select any device.

4. Start the Add Hardware wizard. 

Click the Add button.

5. Select the parallel port device to add. Click Next.
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6. Select the device type. Click Next.

7. If you selected a physical parallel port:

Select the port or enter the port number and whether to connect the device 
when the virtual machine powers on. Click Finish.

8. If you selected an output file:
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Specify the output file name. Click Finish.

Adding a Serial Port
To add a serial port to a virtual machine:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. Click the Hardware tab. 

Select any device.

4. Start the Add Hardware wizard. 

Click the Add button.

5. Select the serial port device to add. Click Next.
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6. Select a serial port type. Click Next.

7. If you selected a physical serial port:

a. Specify the port. 

b. Specify advanced options, if needed.
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Click the Advanced button in the Select a Physical Serial Port screen. Make 
changes. Click Back.

c. Complete the process. Click Finish.

8. If you selected an output file:

a. Specify the output filename. Click Next.

b. Specify advanced options, if needed.
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Click the Advanced button in the Select a Serial Port Output File screen. Make 
changes. Click Back.

c. Complete the process. Click Finish.

9. If you selected output to a named pipe:

a. Specify the named pipe. Click Next.

b. Specify advanced options, if needed.
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Click the Advanced button in the Specify Named Pipe screen. Make changes. 
Click Back.

c. Complete the process. Click Finish.
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Changing Virtual Machine Options
The virtual machine settings allow you define actions that occur in various virtual 
machine power states. The options are described in the following sections:

• Changing General Settings

• Changing Power State Options

• Changing Advanced Settings

Changing General Settings
To change the general settings of a virtual machine:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. View the general options. Click the Options tab. 

4. Make changes as needed. 

Click General in the Settings list. Enter the values in the fields as needed. Click 
OK.
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If it is an ESX Server virtual machine: select your settings.

If it is a GSX Server virtual machine: select your settings.
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Changing Power State Options
To change the setting for actions that occur when the power state of a virtual 
machine changes:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. View the power options. Click the Options tab. 

4. Make changes as needed. 

Click Power in the Settings list. Select when to run VMware Tools scripts. Click 
OK.

Changing Advanced Settings
To change the advanced virtual machine settings:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.
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2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. View Advanced options. Click the Options tab. 

4. Make changes as needed. 

Click the Advanced in the Settings list. Select process priorities and message 
collecting options. Click OK.

If it is an ESX Server virtual machine: select your settings.
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If it is a GSX Server virtual machine: select your settings.
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Changing Virtual Machine Resources 

Settings
You can manually change individual resource settings or you can schedule to have 
the priority for resources changed. 

The Virtual Machine Properties dialog box provides a means to adjust the host 
resource allocation for the selected virtual machine. Refer to Allocating Host 
Resources on page 177 to adjust all the virtual machines currently installed on a 
particular host in a single view. 

Note: Changing resource settings applies to ESX Server hosts only.

Each of the following sections describes adjusting the allocations or priorities of the 
referenced resource:

• Scheduling a Resource Settings Change

• Changing CPU Settings

• Changing Memory Settings

• Changing Disk Settings

• Changing Network Settings

Scheduling a Resource Settings Change
To periodically change the resource allocation for a virtual machine on a 
particular host, use the New Task Wizard:

1. Select the Scheduled Tasks navigation button.

2. Click the New Task button then click Next.

3. From the Select a Task panel, select the pull down menu and choose Change 
resource settings of a virtual machine. 

4. Select virtual machine whose priorities you wish to change. Click Next.
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5. Select a priority level. Click Next.

Assigning Resources configures CPU and memory resource allocation for a 
virtual machine in a host.

6. Schedule a time to implement the change. Click Next.

7. Specify an email address if you wish notification. Click Finish.

Changing CPU Settings
To change the resource allocation for the CPU of a virtual machine:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. View the resources options. Click the Resources tab. 

4. Make changes as needed. 

Click CPU in the Settings list. 
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Select resource settings, shares and scheduling affinity as needed. Click OK.

Changing Memory Settings
To change the resource allocation for the CPU of a virtual machine:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. View the resources options. Click the Resources tab. 

4. Make changes as needed. 

Click memory in the Settings list. 
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Select settings and shares as needed. Click OK.

Changing Disk Settings
To change the resource allocation for the disk of a virtual machine:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. View the resources options. Click the Resources tab. 

4. Make changes as needed. 

Click disk in the Settings list. 
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Select settings and shares as needed. Click OK.

Changing Network Settings
To change the parameters of network traffic shaping:

1. From the VirtualCenter client, select the virtual machine.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

In the Summary tab, click the Edit Properties button. Or, click Properties from 
the Edit menu.

3. View the resources options. Click the Resources tab. 

4. If you have an ESX Server virtual machine:

a. Make changes as needed. 

b. Click network in the Settings list. 
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c. Enable or disable network traffic shaping, and adjust the rates. Click OK.
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5. If you have a GSX Server virtual machine:

a. Make changes as needed. 

b. Click network in the Settings list. 

c. Enable or disable network traffic shaping, and adjust the rates. Click OK.
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Working with Scheduled Tasks
This chapter describes how to schedule VirtualCenter tasks. This chapter contains the 
following sections:

• Understanding Scheduled Tasks on page 366

• Creating a Scheduled Task on page 367

• Rescheduling a Task on page 373

• Removing a Scheduled Task on page 374

• Cancelling a Scheduled Task on page 375

You need to use a Virtual Machine User role assigned to the farm to perform the 
activities described in this chapter.
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Understanding Scheduled Tasks
The scheduled tasks option allows you to configure selected VirtualCenter activities to 
perform at a designated time. The timing options include immediately, later, or on a 
recurring basis. Scheduled tasks are performed in addition to manually driven 
activities. 

Create a scheduled task through the New Task wizard, which displays the available 
task options. After you select an option, the wizard displays the screens that are 
relevant to the type of task you are scheduling. The New Task wizard ends when you 
set the timing of the task. You can reschedule tasks.

If the directions of manually driven and scheduled activities conflict, VirtualCenter 
performs whichever activity is due first. If a virtual machine is in an incorrect state to 
perform any activity, manually or scheduled, VirtualCenter sends a message to the log 
and does not perform the task.

When you create a scheduled task, VirtualCenter verifies that you have the correct 
permissions to perform the actions on the relevant farms, hosts, and virtual machines. 
Once the task is created, the task is performed even if the you no longer have 
permission to perform the task.

When an object is removed from VirtualCenter, all associated tasks are also removed.

Events are logged to the event log at start and completion of the tasks. Any errors that 
occur during the task are also recorded in the event log. Refer to Working with Alarms 
and Events for additional information on the events log.

Note: Do not schedule multiple tasks to be performed at the same time on the same 
object. The results are unpredictable.
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Creating a Scheduled Task
To create a scheduled task:

1. From the VirtualCenter client, display the Tasks panel.

Click the Scheduled Tasks option in the navigation bar.

The current list of scheduled tasks appears.

2. Start the New Task wizard. 

Click New in the toolbar or select File > New > Scheduled Task.

3. Confirm continuing with the New Task wizard. Click Next.

4. Select the task to create.

Click the pull-down menu and select the appropriate option. Click Next.

5. Complete the task specific information.

The New Task wizard displays a series of screens that correspond to the screens 
you see when you perform the task starting from the selected object. The 
possible tasks that can be scheduled through the New Task wizard are:

• Deploy a virtual machine from a template

• Clone an existing virtual machine

• Change the power status of a virtual machine

• Migrate a virtual machine

• Migrate a virtual machine with VMotion

• Change resource settings of a virtual machine
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Refer to the chapter that is appropriate for each option for specific information 
on each task. Most of the scheduling processes differ from manually performed 
tasks only in that you must specify the virtual machine, host, or farm to which 
the task applies, and specify the time to perform the task.

6. Specify the timing of the task.

Note: Only one timing schedule can be set per task. To set more than one 
frequency type, set up additional tasks. 

The default frequency and scheduled time is Now. The task starts when you 
finish creating the task. 

Note: The time a scheduled task occurs is relative to the VirtualCenter server 
and not the local VirtualCenter client from which you configure the task.
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7. To schedule a one-time occurrence: 

Set the Frequency to Once. Set the Start Time to Later. Type a clock time in the 
Time field. View the calendar, click on the Date arrow. Click the left and right 
arrows to view additional months. Click the month and select from the list. Click 
the year, and click the up and down arrows. When you click the calendar date, 
the calendar accepts the changed date and closes.

Note: The frequency time is relative to the VirtualCenter server and not to the 
client.

8. To run the task after startup: 

Click After Startup and enter the amount of the delay.
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9. To run the task hourly: 

Click Hourly. Then enter the start time after the beginning of the hour and the 
interval, for example 15 minutes after every eight hours.

10. To run the task daily: 

Click Daily. Then enter the start time and interval. For example, enter 14:30 every 
fourth day to run the task at 2:30 pm every four days.
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11. To run the task weekly: 

Click Weekly. Then enter the start time, day of the week, and interval. For 
example, Tuesdays and Thursday, 8:00 am, every second week. You can select 
multiple days of the week.

12. To run the task monthly: 

Click Monthly. Then enter the start time, day of the month, and interval. For 
example, enter second Thursday of the month, 11:00 every third month. 

If you select a day higher than 28, a warning message displays since some 
months are 28, 29, 30 or 31 days.

The last <day> of the month selects the last week in the month that the day 
occurs. If you select the last Monday of the month, and the month ends on a 
Sunday, the last Monday will be six days before the end of the month.
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13. Optionally, enter an e-mail address.

If you enter an e-mail address, VirtualCenter sends a notification message to the 
addressee when the task is performed.

Note: You must configure the SMTP options for this email option to work. Refer 
to Preparing for Email Message SMTP Alarm Notification on page 384.

14. Complete the wizard. Click Finish.

VirtualCenter adds the task to the list in the Scheduled Tasks tab.
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Rescheduling a Task
To reschedule a scheduled task:

1. From the VirtualCenter client, display the Tasks panel.

Click the Tasks option in the navigation bar.

The list of scheduled tasks appears.

2. Select the appropriate task form the list. 

Click Properties in the toolbar or select Edit > Properties.

3. Display the date and time, as appropriate. 

Click in the Time field to change the time. Click the date field arrow to display the 
calendar. Select the appropriate date and time. Click Finish.

Refer to Creating a Scheduled Task for more information on working with the 
calendar. 

VirtualCenter closes the calendar and returns to the Scheduled Task display. The 
task is updated with the new date and time.
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Removing a Scheduled Task
Removing a scheduled task removes all future occurrences of the task. The history 
associated to all previous executions of the task remain in the VirtualCenter database.

Note: Removing a task is different than cancelling a task. Cancelling a task is 
stopping a task currently occurring, whether started manually or through a schedule 
task. Removing a task removes future occurrences of a scheduled task.

To remove a task that as been scheduled:

1. From the VirtualCenter client, display the Tasks panel.

Click the Scheduled Tasks option in the navigation bar.

The list of scheduled tasks appears.

2. Select the appropriate task from the list. Select Edit > Remove. Or, right-click the 
appropriate task and select Remove.

VirtualCenter removes the task the scheduled task list.

3. Verify you want to remove the task. Click OK.

The task is deleted from the list of tasks.
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Cancelling a Scheduled Task
Only tasks that are in process can be cancelled. And only selected tasks can be 
cancelled while in process. 

Note: The cancelling operation is not allowed if one or both of the hosts involved is 
an ESX Server version 2.0.1.

Note: Cancelling a task is different than removing a task. Cancelling a task is stopping 
a task currently occurring, whether started manually or through a schedule task. 
Removing a task removes future occurrences of a scheduled task.

The tasks that can be cancelled once started are:

• Connecting to a host

• Cloning a virtual machine

• Migrating a virtual machine

• Deploying a template

• Importing a virtual machine, (only when a file copy is included)

• Creating a template from a virtual machine

• Cloning a template

To cancel a task that is currently running:

1. From the VirtualCenter client, display the Inventory panel.

Click the Inventory option in the navigation bar.

2. View the Active System Tasks panel.

Click the Show toggle at the bottom right of the Inventory panel.

3. Select the appropriate task from the list. 

4. Cancel the task. 

Right-click on the task and select Cancel.

VirtualCenter stops progress on the task, returns the objects to their previous 
states, and displays the task as cancelled.
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Working with Alarms and Events
This chapter describes how to create and edit alarms, and how to view events. Events 
are messages that report VirtualCenter activity. Alarms are notifications that occur in 
response to selected events. Events are predefined by VirtualCenter. 

You must have the role of VirtualCenter Administrator privileges to work with alarms. 
You need only the role of Read Only User to view events.

This chapter contains the following sections:

• Events and Alarms Overview on page 378

• Working with Events on page 379

• Working with Alarms on page 383
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Events and Alarms Overview
View the events, alarms, and logs from three locations:

• Events panel — Displays all the events generated throughout VirtualCenter.

• Events tab in the inventory panel — Displays the events for the selected 
VirtualCenter object. Events are not applied to groups. This is a subset of the list 
of messages in the Events panel.

• Alarms tab in the inventory panel — Displays the list of alarms for the selected 
VirtualCenter object that are activated upon designated events. Alarms can 
apply to groups, farms, hosts, and virtual machines. 
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Working with Events
An event is any action that is of interest to VirtualCenter. Each event triggers an event 
message. All event messages are archived in the VirtualCenter database. View event 
messages from two locations:

• The Events option in the navigation bar displays all events that have occurred on 
the VirtualCenter server. 

• An Events tab for any object under the Inventory option. These Events tab 
listings show only the events that occurred on or to the selected farm, host, or 
virtual machine. 

The most recent events appear at the end of a scrollable list. Messages are identified 
by type: Information, Error, or Warning. Messages are also color coded. A shortened 
event message appears in the description portion of the panel. An more detailed 
version of a selected event message appears in the Event Details portion of the panel. 
Typically, the Event Detail entry indicates the host or virtual machine on which the 
event occurred and describes the action that occurred. The object of the event is a 
link to the object’s individual event page.

The actions available with Events are described in the following sections:

• Viewing All VirtualCenter Events

• Viewing Selected VirtualCenter Events

• Sorting Event Messages

• Exporting Events
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Viewing All VirtualCenter Events
To view all VirtualCenter events: click the Events option in the navigation bar.

Viewing Selected VirtualCenter Events
Each VirtualCenter object in the inventory panel has an Events tab in the information 
panel. Each event that appears is an object-specific subset of all the VirtualCenter 
events. 

To view the event messages and event detail for an object:

1. From the VirtualCenter client, display the inventory panel and expand the 
appropriate farm.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate virtual machine.

2. Select the object for which you want to view events.

In the inventory panel, select a virtual machine, host, or farm, as appropriate. If 
you select a host, the event messages for all the virtual machines on that host 
are included in the Event log.

3. Display the Events log. Click the Events tab.

4. View an event detail. Click on the event.
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A full text message with links to related objects appears in the Event Details box.

5. Link to a message object.

Click any of the blue highlighted items in the Events Details box. VirtualCenter 
displays the Events tab of the highlighted object.

Sorting Event Messages
Sort all lists by clicking in the column label heading. A triangle in the column head 
shows the sort order as ascending or descending. 

To sort a list: Click on a column heading to re-sort the list by the entries in that 
column. The current selection does not change. 

To change ascending or descending order: Click the triangle in the column 
heading.

To select items in a list: Click on an individual item. Use Shift-click or Ctrl-click to 
select multiple items. 
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Exporting Events
VirtualCenter provides an option for exporting your events log file. 

To export the events file:

1. From the VirtualCenter client, open the VirtualCenter Export Events dialog box.

Select File > Export Events.

2. Specify the range of messages and the type of messages to export.

a. Specify a File name and location for the exported file.

b. Indicate how far back from the current date and time to select the messages 
to export by selecting the appropriate Time radio button. 

c. Indicate the type of event message to include in the exported file by selecting 
the appropriate Type radio button.

d. Click OK.

VirtualCenter makes a text file of the selected data and stores the file at the 
specified location. The file contains Type, Time, and Description.
www.vmware.com382



C H A P T E R  1 6  Working with Alarms and Events
Working with Alarms
Alarms send notification messages when selected events occur to or on hosts or 
virtual machines. Alarms indicate the status levels of an object, or collection of objects, 
in the hierarchy. Alarms can be defined at all hierarchical levels, including farms, 
groups, hosts and virtual machines. 

Alarms are inherited from parent levels, and cannot be changed or overridden at a 
child level. Add new alarms to any object, and contribute to the collection of alarms 
that are in force at any of its child levels. 

When an alarm is created, VirtualCenter verifies the user permissions to perform the 
actions on the relevant farms, hosts, and virtual machines. Once the alarm is created, 
the alarm is performed even if the creating user no longer has permission to create 
the alarm.

Alarms are applied to either hosts or virtual machines. Each alarm has a triggering 
event and a notification method.

There are two kinds of alarm triggers:

• Percentage — Monitors host CPU usage, host memory usage, virtual machine 
CPU usage, virtual machine memory, and virtual machine heartbeat

The triggering options are: Is Above (percent) and Is Below (percent). Default 
monitor for virtual machine heartbeat is set to Is Below. Default monitor for all 
other percentage options is set to Is Above.

• State — Monitor host state and virtual machine state

The triggering options are: Is (state) and Is Not (state)

There are several types of alarm notification methods:

• Send a notification email message 

SMTP sends an email message. The SMTP must be ready when the email 
message is sent. There are two ways to set SMTP: through VirtualCenter, or 
through Microsoft Outlook Express. The VirtualCenter setup is not always 
needed if the SMTP setting in Outlook Express is correct. 

The VirtualCenter server generates the subject and body text of the email 
message. Only the To list (receiver) is required from user input. Specify the email 
message address where the message should be sent. Separate the names of 
multiple receivers with commas or semi-colons.
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• Send a notification trap

The VirtualCenter server is the default SNMP notification receiver. An SNMP trap 
viewer is required to view a sent trap. The VirtualCenter server host must be 
configured to receive SNMP traps.

• Run a script 

The user script command and its arguments need to be formatted into one 
string.

The user script is running as separate process and does not block the 
VirtualCenter server processes. But the script does run and consume the 
resources on the VirtualCenter server machine, such as CPU and memory.

• Suspend the virtual machine

• Power off the virtual machine

• Reset the virtual machine

The actions available with alarms are described in the following sections:

• Preparing for Email Message SMTP Alarm Notification

• Preparing for SNMP Alarm Notification

• Creating Alarms

• Editing Alarms

• Removing Alarms

Preparing for Email Message SMTP Alarm Notification
If you are going to use email message to send SMTP notification, you need to:

• Define the SMTP and email message addressing information. 

• Specify the email message address for those to receive the notification when 
you create the alarm.

To define the SMTP and email message addressing information:

1. From the VirtualCenter client, display the VirtualCenter Settings, Advanced tab 
dialog box. 

Select File > VirtualCenter Settings > Advanced tab.
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2. Enter the SNMP and mail addressing, as appropriate. Click OK.

For email message notification set the SMTP server, SMTP port, and email 
message sender. 

• mail.sender — The email message address of sender, for example, 
mail_server@datacenter.com

• mail.smtp.server — The DNS name or IP address of the SMTP gateway to use 
for sending email message.

• mail.smtp.port — The port number for the SMTP gateway. 

If the port value is empty, VirtualCenter uses the default port. The default port 
is 25.

Scroll through the Advanced tab options. Enter data into the fields. Click OK.

Preparing for SNMP Alarm Notification
To use SNMP traps, you must configure:

• The VirtualCenter server host.

• The SNMP receiver server to accept the traps from VirtualCenter.

When you create an alarm, only one trap is triggered and sent. The alarm parameters 
include:

• Type — The state VirtualCenter is monitoring for the alarm. Options include: 
Host CPU usage, Host Memory Usage, Host State, Virtual Machine CPU usage, 
Virtual Machine Memory Usage, Virtual Machine State, Virtual Machine 
Heartbeat

• Name — The name of the host or virtual machine that triggers the alarm.

• Old Status — The alarm status before the alarm was triggered.
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• New Status — The alarm status when the alarm is triggered.

• Object Value — The object value when the alarm is triggered.

To define the SNMP information:

1. From the VirtualCenter client, display the VirtualCenter Settings, Advanced tab 
dialog box. 

Select File > VirtualCenter Settings > Advanced tab.

2. Enter the SNMP and mail addressing, as appropriate. 

Configure up to four receivers of SNMP traps. They must be configured in 
numerical order, 1, 2, 3, and 4. Each SNMP trap requires a corresponding host 
name, port and community. For example:

• snmp.reciever.1.name — The DNS name, and IP address of the SNMP 
receiver.

• snmp.reciever.1.port — The port number of the receiver.

If the port value is empty, VirtualCenter uses the default port. The default port 
is 162.

• snmp.reciever.1.community — The community identifier.

Scroll through the Advanced tab options. Enter the data into the fields. Click OK.
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Using MIBs with Your SNMP Traps
VirtualCenter allows you to configure SNMP traps for alarm notification of events 
occurring in VirtualCenter. Though do continue to use your GSX Server or ESX Server 
MIBs for host related alarms.

The traps defined here are sent typically to other management programs. These 
management programs need to know how to interpret the SNMP traps sent by 
VirtualCenter. 

To configure your management program to interpret VirtualCenter SNMP traps:

1. Download the management information base (MIB) definitions. 

• VMWARE-ROOT-MIB.mib

• VMWARE-TRAPS-MIB.mib

The MIB definition files can be found at: /www.vmware.com/support/vc

2. Modify your management program to include and interpret the VMware MIBs.

Refer to your management program documentation for information on adding 
MIB definitions to your program.

SNMP Trap and Variable Definitions
There are two groups of SNMP MIB definitions. These can be downloaded for your use. 
Refer to Using MIBs with Your SNMP Traps on page 387.

The VMware enterprise tree is at 
.iso.dod.org.internet.private.enterprises.vmware. 
(.1.3.6.1.4.1.6876.). 

The tree consists of several groups. The SNMP traps are at 
1.3.6.1.4.1.6876.50.301 and labeled vpxdTrap. System uptime is 
measured in ticks.  

 Identification Map Labels

1.3.6.1.2.1.1.3.0 System up time = ticks

1.3.6.1.6.3.1.1.4.1.0 Trap name = 1.3.6.1.4.1.6876.50.301 = vpxdTrap

1.3.6.1.6.3.1.1.4.3.0 Enterprise = 1.3.6.1.4.1.6876 = vmware
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The table below lists the identification mapping for each VirtualCenter MIB group.  

The following tables describe the VMware SNMP MIB root and primary subtrees. 
Currently each subtree has its own MIB file. The tables list the variables used in the 
SNMP Trap groups. 

From VMWARE-ROOT-MIB.mib the following definition mapping. 

From VMWARE-TRAPS-MIB.mib, the following trap types. 

Identification Map Label

1.3.6.1.4.1.6876.50.301 vpxdTrap Type

1.3.6.1.4.1.6876.50.302  vpxdHostName

1.3.6.1.4.1.6876.50.303  vpxdVMName

1.3.6.1.4.1.6876.50.304  vpxdOldStatus

1.3.6.1.4.1.6876.50.305  vpxdNewStatus

1.3.6.1.4.1.6876.50.306  vpxObjValue

Label Identification Mapping

vmware              enterprises 6876

vmwSystem          vmware 1 

vmwVirtMachines     vmware 2 

vmwResources       vmware 3 

vmwProductSpecific  vmware 4 

vmwTraps            vmware 50 

vmwOID              vmware 60 

vmwExperimental     vmware 700 

Trap Label Description Variables

vmPoweredOn This trap is sent when a virtual 
machine is powered ON from a 
suspended or a powered off 
state.

vmID, vmConfigFile

vmPoweredOff This trap is sent when a virtual 
machine is powered OFF. 

vmID, vmConfigFile
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The following tables describe the variables and parameters used in the VMware 
VirtualCenter defined SNMP traps. 

Note: All variables are read-only. The data type field refers to the SNMP version 1 
type described by the structure of management information (SMI). And all variables 
and parameters are mandatory.

vmHBLost This trap is sent when a virtual 
machine detects a loss in guest 
heartbeat.

vmID, vmConfigFile

vmHBDetected This trap is sent when a virtual 
machine detects or regains the 
guest heartbeat. 

vmID, vmConfigFile

vmSuspended This trap is sent when a virtual 
machine is suspended. 

vmID, vmConfigFile

vpxdTrap This trap is sent when entity 
status changed.

vpxdObjValue, vpxdNewStatus, 

vpxdOldStatus, vpxdVMName, 

vpxdTrapType, vpxdHostName

Variable Description Syntax

vmID This is the ID of the affected virtual machine generating 
the trap. If the vmID is non-existent, (such as for a 
power-off trap) -1 is returned.

INTEGER 

vmConfigFile This is the configuration file of the affected vm 
generating the trap.

DisplayString 

vpxdTrapType This is the trap type in the preceding traps. DisplayString 

vpxdHostName This is the name of the host in the preceding traps. DisplayString 

vpxdVMName This is the name of the VM in the preceding traps. DisplayString

vpxdOldStatus This is the old status in the preceding traps. DisplayString 

vpxdNewStatus This is the new status in the preceding traps. DisplayString 

vpxdObjValue This is the current object value in the preceding traps. DisplayString

Trap Label Description Variables
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Creating Alarms
If you are going to use email message or SNMP notification, refer to Preparing for 
Email Message SMTP Alarm Notification and define the address information before 
you create your alarm.

To create an alarm:

1. From the VirtualCenter client, display the inventory panel and expand the 
appropriate object.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate object.

2. Display the alarm properties. 

Select the object on which you want to apply the alarm. 

3. Enter the alarm general information.

Specify a name for the alarm, the object to be monitored (host or virtual 
machine), and whether to enable this alarm. 
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To define the alarm, but not have it active, uncheck the Enable box.

Click OK.

4. Specify the triggering parameters for the alarm.

There are two kinds of triggers:

• Percentage — Monitors host CPU usage, host memory usage, virtual 
machine CPU usage, virtual machine memory, and virtual machine heartbeat

The triggering options are: Is Above (percent) and Is Below (percent). Default 
monitor for virtual machine heartbeat is set to Is Below. Default monitor for all 
other percentage options is set to Is Above.

• State — Monitor host state and virtual machine state

The triggering options are: Is (state) and Is Not (state)

a. Click the Triggers tab. 

b. Using the pull-down menus, indicate the type and condition of the state.

c. Optionally, define multiple conditions for the alarm triggering event. Click 
Add. Enter the parameters for each condition. 

d. Click OK.
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5. Specify the action to be taken when the alarm is triggered.

a. Click the Actions tab.

b. Select a transition state at which to notify. 

Select at which transition state the alarm should be triggered. For example, 
select to trigger the alarm when the CPU usage transitions from a 15% yellow 
state to a 5% red state, as defined in the Triggers tab, and cause the alarm to 
suspend the virtual machine. 

c. Click the appropriate check box. 

There are four different level changes: green to yellow, yellow to red, red to 
yellow, and yellow to green. Attach an action for each level change. 

d. Select a notification type and provide related information.

Click Add to add as many notifications as needed. The notification options are:

• Send an email message.

Provide the email message address for the notification recipient.

SMTP sends an email message. The SMTP must be ready when the email 
message is sent. There are two ways to set SMTP: through VirtualCenter, or 
through Microsoft Outlook Express. VirtualCenter setup is not always needed 
if the SMTP setting in Outlook Express is correct. 

VirtualCenter server generates the email message subject and body text. Only 
the “to” list (receiver) is required from user input. Specify the email message 
address to which the message should be sent. Separate multiple receivers 
with commas or semi-colons.

• Send a notification trap.
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There is a default SNMP notification receiver, the VirtualCenter server. An 
SNMP trap viewer is required to view a sent trap. The VirtualCenter server host 
must be configured to receive SNMP traps.

• Run a script.

Provide the path to the script to run.

The user script command and its arguments need to be formatted into one 
string.

The user script is running in other process and does not block the 
VirtualCenter server from running. But the script does consume the resources 
on the server, such as CPU and memory.

• Suspend the virtual machine.

This applies to a virtual machine alarm. 

• Power off the virtual machine.

This applies to a virtual machine alarm. 

• Reset the virtual machine.

This applies to a virtual machine alarm. 

e. Complete the alarm. Click OK.

VirtualCenter verifies the configuration of the alarm and adds the alarm to the 
list of alarms for the selected object.
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Editing Alarms
To edit an existing alarm:

1. From the VirtualCenter client, display the inventory panel and expand the 
appropriate object.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed,.

2. Identify and select the object where the alarm is defined.

a. Select an object where the alarm is applied.

b. Display the Alarms list. Click the Alarms tab.

c. Click the linked object in the Defined in column.

VirtualCenter displays the Alarms panel for the object where the alarm was 
defined.

3. Display the alarm properties. 

The entry in the Defined in column for the alarm must be This Object. 
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Select the alarm to edit. Select Properties from either the main or right-click 
menu.

4. Edit the alarm general information, as needed. Click OK.

VirtualCenter verifies the configuration of the alarm and edits the alarm in the list 
of alarms for the selected object.
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Removing Alarms
Remove alarms from the object in which they were defined. You cannot remove them 
from a child level. 

To remove an alarm:

1. From the VirtualCenter client, display the inventory panel and expand the 
appropriate object.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed,.

2. Identify and select the object where the alarm is defined.

a. Select an object where the alarm is applied.

b. Display the Alarms list. Click the Alarms tab.

c. Click the linked object in the Defined in column.

VirtualCenter displays the Alarms panel for the object where the alarm was 
defined.

3. Remove an alarm.

Select the alarm and click Remove from the right-click menu. 
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Click Yes to confirm removing the alarm.
397



VMware VirtualCenter User’s Manual
www.vmware.com398



C H A P T E R 17

Working with the VirtualCenter 
Data
This chapter describes the scope of the VirtualCenter data presented in the 
VirtualCenter client. This chapter describes the display of current data. This chapter 
contains the following topics:

• VirtualCenter Data Overview on page 400

• Viewing Navigation Bar Scheduled Tasks on page 403

• Viewing Navigation Bar Templates on page 405

• Viewing Navigation Bar Events on page 406

• Viewing Navigation Bar Inventory on page 408

• Understanding the Summary Tabs on page 410

• Viewing the Farms Tab on page 415

• Viewing the Hosts Tab on page 417

• Viewing the Virtual Machines Tab on page 418

• Viewing the Events Tab on page 421 

• Viewing the Alarms Tab on page 422
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• Viewing the Permissions Tab on page 423

• Viewing the Console Tab on page 424

• Viewing the Performance Tab on page 425

VirtualCenter Data Overview
Access the general display of data and activity through the information panel. The 
information panel is the visual center of your VirtualCenter monitoring activities. 
Through the information panel, view status, resource usage, and performance 
information about your hosts, virtual machines, and farms. View scheduled tasks, 
available templates, and a list of events.

When an object is removed from VirtualCenter inventory, its log and event history 
remains until purged through the normal processes.

This information in one of two sets of panels. 

• Navigation bar — Provides shortcuts to generalized areas of related activities. 
The options are: Inventory, Scheduled Tasks, Templates, and Events.

The Scheduled Tasks, Templates, and Events options display a single information 
panel. The Inventory option displays an inventory panel or an information panel. 
The Inventory information panel displays a set of tabs. The displayed tabs 
depend upon the object you select in the inventory panel. 

When you select any other navigation bar, the information panel appears. 

• Inventory tabs — A subset of the Inventory option. The Inventory tabs are a set 
of panels that display task oriented information pertaining to the selected 
VirtualCenter object. Each VirtualCenter object has its own set of tabs. The tab 
options are: Summary, Farms, Hosts, Virtual Machines, Performance, Events, 
Alarms, Console, and Permissions.

When you select the Inventory option in the navigation bar, an information 
panel appears on the right side of the screen. When you select an object, (host, 
virtual machine, group, or farm) from the inventory panel, the information panel 
displays tabs corresponding to the selected object. This data appears until you 
select a different object from the inventory panel. 

The following table shows the available panels and their source mapping. Note that 
you can use either the navigation bar and the information panel tabs to view events 
information.
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Each navigation bar has a primary information panel and associated tab. The 
Inventory option has an inventory panel from which you can select objects. Each 
selected object has its own set of associated information panel tabs. The following 
table lists the possible tab views for each VirtualCenter object.

Panel Source Description

Alarms Inventory panel Lists the configured alarms for the selected object. 

Console Inventory panel Displays a remote console to interact directly with the virtual 
machine. Through the remote console you can take selected 
actions upon the virtual machine.

Events navigation bar Lists the recent event messages for all objects managed by 
VirtualCenter. 

Events Inventory panel Lists the recent event messages that report on the status of 
the selected object. 

Farms Inventory panel Lists the farms assigned to the selected farm group.

Hosts Inventory panel Lists the hosts assigned to the selected farm.

Inventory navigation bar Provides access for managing all the Server Farms entities.

Performance Inventory panel Displays the performance charts for the selected host or virtual 
machine resources. The charts for farms and hosts display 
combined charts that show the usage of each resource.

Permissions Inventory panel Lists the users and groups that have permissions on the 
selected object and at what level the permission was assigned.

Summary Inventory panel Displays a collection of data for the selected object.

Scheduled Tasks navigation bar Provides access for managing scheduled tasks.

Tasks Inventory panel Lists the all tasks for the selected object. 

Templates navigation bar Provides access for managing templates.

Virtual Machines Inventory panel Lists the virtual machines assigned to the selected farm or 
host.

Inventory 
Object

Summary Farms Virtual Machines Hosts Performance Tasks Events Alarms Console Permissions

Server Farms Farms Virtual Machines Hosts Tasks Events Alarms Permissions

Farm Group Farms Virtual Machines Hosts Tasks Events Alarms Permissions

Farm Summary Virtual Machines Hosts Performance Tasks Events Alarms Permissions

Host Summary Virtual Machines Performance Tasks Events Alarms
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Virtual 
Machine 
Group

Virtual Machines Performance Tasks Events Alarms Permissions

Virtual 
Machine

Summary Performance Tasks Events Alarms Console Permissions

Inventory 
Object

Summary Farms Virtual Machines Hosts Performance Tasks Events Alarms Console Permissions
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Viewing Navigation Bar Scheduled Tasks
The Scheduled Tasks option in the navigation bar displays the tasks that are 
scheduled to be performed, and provides a means for you to create and edit 
scheduled tasks. 

Navigation Bar > Scheduled Tasks Button

The scheduled task activities include:

• Create new task

• Edit the task properties
403



VMware VirtualCenter User’s Manual
The type of scheduled tasks that can be created through the New Task wizard include:

• Deploy a virtual machine from a template

• Clone an existing virtual machine

• Change the power status of a virtual machine

• Migrate a virtual machine

• Migrate a virtual machine with VMotion

• Change resource settings of a virtual machine

For more information on scheduled tasks, refer to Working with Scheduled Tasks on 
page 365. The table below lists the possible attributes that appear in a Scheduled 
Tasks panel list.

List Attribute Description

Description VirtualCenter object where the setting was made

Last Run Date and time the task was last performed

Next Run Date and time the task is to be performed next
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Viewing Navigation Bar Templates
The Templates option in the navigation bar displays the list of available templates and 
provides the means to deploy, create, and clone new templates. 

Navigation Bar > Templates Button

The template activities include:

• Create a new template

• Deploy a template (create new virtual machine)

• Clone a template

For more information on template, refer to Working with Templates on page 245. The 
table below lists the possible attributes that appear in the Template panel list.

List Attribute Description

Name Name of template

Guest OS Guest operating system in the virtual machine

Size Size of the template, in MB

Datastore Indicates if the template is on a shared datastore

Description Text entered for reference
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Viewing Navigation Bar Events
An event is any action that is of interest to VirtualCenter. Each event triggers an event 
message. All event messages are archived in the VirtualCenter database. Event 
messages appear in two locations:

• Events option in the navigation bar — Displays all events that have occurred 
on the VirtualCenter server. 

• Events tab for an object under the Inventory option — List the events that 
occurred on or to the selected object. 

Navigation Bar > Events Button

Events activities include:

• Sorting the list of event messages.

• Viewing the event details for a selected message. 

• Linking to the Events tab of an object in an Event Detail message.

• Exporting events to a text file. The exported data can be a set of messages 
selected by time, date, and type.
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For more information on events, refer to the chapter, Working with Alarms and Events 
on page 377. The table below lists the possible attributes that can be displayed in an 
Events panel list.

List Attribute Description

Description Text explanation of action

Type Type of event that occurred

Time Time event occurred

Task Task that triggered the event, if there is one

Target Object the event occurred on
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Viewing Navigation Bar Inventory
The Inventory option in the navigation bar displays an inventory panel and an 
information panel. Each object in the inventory panel displays a particular set of tabs 
in the information panel. The remainder of this chapter describes each of the 
Inventory tab panels. 

The navigation bar topics are covered in the following sections:

• Understanding the Inventory Panel

• Understanding the Information Panel

Understanding the Inventory Panel
The inventory panel is located on the left side of the screen when you select the 
Inventory option in the navigation bar. The inventory panel elements include:

• Hierarchical listing of VirtualCenter server objects.

• Status icons associated with each object.

• Toggle to close or open the inventory panel.

• Popup menu bar for close, dock, and float options. 

The root of the inventory panel is a top-level group labeled Server Farms. All farms, 
groups, hosts, and virtual machines fall within the Server Farms group. All of these 
items are added to the VirtualCenter server through the VirtualCenter client.

Depending upon your user permissions, you may be able to see but not expand a 
farm or group. You must be assigned the appropriate permissions levels before you 
can view and take action upon objects managed by VirtualCenter.
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Understanding the Information Panel
The information panel is the visual center of your VirtualCenter monitoring activities. 
Through the information panel you:

• View status, resource usage, and performance information about your hosts, 
virtual machines, and farms. 

• View scheduled tasks, available templates, and a list of events.

Select any button in the navigation bar or any object in the inventory panel and the 
corresponding information panel appears. Select the Inventory option in the 
navigation bar and the information panel appears to the right side of the inventory 
panel. Use the docking option in the inventory panel menu, to place the information 
panel on the left side of the screen. 

The information panel elements are:

• Toolbar — specific to each navigation button

• Tabbed panel — for all but the Inventory button, lists in column form, all the 
objects that apply to the navigation button. For the Inventory button, there are 
multiple tabbed panels that vary depending upon the object selected in the 
inventory panel. 

• Identification line — displayed with the Inventory button only, it lists the name 
and if relevant the version level of the object selected in the inventory panel.
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Understanding the Summary Tabs
The Summary tab is available when you select a farm, host, or virtual machine object 
from the inventory panel. The Summary tab information panel is grouped into 
sections, depending upon the object type selected. 

The Summary tab topics are covered in the following sections:

• Viewing the Farm Summary Tab

• Viewing the Host Summary Tab

• Viewing the Virtual Machine Summary Tab
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Viewing the Farm Summary Tab
The farm Summary tab displays information that applies to the hosts and virtual 
machines within the farm. 

Inventory > Farm > Summary Tab

The farm Summary tab content is described in the following table. 

Section Field Description

Identification Total Hosts Number of hosts on the farm.

Disconnected Hosts Number of disconnected hosts on the farm.

Total Virtual Machines Number of virtual machines on the farm.

Disconnected Virtual Machines Number of disconnected virtual machines on the farm.

VMs Powered On Number of virtual machines in a powered on state.

VMs Suspended Number of virtual machine in a suspended state.

Total VMs Provisioned Number of virtual machines that have been created by either cloning or 
deploying a template.

Total VM Migrations Number of times virtual machines that have been migrated between host 
machines.

View tables for CPU, Disk, Memory, Network The resource whose data you wish to see.

Hot List Most active hosts — Least active hosts Where the hosts fit, relative to the critical ends of the range. 

Resource Contention all hosts Percentage of time any host was in contention.

Resource Volatility all hosts Percentage change in host utilization in the past seven days.
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Viewing the Host Summary Tab
The host Summary tab displays information that applies to the host machine and its 
resources. 

Inventory > Host > Summary Tab

The host Summary tab content is described in the following table.

Section Field Description

Identification Manufacturer Manufacturer of the host machine.

Model Model type of the host machine.

Total Memory Memory installed in the host machine.

Processor Manufacturer, type, and speed of CPU.

VMotion Enabled Whether or not the host machine is licensed for VMotion.

Number of Virtual Machines Number of virtual machines currently located on the host machine.

Number of Processors Number of processors installed in the host machine.

Number of NICs Number of NICs installed in the host machine.

Active Tasks Indicates if at least one task is occurring on object currently.

Commands Manage Virtual Machine 
Resources

The Virtual Machine Resources panel for adjusting the resource allocation for virtual 
machines on the host. Available for ESX Server hosts only.

Edit Properties The virtual machine Properties panel.

Edit Host Configuration Opens a Web browser to connect to the VMware Management Interface. Requires that 
you log on.
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Shut Down Displays a menu to shut down or restart the host. Starting the host is not available. 

Available Resources Available Disk Space Free disk space on all datastores available to the host machine.

Memory Available to New VMs Unreserved memory on the host machine.

CPU Usage Virtual Machine Percentage of CPU used by running virtual machines.

Other Percentage of CPU used for other purposes.

System Total Total percentage of CPU used on the host machine.

Memory Usage Virtual Machine Percentage of memory used by running virtual machines.

Other Percentage of memory used for other purposes.

System Total Total percentage of memory used on the host machine.

Networks List of networks accessible by the host machine.

Datastores List of datastores accessible by the host machine.

Section Field Description
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Viewing the Virtual Machine Summary Tab
The virtual machine Summary tab displays information that applies to a virtual 
machine and its resources.

Inventory > Virtual Machine > Summary Tab

The virtual machine Summary tab content is described in the following table. 

Section Field Description

Identification Hosted on Host where virtual machine is currently located.

Status Condition status of the virtual machine. options: Alert (red), Warning (yellow), or OK (green).

State Power state of the virtual machine. options: Powered on, Powered Off, or Suspended.

Active Tasks Transition status of any running task.

Guest OS Operating system installed in the virtual machine.

IP Address Primary IP address assigned to this virtual machine.

DNS Name DNS name assigned to this virtual machine, if any.

VMware Tools Indicates if VMware Tools are installed and/or current.

Commands Power Off/Suspend/Reset/
Power On this virtual machine

Powers Off/On, Resets, or Suspend/Resumes the virtual machine now.

Edit Properties Opens the Virtual Machine Properties dialog box for editing the configuration.

Open Console Opens the virtual machine Console. Screen black if the virtual machine is not powered on.

Migrate to New Host Opens the Migration Wizard.

Create Template Opens the Create a Template Wizard. Available when virtual machine is powered off.

Clone this Virtual Machine Opens the Clone a Virtual Machine Wizard. Available when virtual machine is powered off.

Devices Installed and/or configured devices. Minimum: Memory, Hard Disk, CPU, NIC.
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Viewing the Farms Tab
The Farms tab is available when you select a server farm or farm group object from 
the inventory panel of the navigation bar. The Farms tab displays information about 
the farms in the group.

Inventory > Server Farms > Farms Tab
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The Farms tab content is described in the following table. 

List Attribute Description

Name Name of farm in the farm group or Server Farms.

Status Condition of the farm.

Number of VMs Number of virtual machines in the farm group or Server Farms.

Number of Hosts Number of hosts in the farm group.
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Viewing the Hosts Tab
The Hosts tab is available when you select a server farm, farm group, or farm object 
from the inventory panel of the navigation bar. The Hosts tab displays information 
about the hosts in the farm. 

Inventory > Farm > Hosts Tab

The Hosts tab content is described in the following table. 

List Attribute Description

Name Name of host.

State State of host, for example, powered on or connected.

Status Condition of the host.

% CPU Percentage of the CPU being used.

% Memory Percentage of the memory being used.

Memory Size - MB System memory.

CPU Count System CPU Count.

NIC Count Number of NICs.

Uptime Uptime of system.
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Viewing the Virtual Machines Tab
The Virtual Machines tab is available when you select a farm, host, or virtual machine 
group object from the inventory panel of the navigation bar. The Virtual Machines 
tab displays information about the status of virtual machines within the farm, host, or 
virtual machine group selected. The Virtual Machines tab’s panel provides filtering 
capabilities to view only selected virtual machines.

Inventory > Farm > Virtual Machines Tab

The Virtual Machines tab content is described in the following table.

List Attribute Description

Name Name of virtual machine.

State State of virtual machine, such as, powered on or connected.

Status Condition of the virtual machine.

Host Host where virtual machine is currently resident.

% CPU Percentage of the CPU being used.

% Memory Percentage of the memory being used.

Guest OS Guest operating system in the virtual machine.

Memory Size - MB System memory.

CPU Count System CPU Count.

NIC Count Number of NICs.

Uptime Uptime of system.
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IP Address IP address of the virtual machine.

Tools Status VMware tools available.

Path Location of the virtual machine in the inventory.

DNS Name DNS name used on the network.

UUID UUID used on the network to uniquely identify this virtual machine.

List Attribute Description
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Viewing the Tasks Tab
The Tasks tab is available when you select any object from the inventory panel. 
Selecting a task displays to its details in the Task Details field. Click the link in the Task 
Details field to shift the display to the linked object.

The Tasks tab displays a filtered view of the Tasks. It displays either all tasks in the 
VirtualCenter server or only those tasks that occurred on the selected object through 
a toggle. The toggle option state, Show all entries or Show <object> entries, displays 
in the bottom right status bar of the VirtualCenter client.

Inventory > Virtual Machine > Tasks Tab

The Task tab content is described in the following table.

List Attribute Description

Name Name of the task.

Target Object task performed on.

Progress Progress state of the task, if it is in progress.

Status State of complete of the task.

Reason Name of user initiated the task or whether the task was a scheduled task.

Time Time task started.
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Viewing the Events Tab
The Events tab is available when you select any object from the inventory panel. 
Selecting an events displays to its details in the Event Details field. Click the link in the 
Event Details field to shift the display to the linked object.

The Events tab displays a filtered view of the Events. It displays either all events in the 
VirtualCenter server or only those events that occurred on the selected object 
through a toggle. The toggle option state, Show all entries or Show <object> entries, 
displays in the bottom right status bar of the VirtualCenter client.

Inventory > Virtual Machine > Events Tab

The Events tab content is described in the following table.

List Attribute Description

Description Text explanation of action.

Type Type of event that occurred.

Time Time event occurred.

Task Task that caused event.

Target Object event occurred on.
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Viewing the Alarms Tab
The Alarms tab is available when you select any object from the inventory panel of 
the navigation bar. The Alarms tab displays the alarms that have been created for the 
selected object and the status of the alarm. 

Inventory > Host > Alarms Tab

The Alarms tab content is described in the following table.

List Attribute Description

Name Name of object.

Status Condition of the alarm.

Defined in VirtualCenter object where the setting was made.

Defined for VirtualCenter to which the setting applies.

Last triggered Date and time the alarm was most recently triggered.
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Viewing the Permissions Tab
The Permissions tab is available when you select any object from the inventory panel 
except a host. The Permissions tab displays the users and groups with their associated 
permission roles assigned to the selected object.

Inventory > Virtual Machines > Permissions Tab

The Permissions tab content is described in the following table.

List Attribute Description

User/Group Name of user or group assigned the role.

Role The role assigned to the user or group. options: Read Only User, Virtual 
Machine User, Virtual Machine Administrator, and VirtualCenter Administrator.

Defined In The VirtualCenter object where the permission user+role pair is assigned. If it is 
not the current object, a link to the defined in object is displayed.
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Viewing the Console Tab
The Console tab is available when you select a virtual machine object from the 
inventory panel of the navigation bar. The Console tab displays a blank screen when 
the virtual machine selected is not powered on. When the virtual machine is powered 
on, the Console tab displays the running console of the virtual machine. When you 
select the Console tab, a popout version of the console is also available by clicking on 
the Console toolbar button. 

Inventory > Virtual Machine > Console Tab

The Console window provides live access to the virtual machine console from within 
the VirtualCenter client, and allows you to interact with the operations of the virtual 
machine. A detachable virtual machine Console window can be operated 
independently from the VirtualCenter client by selecting the appropriate virtual 
machine from the inventory panel and clicking the Console option in the Inventory 
toolbar. This separate console operates in addition to, not to the exclusion of, the 
embedded console.

The behavior of the VirtualCenter client console is similar to but not an exact duplicate 
of the Remote Console provided with the VMware platform products, such as ESX 
Server or GSX Server. For example, the Quick-Switch mode, (for switching between 
console windows), and the Snapshot and Full Screen options are not included in 
VirtualCenter. The VirtualCenter client console does not provide access to selected 
functions (such as power or configuration operations) of the virtual machine. These 
tasks are handled through the VirtualCenter client.
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Viewing the Performance Tab
The Performance tab is available when you select a farm, host, virtual machine group, 
or virtual machine object from the inventory panel of the navigation bar. 

The Performance tab displays the selected object’s information in graph form. 
Performance views show graphs for four primary attributes: CPU Usage, Memory 
Usage, Net I/O Usage, and Disk I/O Usage. 

Each attribute has a summary graph and one graph per instance of that attribute. For 
example, the CPU Usage attribute has one graph per CPU. Net Usage has one graph 
per NIC. Only one set of attribute graphs is viewable at a time. 

Performance charts for hosts and virtual machines display in two forms: 

• Summary charts — For each host or virtual machine in a farm or group.

• Individual charts — For a selected individual resource sharing the panel with 
thumbnail resource charts for all charted resources: CPU, Memory, NIC, and Disk. 

Performance charts for farms and virtual machine groups display the summary charts 
for each host or virtual machine in their group, respectively.

The Performance tab topics are covered in the following sections:

• Viewing Summary Performance Charts

• Viewing Individual Charts

• Configuring Performance Measurement Intervals

• Configuring the Number of Threads for Collecting Performance Statistics

• Exporting Performance Data
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Viewing Summary Performance Charts
The Performance tab of a farm for a virtual machine group object displays a summary 
chart for each host in the farm or each virtual machine in a virtual machine group.

The summary chart list of the total CPU, memory, disk, and network utilization over a 
selected time range, along with the average utilization over that same time range. 
Clicking on the charts links to the Performance tab of the selected host or virtual 
machine and displays the selected resource as the main chart.

If there are more than four hosts or virtual machines in the farm or virtual machine 
group, then the First, Prev, Next, and Last buttons are available to shift the view to 
additional hosts or virtual machines. 

Inventory > Farm > Performance Tab

The Performance tab content is described in the following table.

List Attribute Description

Name Host or virtual machine name.

CPU Reports the percentage of CPU being used.

Memory Reports the percentage of usage in MBytes. 

Disks Reports the number of bits per second of read and write activity to and from the disk in KBytes per second.

Network Reports the number of bits per second of input and output to each and all network interface (NIC) cards. 

Range Selectable range of time to display in the charts. options include: day, week, month, year.
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Viewing Individual Charts
The Performance tab for hosts and virtual machines displays four thumbnail charts 
and one expanded chart of the monitored resource for each selected host or virtual 
machine. 

The thumbnail charts at the top of the panel are the same as the summary charts. 
Clicking a the summary chart displays an expanded version of that chart in the body 
of the panel. 

Inventory > Host > Performance > CPU Chart

Note: When VirtualCenter server starts, it can take awhile to load the historical statics 
from the database into memory. While the data is loading: the performance charts are 
not viewable; the CPU and memory utilization columns in the Hosts and Virtual 
Machines tabs are empty; and alarms do not fire. All other VirtualCenter functions 
operate normally.

Performance Panel Legend — View or hide the legend for the charts or not by 
toggling the Hide legend button. The legend at the bottom of the panel displays a 
key for: 

• Chart Entries — Maps the line styles to the item they are representing

• Event Indicators — Triangles on the expanded chart indicate when significant 
events occurred for the host or virtual machine. Review the Events panel to 
locate the nature and condition of the event. 
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Performance Panel Range — Adjust the time increment by selecting from the 
Range pull-down menu. 

Customize Chart Dialog — The Customize Performance Chart provides options that 
affect the display of the chart. The chart options differ between hosts and virtual 
machines.

Host customized chart options:

• All resources:

• Total utilization [line chart]

• Total utilization by virtual machine [stacked chart]

This also provides options Show/Granted and a selectable list of virtual 
machines to include in the chart data.

• Disk and network only:

• Total disk/network I/O

• Total disk/network I/O by device 

• Total disk/network I/O by virtual machine [stacked chart]

This option and Individual disk I/O provide an option for Total/Reads/Writes 
and a selectable list of virtual machines to include in the chart data.

• Individual disk/network I/O

This provides and option to specify a device and list the performance data by 
virtual machine.
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Virtual machine chart options:

• Total utilization [line chart] — All devices

• Total disk/network by device [stacked chart] — Disk and Network only

This option and Individual disk I/O provide an option for Total/Reads/Writes and 
a selectable list of virtual machines to include in the chart data.

• Individual disk I/O — Disk only

This provides and option to specify a device in the virtual machine.

Performance Panel Resource Charts
The performance panel displays the usage of the following resources:

• CPU — Chart reports the percentage of CPU being used. Calculated as a 
percentage of shares of the entire CPU availability assigned to the virtual 
machine. 

The CPU chart displays the percentage of combined CPU usage. If there is more 
than one CPU the chart distributes the data based on the combined usage at 
100%. The legend lists the values as a portion of the 100% total.

Note: If multiple virtual machines are sharing the same CPU or memory, the 
usage line might step down or up as additional virtual machines are powered on 
or off. If there is no contention for the CPU or memory, usage is reported as a flat 
line.
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The virtual machine CPU and memory usage chart has several lines on it. One 
each designates the maximum and minimum percentage of the CPU or memory 
allotted. A third line shows the percent usage of the CPU or memory. 

The CPU chart displays the following information

• Usage: Percentage of CPU time used by the virtual machine (or by all virtual 
machines on the host)

• Guarantee: Percentage of CPU time guaranteed to be available to the virtual 
machine (not available on the host chart); value is determined by the min/
max/shares settings of this VM and all VMs currently running on the host

• Memory — Chart reports the memory usage in MBytes. Calculated as a 
percentage of shares of the entire physical plus swap memory on the host 
assigned to the virtual machine. Virtual machine memory maximum and 
minimum usage is configurable. 

The display is one chart per host. This does not include NUMA systems.

The memory chart displays the following information:

• Active: Memory recently used by the virtual machine (or by all virtual 
machines on the host)

• Granted: Memory allocated to the virtual machine (or to all virtual machines 
on the host)

• Disk — Chart reports the amount of read and write activity to and from the disk 
in bytes per second. 

The data is defined by shares of the disk resource per volume. There is no line to 
show the percentage of the disk space read/write usage assigned to the virtual 
machine.

Data is collected on each disk connected to the ESX Server and GSX Server host. 
This tracks the VMFS traffic and access to the network share. For any disk, the 
reported data is relative to the host selected in the inventory panel. Traffic with a 
disk that is due to additional hosts attached to the disk is not included in the 
chart. 

Host data appears in two aggregate charts, one for read activity and one for 
write activity. With VMFS systems, separate charts display volume inbound read 
traffic and volume outbound write traffic. Note logical volumes span partitions. 

Note: Disk charts do not report percentage of occupancy, they do report read/
write activity.

The disk chart displays the following information:
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• Total: Total I/O

• Reads: Disk reads, network traffic received

• Writes: Disk writes, network traffic transmitted

• Network — Chart reports the number of bits per second of input and output to 
each and all network interface (NIC) cards. 

Host aggregate chart reports all the network input and output per host. Network 
input and network output usage are given separate charts reporting the usage 
of the physical NIC based on the configuration of the virtual machines on that 
host.

Virtual machine aggregate chart shows all the input and output activity per 
virtual machine. The detail charts show the activity for each NIC for the virtual 
machine.

The network chart displays the following information:

• Total: Total I/O

• Reads: Disk reads, network traffic received

• Writes: Disk writes, network traffic transmitted
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Configuring Performance Measurement Intervals
Note: Existing performance data is reset (lost) when you change the interval 
configuration. However, only the data for that interval is reset. For example, if you 
change only the weekly time interval, the daily and monthly data are maintained,.

To configure performance intervals:

1. Start VirtualCenter.

2. Open the VirtualCenter Settings dialog and select the Performance tab.

3. Modify intervals and sampling values as needed. Click OK.

Name — the name of the interval. This name is selectable in the Ranges menu 
of the Performance tab.

Minutes per sample — the length of time between each sample taken.

Number of samples — the maximum number of samples that are displayed in 
the Performance tab. As new samples are collected, old samples beyond the 
maximum number are purge from the Performance display, but are kept in the 
database for historical reference.

The charts in the Performance tabs reflects the adjusted values.

Configuring the Number of Threads for Collecting Performance 
Statistics
You can configure multiple statistical refresh threads and distribute their updates over 
time. On an SMP VirtualCenter host, use multiple threads to increase the number of 
managed hosts and take advantage of the additional CPU. On a uniprocessor host 
adjust this value to smooth out CPU usage.
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The number of threads is used for collecting performance statistics from managed 
hosts. The default value is 1, the maximum setting is 8.

To configure number of threads:

1. Start VirtualCenter.

2. Open the VirtualCenter Settings dialog and select File > Advanced menu 
option. 

3. Select the Performance tab in the VirtualCenter Settings dialog box.

4. Modify perf.numThreads value as needed. Click OK.

On SMP hosts, using multiple threads increases the number of managed hosts 
possible by taking advantage of the additional CPUs. On UP hosts it improves 
the CPU utilization.

5. Restart the VirtualCenter server to apply the changes.

Exporting Performance Data
Performance data can be exported to various file types. 

To export performance data:

1. Select File > Report > Performance and Report > Summary.

2. Select a file format type to save out the data.

File options include:

• FormatedFiles.cs -- For large files dealing with the various file formats. 
Currently CSV, Excel/XLS, XML, HTML (with internal/external CSS support), TXT.

• HostSummaryFile.cs -- File for controlling the layout and output of the host 
summaries accessible through the main form.
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• FormExcelOutput.cs -- A dialog box class for configuring various graph 
options for Excel output.

• ExcelGraph.cs - For large files that deals with Querying the VMDB for graphing 
data and then generating an excel graph from it. Includes a Graph class for 
constructing/customizing graphs.

3. For additional formats, select Save from the Export Event dialog.
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Setting Access and Permissions
This chapter describes how to manage access to VirtualCenter managed objects for 
users and groups. This chapter contains the following sections:

• Understanding Users and Groups on page 436

• Planning Access Permission on page 444

• Assigning Access Permissions on page 445

• Changing Access Permissions on page 447

• Removing Access Permissions on page 449

You must have VirtualCenter Administrator permission to change the role permissions 
assigned to any object in VirtualCenter.
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Understanding Users and Groups
VirtualCenter has full access rights and privileges on all managed virtual objects, such 
as, farms, farms groups, virtual machines, and virtual machine groups. VirtualCenter 
access is not granted to users for hosts, templates, events, alarms, or scheduled tasks. 

When a host is managed with VirtualCenter, VirtualCenter is granted privileges on the 
host. VirtualCenter can move virtual machines to and from hosts, and perform 
configuration changes needed to support virtual machines. Some configuration 
conditions are not handled within VirtualCenter, but can be controlled through the 
standard ESX Server or GSX Server interfaces: the VMware Management Interface, 
remote console, or service console. 

VirtualCenter registers any selected Windows domain or Active Directory user or 
group through process of assigning privileges. By default all users who are members 
of the Administrators group on the VirtualCenter server machine are granted 
VirtualCenter Administrator access. Users who are members of the Administrator 
group can log on as individuals and have the appropriate access.

VirtualCenter grants access to each VirtualCenter object by assigning a role and a user 
(or group) to each object. 

Individual permissions are assigned through VirtualCenter by pairing a user and a role 
and assigning this pair to a VirtualCenter object.

• Users and Groups — Created through the Windows domain or Active Directory 
database. VirtualCenter registers users and groups as part of the assigning 
privileges process. 

• Roles — A VirtualCenter pre-defined set of access rights and privileges. There 
are four roles. Each subsequent role includes the privileges of the previous role.

The types of roles that can be paired with a user and assigned to an object are:

• Read Only User — Users assigned this role for an object are allowed to view the 
state of virtual machines, hosts, farms, and groups.

With this role, view virtual machines, hosts, farms farm groups, and virtual 
machine group attributes, that is, all the tab panels in VirtualCenter — except 
the Console tab. You cannot view the remote console for a host. All actions 
through the menus and toolbars are disallowed. A Read Only User role can view 
the templates and scheduled tasks but not perform any actions with them.

• Virtual Machine User — Users assigned this role for an object are allowed to 
perform power operations on virtual machines. 
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With this role, connect with a remote console and view the states of virtual 
machines. You cannot modify the configuration of hosts or virtual machines.

• Virtual Machine Administrator — Users assigned this role for an object are 
allowed to add, remove, or modify objects. With this role you:

• Connect/disconnect host devices, migrate and migrate with VMotion, clone, 
remove and configure virtual machines

• Create, import, and deploy templates

• Add and remove hosts from farms

• Create, remove, or modify farms, farm groups, and virtual machine groups and 
their content.

• VirtualCenter Administrator — Users in this role are allowed to change 
privileges for an object. 

With this role, add, remove, and set access rights and privileges for all the 
VirtualCenter users and all the virtual objects in the VirtualCenter environment.

Read Only 
User

Virtual 
Machine 
User

Virtual 
Machine 
Administrator

VirtualCenter 
Administrator

Access Permission

X X X X View farms, hosts, and virtual 
machines

X X X Perform power operations on virtual 
machines

X X X Access remote console

X X Add and remove hosts

X X Add, remove and move virtual 
machines, including deploy 
templates and clone existing virtual 
machines

X X Add and remove farms, and groups

X X Add and remove templates, tasks

X X Change VirtualCenter Settings 
including performance intervals, 
template upload directory, and 
SNMP and SMTP settings

X Add and change licenses

X Add and remove user permissions
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The following table lists the VirtualCenter objects and the role required to perform 
functions on each object. Permissions do not apply to hosts. Activities through 
VirtualCenter apply to the virtual machines on a host. Permissions are applied to the 
virtual machines or the farms and groups containing the virtual machines. 

Object Type Action to be Taken Minimum Role Required

Permissions Read Read Only User

Change permissions VirtualCenter Administrator

Farm Read Read Only User

Modify Virtual Machine Administrator

Groups Read Read Only User

Modify Virtual Machine Administrator

Virtual Machines Read Read Only User

Power Operations Virtual Machine User

Connect Remote Console Virtual Machine User

Configure Virtual Machine Administrator

Connect/Disconnect Devices Virtual Machine Administrator

Migration with VMotion Virtual Machine Administrator on both 
on the farm that contains the source 
and target machine

Migration Virtual Machine Administrator on both 
on the farm that contains the source 
and target machine

Deploying Templates with or without 
customization

Virtual Machine Administrator on both 
on the farm that contains the source 
and target machine

Cloning with or without customization Virtual Machine Administrator

Scheduling Tasks - Power Operations Virtual Machine User

Scheduling Tasks - Deploying or 
Migration

Virtual Machine Administrator

Viewing Events Virtual Machine User
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Using the Hierarchy to Apply Access Rights
All VirtualCenter objects are contained within a hierarchy in VirtualCenter. Permissions 
(role+user pairs) are inherited through the VirtualCenter object hierarchy. When a role 
and user pair are assigned to an object, all objects that lay hierarchically under the 
object inherit the same role+user assignments. For example, if a role+user pair is 
assigned to a farm group, all members of the role+user pair have the access rights and 
privileges assigned to all the objects contained in the farm group. Permissions can 
also be explicitly assigned to any object in the VirtualCenter hierarchy. 

If a user is not assigned to an object with a specific role, the user cannot see or take 
action upon the object. Changes to a users permissions are implemented when the 
user logs in. If the user is currently logged in, the old permissions continue until the 
user exits and re-logs in. Objects created after a user logs in inherit the parent object’s 
permissions. 

Templates Read Read Only User

Creating Templates Virtual Machine Administrator on the 
Server Farms

Deploying Templates with or without 
customization

Virtual Machine Administrator on both 
on the farm that contains the source 
and target machine

Server Farms Read Settings Read Only User

Change Settings.

Includes performance intervals, SNMP, 
SMTP, and template upload directory

Virtual Machine Administrator on the 
Server Farms

Read licenses Read Only User

Adding or removing licenses VirtualCenter Administrator on Server 
Farms

Read Alarms Read Only User

Add or modify Alarms Virtual Machine Administrator on the 
Server Farms

Object Type Action to be Taken Minimum Role Required
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The figure below illustrates a distribution of user permission. Refer to Abbreviations on 
page 16 for a description of abbreviations.

Role + User Applied Across Server Farms

When an object is moved within the VirtualCenter hierarchy, the object assumes the 
permission settings of its new parent object. Assigned permission pairs (role+user) are 
inherited from parent objects. In the example, if VM2 is moved to VM group 2, User1 
loses the VirtualCenter Administrator privileges, but keeps the Virtual Machine User 
privileges.

farm1

VM1

VM group 1

Server Farms

Object

VM4

VM3

VM2

VM group 2

[User/Group Name + Role] at Object

user1 
+

Read Only

user1
+

VM User

user1 +  
VM Admin

user1
+

VirtualCenter 
Administrator
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The figure below illustrates changes in permission when a virtual machine moves to a 
virtual machine group where the permissions granted had been inherited. Refer to 
Abbreviations on page 16 for a description of abbreviations.

Moving Virtual Machine Changing Role + User Status

If the object has explicit permissions that are less than the permissions at the new 
location the higher level permission granted at the virtual machine group level are 
applied. The lower level explicit permission is removed. In the example, if VM3 moves 
to VM group 1, a flag indicates an explicit permission exists. If the object is returned to 
its original location or a location with matching role levels, VirtualCenter does not re-
instate the explicit assignment. 

farm 1

VM1

VM group 1

Server Farms

Object

VM4

VM3

VM2

VM group 2

[User/Group Name + Role] at Object

user1 
+

Read Only

user1
+

VM User

user1 +  
VM Admin

user1
+

VirtualCenter 
Administrator

user1 lost VirtualCenter Administrator
permission on VM2
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The figure below illustrates the change in permissions when a virtual machine is 
moved to a virtual machine group where the user has a higher level inherited 
permission. Refer to Abbreviations on page 16 for a description of abbreviations.

Moving Virtual Machine Upgrades Role + User

farm 1

VM1

VM group 1

Server Farms

Object

VM4

VM3

VM2

VM group 2

[User/Group Name + Role] at Object

user1 
+

Read Only

user1
+

VM User

user1
+

VirtualCenter 
Administrator

user1 Virtual Machine Administrator explicit  
permission on VM2 removed
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Using hierarchical inheritance, increase access permissions for users (or groups) as you 
descend into the VirtualCenter object hierarchy. However, once you pair higher role 
levels with a user (or group) at an object hierarchy level, you cannot reduce 
permissions at lower levels of the hierarchy. For example, if a user (or group) is paired 
with Virtual Machine Administrator role at a virtual machine group level, you cannot 
reduce the same user+role to Read Only User for any of the virtual machines 
contained within that virtual machine group. 

The figure below illustrates when a permission level does not change through an 
explicit role+user assignment. Refer to Abbreviations on page 16 for a description of 
abbreviations.

Reducing Role + User Not Allowed Through Conflicting Hierarchy

farm 1

VM1

VM group 1

Server Farms

Object

VM4

VM3

VM2

VM group 2

[User/Group Name + Role] at Object

user1 
+

Read Only

user1
+

VM User

user1 +  
VM Admin

user1
+

VirtualCenter 
Administrator

reducing user1 permission to Read Only permission on 
VM4 is not allowed.

user1 +
Read Only
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Planning Access Permission
For each object in the VirtualCenter hierarchy, determine what permissions you want 
to grant for each VirtualCenter user and group. Typically, lower level permission roles 
are assigned at higher level locations in the hierarchy. As you move down into the 
branches of the hierarchy, users and groups permissions naturally start to differentiate: 
some users and groups require higher permission roles in some branches, while other 
users and groups require higher permission roles in other branches. 

Note: Several users may access the VirtualCenter server from different VirtualCenter 
clients at the same time. VirtualCenter does not explicitly restrict users with the same 
login and password from accessing and taking action in VirtualCenter. If users give 
conflicting directions the results, however, become unpredictable.

Remove users from a group in the Windows Domain Controller or Active Directory, 
and they do not lose access to the VirtualCenter objects until they log out. Individual 
permissions, or those granted as part of inclusion in another group, are not affected. 

Remove users from the Windows Domain Controller or Active Directory, and they lose 
permissions to all objects in the VirtualCenter system on their next attempts at login. 
Users that are currently logged in and are removed from the Windows databases 
retain their VirtualCenter permissions as long as they remain logged in. Once logged 
out, they can no longer access the VirtualCenter system.

Change a user's name in the Windows Domain Controller or Active Directory, and the 
existing user name becomes invalid in the VirtualCenter system.

Preparing GSX Server Host Virtual Machines
GSX Server virtual machines are assigned user modes of Interactive, RunAs and 
Private. These modes, within the structure of GSX Server, allow the following 
conditions:

Interactive mode — the virtual machine performs functions as the user connecting 
to GSX Server.

RunAs mode — the virtual machine performs functions allowed by the user or group 
specified in the virtual machine.

Private mode — only the specifically defined user is allowed to perform functions on 
the virtual machine

To allow VirtualCenter to perform all the functions on any GSX Server virtual machine, 
all GSX Server virtual machines must be configured with RunAs mode. This ensures 
that the virtual machines have corresponding access to all datastores. 
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Assigning Access Permissions
To assign a user or group role level permission:

1. Log on as a user with VirtualCenter Administrator role.

2. From the VirtualCenter client, display the inventory panel and expand the 
appropriate object.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate object.

3. With the appropriate object selected, view the Permissions panel, click 
Permissions tab.

4. Start the Add Permissions sequence. 

a. Right-click the Inventory option.

b. Select the object to add the user+role to.

c. Select Add Permission from the object’s right-click menu or the Edit menu.
445



VMware VirtualCenter User’s Manual
5. Select the users or groups and the new permission for the object.

a. Choose a method to add users or groups:

b. Enter a user or group name in the field. Select the user or groups from the 
scrollable list. Click Add.

6. Set the role for the selected user on the selected object.

a. Select the user or group name from the permissions box.

b. Click the radio button for the appropriate permission. Add as many users and 
groups with assorted permission roles as needed. Click OK.

VirtualCenter adds the permission to the list of permissions for the object. 

The list of permissions references all users and groups that have roles assigned to 
the object, and where in the VirtualCenter hierarchy the role is assigned.
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Changing Access Permissions
To change the permission role for a user or group:

1. From the VirtualCenter client, display the inventory panel and expand the 
appropriate object.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate object.

2. With the appropriate object selected, view the Permissions panel, click 
Permissions tab.

3. Identify and select the object where the permission is defined.

a. Select an object to which the permission is defined.

b. Display the Permissions list. Click the Permissions tab.

c. Click the linked object in the Defined in column.

VirtualCenter displays the Permission panel for the object to which the 
permission was defined.

4. View the Change Access Rule dialog box. 

Select the user permission to change. Select Properties from either the Edit or 
right-click menu.

5. Select the appropriate role for the user or group.
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Click the appropriate radio button in the Change Access Rule screen. Click OK.

When you change a rule on an object that does not define the rule, but inherits 
it, a new rule is created for the user on that object, even though you specified a 
change. The change is to create a new rule for the object different than the 
inherited rule.
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Removing Access Permissions
To remove a permission role for a user or group:

1. Log on as a user with the VirtualCenter Administrator role.

2. From the VirtualCenter client, display the inventory panel and expand the 
appropriate object.

Click the Inventory option in the navigation bar. Expand the inventory as 
needed, and click the appropriate object.

3. With the appropriate object selected, view the Permissions panel, click 
Permissions tab.

4. Identify and select the object where the permission is defined.

a. Select an object to which the permission is defined.

b. Display the Permissions list. Click the Permissions tab.

c. Click the linked object in the Defined in column.

VirtualCenter displays the Permission panel for the object to which the 
permission was defined.

5. Remove the permission setting.

Select the user permission to remove. Select Remove from either the Edit or 
right-click menu. VirtualCenter removes the permission setting. 

Note: There is no additional warning that the permission is going to be 
removed. 
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Glossary
Alarms —  An entity that monitors one or more properties of a virtual machine, such 
as CPU load. Alarms user green, red, and yellow color coding issue notifications as 
directed by the configurable alarm definition.

Clone —  The process of making a copy of a virtual machine. This process includes 
the option to customize the guest operating system of the new virtual machine. 
When a clone is created VirtualCenter provides an option to customize the guest 
operating system of that virtual machine. Clones can be stored on any host within the 
same farm as the original virtual machine. 

Configuration — See Virtual machine configuration file. 

Console See VMware Virtual Machine Console.

Custom networking — Any type of network connection between virtual machines 
and the host that does not use the default bridged, host-only or network address 
translation (NAT) networking configurations. For instance, different virtual machines 
can be connected to the host by separate networks or connected to each other and 
not to the host. Any network topology is possible. 
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Customization —  The process of customizing a guest operating system in a virtual 
machine as it is being either deployed from a template or cloned from another 
existing virtual machine. Customization options include changing the new virtual 
machine identification and network information.

Datastore —  The storage locations for the virtual machine files. 

Drag and drop— A feature of VMware VirtualCenter that allows you to move virtual 
machines easily between groups.

Events —  A message record of VirtualCenter activities. Through the Navigation 
option all the events are displayed. Through an object specific panel, only events 
relative to that object are displayed.

Farm —  A required structure under which hosts and their associated virtual 
machines are added to the VirtualCenter server. VirtualCenter server supports multiple 
farms. A host can be managed only under one farm.

Farm groups —  An optional grouping structure, it is contained within the Server 
Farms structure. The VirtualCenter server supports multiple farm groups. Farm groups 
can contain other farm groups and farms.

Guest operating system — An operating system that runs inside a virtual 
machine. 

Headless — A program or application that runs in the background without any 
interface connected to it. A running virtual machine that has no consoles connected 
to it is running headless.

Host — The physical computer on which the VirtualCenter virtual machines are 
installed. 

Host-only networking — A type of network connection between a virtual 
machine and the host. Under host-only networking, a virtual machine is connected to 
the host on a private network, which normally is not visible outside the host. Multiple 
virtual machines configured with host-only networking on the same host are on the 
same network. 

Inventory —  Provides a view of all the monitored objects in VirtualCenter. 
Monitored objects include: Server Farms, farms, farm groups, hosts, virtual machines, 
and virtual machine groups.

Migration —  Moving a powered off virtual machine between hosts. 

Migration with VMotion —  Moving a virtual machine that is powered on and has 
met selected requirements, including the activation of VMotion on both the source 
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and target host. When a migration with VMotion is performed, the operations of the 
virtual machine can continue without interruption.

New Virtual Machine wizard — A point-and-click interface for convenient, easy 
creation of a virtual machine configuration. It prompts you for information, 
suggesting default values in most cases. It creates files that define the virtual machine, 
including a virtual machine configuration file and (optionally) a virtual disk or raw disk 
file. 

Nonpersistent mode — If you configure a virtual disk as an independent disk in 
nonpersistent mode, all disk writes issued by software running inside a virtual 
machine with a disk in nonpersistent mode appear to be written to disk but are in fact 
discarded after the virtual machine is powered off. As a result, a virtual disk or raw disk 
in independent-nonpersistent mode is not modified by VirtualCenter. 

Persistent mode — If you configure a virtual disk as an independent disk in 
persistent mode, all disk writes issued by software running inside a virtual machine are 
immediately and permanently written to a virtual disk in persistent mode. As a result, a 
virtual disk or raw disk in independent-persistent mode behaves like a conventional 
disk drive on a physical computer. 

Preallocated disk —  A type of virtual disk where all disk space for the virtual 
machine is allocated at the time the disk is created. This is the default type of virtual 
disk created by VirtualCenter.

Raw disk — A hard disk in a virtual machine that is mapped to a physical disk drive 
or partition on the host machine. A virtual machine’s disk can be stored as a file on the 
host file system (see Virtual disk) or on a local hard disk. When a virtual machine is 
configured to use a raw disk, VirtualCenter directly accesses the local disk or partition 
as a raw device (not as a file on a file system). It is possible to boot a previously 
installed operating system on an existing partition within a virtual machine 
environment. The only limitation is that the existing partition must reside on a local 
IDE or SCSI drive. 

Read Only User —  A role where the user is allowed to view the inventory but not 
allowed to perform any tasks.

Redo log —  The file that stores the changes made to a disk in undoable or 
nonpersistent mode. You can permanently apply the changes saved in the redo log to 
a disk in undoable mode so they become part of the main disk files. For a disk in 
nonpersistent mode, however, the redo-log file is deleted when you power off or reset 
the virtual machine without writing any changes to the disk.
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Resume — Return a virtual machine to operation from its suspended state. When 
you resume a suspended virtual machine, all applications are in the same state they 
were when the virtual machine was suspended.

Role —  A VirtualCenter pre-defined set of access rights and privileges. There are four 
roles, each subsequent role includes the privileges of the lesser role.

Scheduled Tasks —  A VirtualCenter activity that is configured to occur at 
designated times. The Tasks panel displays a list of and a means to schedule selected 
activities.

Server Farms —  The top level structure for the VirtualCenter server. There is only 
one Server Farms per VirtualCenter server.

Supported partition  A virtual disk partition that VMware Tools can prepare for 
shrinking, such as one of the drives that comprise the virtual hard disk. You can 
choose to not prepare certain partitions for shrinking.

Suspend — Save the current state of a running virtual machine. To return a 
suspended virtual machine to operation, use the resume feature.

Template —  A golden image of a virtual machine. This typically includes a specified 
operating system and configuration which provides virtual counterparts to hardware 
components. Optionally, a template can include an installed guest operating system 
and a set of applications. Templates are used by VirtualCenter to create new virtual 
machines. 

Template upload directory —  A template upload directory is located on the 
VirtualCenter server machine. A copy of the original virtual machine virtual disks are 
placed in the directory you specify as the template upload directory. This is typically 
used for creating templates from non-ESX Server or GSX Server virtual machines that 
are stored locally to the VirtualCenter server.

Templates —  Provides a list of and a means to import virtual machines and store 
them as templates for deploying at a later time to create new virtual machines. 

Unsupported partition A virtual disk partition that VMware Tools cannot prepare 
for shrinking. Unsupported partitions include read-only drive partitions, partitions on 
remote devices and partitions on removable devices such as floppy drives or CD-ROM 
drives. 

Virtual disk — A virtual disk is a file or set of files that appear as a physical disk drive 
to a guest operating system. These files can be on the host machine or on a remote 
file system. When you configure a virtual machine with a virtual disk, you can install a 
new operating system into the disk file. 
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Virtual machine — A virtualized x86 PC environment in which a guest operating 
system and associated application software can run. Multiple virtual machines can 
operate on the same host machine concurrently. 

Virtual Machine Administrator —  A role where the user is allowed to perform all 
the virtual machine management functions. 

Virtual machine configuration — The specification of what virtual devices (disks, 
memory size, etc.) are present in a virtual machine and how they are mapped to host 
files and devices. 

Virtual machine configuration file — A file containing a virtual machine 
configuration. It is created by the New Virtual Machine Wizard. It is used by 
VirtualCenter to identify and run a specific virtual machine.

Virtual Machine Properties — A point-and-click control panel used to view and 
modify the resource settings of all the virtual machines on a host. 

Virtual Machine Groups —  An optional grouping structure, it is subset to a farm. 
VirtualCenter server supports multiple virtual machine groups. Virtual machine groups 
contain virtual machines and other virtual machine groups.

Virtual Machine User —  A role where the user is allowed to perform power 
operations on virtual machines.

VirtualCenter Administrator —  A role where the user is allowed to set the 
user+role permissions and controls the VirtualCenter licensing.

VirtualCenter client —  A user interface that runs locally on a Windows machine. 

The VirtualCenter client runs on a networked machine. This can be on the same 
machine as the VirtualCenter server or another networked machine. The VirtualCenter 
client requires a monitor for access to the graphical user interface.

VirtualCenter database —  A persistent storage area, for maintaining status of 
each virtual machine and user managed in the VirtualCenter environment. This is 
located on the same machine as the VirtualCenter server.

VirtualCenter agent —  Installed on each virtual machine host, it coordinates the 
actions received from the VirtualCenter server.

VirtualCenter server —  A service that acts as a central administrator for VMware 
servers connected on a network, to direct actions upon the virtual machines and the 
virtual machine hosts. VirtualCenter server is the central working core of VirtualCenter. 

VMotion —  Enables moving running virtual machines from one ESX Server to 
another without service interruption. It requires licensing on both the source and 
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target host. Feature that is activated by the VirtualCenter agent. The VirtualCenter 
server centrally coordinates all VMotion activities.

VMware Tools — A suite of utilities and drivers that enhances the performance and 
functionality of your guest operating system. Key features of VMware Tools include 
some or all of the following, depending on your guest operating system: an SVGA 
driver, a mouse driver, the VMware guest operating system service, the VMware Tools 
control panel and support for such features as shared folders, drag and drop in 
Windows guests, shrinking virtual disks, time synchronization with the host, VMware 
Tools scripts and connecting and disconnecting devices while the virtual machine is 
running.

VMware Virtual Machine Console — Interface to a virtual machine that provides 
access to one or more virtual machines on the local host or a remote host running 
VirtualCenter. You can view the virtual machine’s display to run programs within it or 
modify guest operating system settings. In addition, you can change the virtual 
machine’s configuration, install the guest operating system or run the virtual machine 
in full screen mode.
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